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I. GRAFIK DIZAYN

Ushbu go‘llanmaning birinchi gismida biz grafik dizayn hagida
so‘z yuritamiz. Rasm chizish yoki kompozitsiyalar gila olish
to‘g‘risida emas, buning uchun qobiliyat va ta’bning o°zi yetarli.
Bundan tashqgari, ko‘pgina foydalanuvchilar Photoshop yoki
CorelDRAWni ozgina o‘rganib olib, o‘zlarini dizayner deb
hisoblasalar-da, biz hech ganday grafik paket bilan ishlash
xususiyatlari to‘g‘risida gapirmaymiz. Grafik dizayn xuddi fan singari
aniq aksioma va qoidalar yordamida tuzilgan, adashishlar va
kashfiyotlar gilingan fandir.

Siz fagat shu bobni o‘gibgina dizayner bo‘lmaysiz. Lekin biz
o‘ylaymizki, sizlar asosiy narsani tushunasiz: agar biror narsa
to‘g‘ri bajarilgan bo‘lsa, u obyektiv sabablarga ko‘ra sifatli tayyor-
langan, lekin yaratuvchi bu darajaga o‘z qobiliyati va nazariy
bilimlari hisobiga erishdi.

Biz o‘quvchi shu narsani tushunishini xohlaymiz: rassomlik
gobiliyatiga ega bo‘lmasdan turib ham dizayner bo‘lish mumkin.
Lekin buning uchun inson «nima yaxshi-yu, nima yomonsligini
aniglaydigan qoidani juda to‘g‘ri tushunib olishi kerak.

Biz o‘lcham, shakl, tekstura rangi, joylashishi va shrift kabi
tushunchalar to‘g risida fikr yuritamiz. Yana kompozitsiya masalasiga
ham to‘xtalamiz. Shakllantirishga urinib ko‘raylik, tanlash, aynigsa,
tanlashdan voz kechish nimaga asoslanadi. O‘zingiz tushunasiz,
ko‘pincha variantlar juda ko‘p bo‘ladi, yaxshilari esa sanoqli. Biz
boshlovchi dizaynerlar yo‘l qo‘yadigan asosiy xatolarni va ularning
kattaroq hamkasblarida bo‘ladigan adashishlarni aks ettirishga
harakat qgilamiz.

Lekin bu dizaynga soddalashtirilgan garash, xolos. Agar bu
sizga qiziqarli ko‘rinsa, dizaynning asosiy savoli — «ganday qilib
chiroyli gilish mumkin». Bu savolga to‘ligroq javob bera oladigan
ko‘plab kitoblar mavjud.



1.1. O‘lcham

O‘lcham nimaligi hammamizga u yoki bu darajada yaxshi
ma’lum — maktab davrlarida geometriya fani aniq ta’rif bergan.
Lekin inson his-tuyg‘usi uchun o‘lcham aniq matematik
ifodalangan tushuncha hisoblanmaydi. Masalan, agar biz
evkaliptning balandligini 100 metrga yaqinligini bilsak, bu bizga
unchalik ko‘p narsa bermaydi. Lekin agar bu 30 gavatli uyning
balandligi ekanligini bilsak, u holda bu daraxtning balandligi
to‘g‘risida aniq tasavvur hosil gila olamiz.

Shunday qilib o‘lcham — nisbiy tushuncha. Biz uni 20 cm, 3 m, 5
km sifatida emas, balki «mitti», «o‘rtacha», «katta», «ulkan»,
«bahaybat» kabi gabul gilamiz. Hammasi inson qabul giladigan
sezgilarga asoslanadi, inson sezgisi esa juda egiluvchan. Biz jurnaldagi
miniaturani ko‘rayotganimizdagi katta va kichik tushunchalar katta
kartinani ko‘rayotganimizdagi katta va kichik to‘g‘risidagi
tushunchalardan farq giladi.

Ishdagi aniq bir obyektning o‘lchamlarini tanlashda kompo-
zitsiya birgalikda gandaydir g*oyaga (umuman olganda, zamonaviy
dizaynning asosiy vazifasi — ma’lumot yoki buyrugni maksimal
darajada yetkazib berish) ega bo‘lishi to‘g‘risida o‘ylash kerak.
Shuning uchun, aytaylik, uyali telefon reklamasida aynan uyali
telefon ajralib turishi kerak.

Kompozitsiyadagi biror-bir obyektga
e’tiborni nafagat uning hajmini boshga
obyektlarga nisbatan kattaroq qilib jalb
qilish mumkin, balki buning teskarisi:
katta hajmdagi detallarga keskin garshi
turuvchi kichkina detalga ham jalb qilish
mumkin. Bu holatda, aynan u asosiy
ma’lumot sifatida, qolganlari esa fon
sifatida gabul gilinadi. Bu narsa e’tiborni
bitta ragamga jalb gilingan 1.1-rasmda
ko‘rsatilgan.
1.1-rasm. Kompo- Shuning uchun bitta kompozitsiyada
zitsiyadagi obyektga  yaxshi «ishlovchi» obyekt (ko‘pincha)
e’tiborni nafagat uning  pnhga olchamlarni yaxshilab o‘zgartir-
hajmini Kattarog qilib 6421 turib mos kelmaydi. Bunda ishni
jalb qilish mumkin, i ) . .
balki buning aksi ham  bajarayotganda nafagat ko‘zga (ko‘z bilan
bo‘lishi mumkin. olingan ma’lumotni ganchalik aldamchi-
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ligini professionallar juda yaxshi bilishadi), balki shakl, tekstura va
ranglar odamning o‘lchamini gabul qiluvchi sezgilariga ta’siri
to‘g‘risidagi o‘z bilimlariga ham tayanishi kerak.

Shakl va o‘lcham

O‘Ichamni gabul qilish obyektning shakliga bog‘liq bo‘ladi. Bu
inson ko‘zining yorug‘lik interferensiyasini gqabul qilish
xususiyatlari bilan bog‘lig. Amalda murakkab tuzilishga ega, asosan
bo‘laklardan iborat obyektlarning o‘lcham
jihatidan qiyin baholanishiga ko‘p bor duch
kelish mumkin. Albatta, agar ularning nisba-
tan katta, qolgan kompozitsiya obyektlariga
nisbatan gabaritlarini solishtirsak, bunday
muammo yuz bermaydi. Lekin murakkab
shaklning kichik bo‘laklari, umuman obyekt- /.2-rasm. Bu
ning o‘lchamiga ta’sir qiluvchi qismi sifatida gabul figuradagi nurlar
qilinmaydi. obyektning girra-

Bu misol bizni shaklning o‘lchamni qabul &1 sifatida gabul

. A g . . qilinmaydi.
gilishga munosabatini belgilovchi asosiy
tushunchaga olib keladi. Bu kompaktlilik yoki zichlik. Ba’zida eng
zich figura sifatida adabiyotlarda doira keltiriladi. Bizningcha, bu
juda ham to‘g‘ri emas.

Biz shaklning kom-
paktliligini uning maydo-
nini belgilangan chegara-
lardagi to‘ldirilmagan sohaga
nisbat sifatida aniqladik.
Murakkabmi? Misol orqali
tushuntiramiz. Aytaylik, siz-
ga ikki figura — to‘rtburchak
va doirani ikki tanga va
markalarga joylashtirish kerak
bo‘lib goldi (1.3-rasm).

Ko‘rinib turibdiki, mar-

r——=
I

ka uchun kvadrat kompakt-
roq figura, tanga uchun esa

1.3-rasm. Doira va kvadrat doira hISObla.n_adl'_
shaklidagi obyektlarni Qabul gilishning mana
joylashtirish: shu nisbiyligini doimo yodda

a - markaga; b — tangaga. tutish kerak, chunki aynan



kompaktlilik o‘lchamlarni qabul gilishni belgilaydi. Zichroq figura
doimo yirikroq ko‘rinadi. Bu narsa 1.3-rasmdagi markada aniq
ko‘rinib turibdi.

Bu xossadan amalda quyidagicha foydalaniladi. Aytaylik, ikkita
masala turgan bo‘lsin: vizitkalardan foydalanish uchun shartli
ravishda «<AGGW» deb nomlanuvchi kompaniyaning logotipini
chizish kerak bo‘lsin. Agar siz kartochkada bu elementning
muhimligini ta’kidlamoqchi va unga ¢’tiborni jalb qilmoqchi
bo‘lsangiz, u holda logotipning kompakt shaklda tayyorlashga to‘g‘ri
keladi (1.4-rasm, a). Agar logotip ¢’tiborni jalb gilmasligini, balki
faqat fon sifatida ishlatilishini xohlasangiz, u holda sizning
tanlovingiz (1.4-rasm, b ) bo‘lishi kerak. Va bu, e’tibor bering,

vizitkaning bir xil o‘lchamlarida ko‘rinadi.

S .

1.4-rasm. Logotip shakli: @ — kompakt; » — kompakt bo‘lmagan.

Tekstura va o‘lcham
Teksturaning qo‘llanilishi yangi effektlarni yasash, predmet
giyofasini murakkablashtirish, unga ma’no berish imkoniyatini
yaratadi. Lekin tekstura yana obyektning o‘lchovini gabul qgilishga
ham ta’sir qilishi mumkin va buni albatta hisobga olish kerak.

I =

1.5-rasm. Yorug‘roq predmetlar katta ko‘rinadi: yorqin chiziglarning
yo‘nalishi shu yo‘nalish bo‘yicha predmetning uzayishi kabi illuziyani
hosil giladi.
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1.5-rasmda bir xil geometrik o‘lchamga ega ikkita kvadrat
keltirilgan. Lekin shunga garamasdan tik polosali kvadrat ancha
«og‘ir», gorizontal tekislikka nisbatan yirikroq ko‘rinadi. Gorizontal
polosali kvadrat esa yengil ko‘rinadi.

Bu effekt anchadan beri ma’lum. Eski jurnallardan to‘la
ayollarga vertikal polosali ko‘ylaklar kiyish to‘g‘risidagi tavsiya-
larni o‘qish mumkin — ular ayollarni asliga nisbatan ixcham
ko‘rsatish xususiyatiga ega.

Amalda bu hodisadan ko‘p foydalaniladi. Obyektga qo‘shimcha
«mustahkamlik» berish kerak bo‘lsa, gorizontal yo‘nalganligi yorqin
ravishda ko‘rinib turadigan rasmlardan (aytaylik, g‘isht taxlamli
tekstura) foydalaning. Agar aksincha, bosib turuvchi o‘lchamdan
qutulmoqchi bo‘lsangiz, vertikal yo‘nalishga asoslaning.

Tekstura bilan yana bitta effekt bog‘langan. 1.6-rasmdagi birinchi
tasvir go‘yoki bizdan uzoqlashib borayapti, ikkinchisi esa,
aksincha, yaqinroq ko‘rinadi. Bu effekt oq rangning o‘zining
fonidagi barcha predmetlarni «egishi»ga asoslangan. Bu effektni bilish
va uning asosi hagida kitobda ko‘plab misollar keltirilgan aylanaviy
gradiyentlar bilan ishlashni qo‘llay bilish kerak.

Shunday qilib, tekstura obyektlarini tasvirlashda ijobiy hamda
salbiy (uni noto‘g‘ri tanlanganda) ta’sir qilishi mumkin ekan.
Bunga juda ¢’tibor bering va shunda bunga o‘xshash narsa siz bilan
sodir bo‘lmaydi.

a b

1.6-rasm. Oq va gora aylanaviy polosalarning almashishiga asoslangan
effektlar: @ — uzoglashish; » — yaginlashish.

Rang va o°‘lcham. Bu biz uchun o‘lchamlarga bag‘ishlangan
eng murakkab gismdir. Masala yana o‘sha — uni gabul qgilishning
nisbiyligidir. Ko‘pincha biz yirikroq, boshqalari orasida ajralib
turadiganlariga, garchi bunga obycktiv sabablar bo‘lmasa-da,
¢’tibor beramiz.



Shunday qilib, birinchi va eng asosiy xossa: qora fondagi yorqin
obyektlar yorqgin fondagi qora obyektlarga nisbatan yirikroq
ko‘rinadi (1.7-rasm).

1.7-rasm. Qora fondagi yorqin obyektlar yorqin fondagi qora obycktlarga
nisbatan yirikroq ko‘rinadi.

Bir-biridan yorqinligi bo‘yicha keskin ajralib turuvchi, masa-
lan, logotipdagi obycktlarning simmetrikligini ta’kidlamoqchi
bo‘lsangiz, buni albatta hisobga olishingiz kerak. Tomoshabinga siz
oz ishingizni unchalik sifatli bajarmagandek ko‘rinishingiz uchun
gora elementni kattalashtirishga to‘g‘ri kelishi mumkin.

1.8-rasmda biz qora doira radiusini 2%ga orttirdik — yo‘gsa logotip
o‘ylagan natija chigmasdi.

Design

B @

1.8-rasm. Bu ishda doiralar bir xil ko‘rinishi uchun qora doiraning
radiusi oq doiranikiga nisbatan 2% ga oshirilgan.

=

W
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Shunga o‘xshash, yorqin-qgizil element o‘zi bilan teng to‘g-
ko‘k elementga nisbatan ancha kattaroq ko‘rinadi. Buni ham ish
jarayonida e’tiborga olish kerak.

1.2. Rang

Biz rangli dunyoda yashaymiz. Har kuni, hatto uydan
chigmasdan turib ham inson juda katta sondagi ranglarni ko‘radi.
Biz bunga ko‘nikib golganmiz va ranglarning tabiati, ular bizga va
bizning xatti-harakatlarimizga ganday ta’sir qilishi haqgida
o‘ylamaymiz ham. Garchi bu, balki unchalik to‘g‘ri bo‘lmasa-da:
har bir ayol ganday holda yorqin-qizil ko‘ylak kiyishni, kulrang
kostyum esa ganday holda to‘g‘ri kelishini juda yaxshi biladi.

Biz ranglarning asiri bo‘lib yashaymiz. Bizning fikrlarimiz, his-
tuyg‘ularimiz — hammasi o°‘zining rangiga ega. Qora rang — fikrlar,
ko‘k — sog‘inch, zangori — kayfiyat kabilarni esga olish va tushunish
uchun yetarli: predmetning psixologik gabul gilinishi uning rangi
bilan yetarlicha gattiq bog‘langan.

Odatiy hayotda bu unchalik katta ahamiyatga ega emas. Lekin
hozir gap ranglarning kompyuter grafikasida qo‘llanilishi to‘g‘-
risida borayapti va bu yerda biz nafagat ranglardagi farq, balki bir
rangning darajasini ham his qila olishimiz, ularni go‘llanilishi inson
tomonidan qgabul qilishga ganday ta’sir qilishini tushunishimiz
kerak.

To‘g‘ri tanlangan ranglar tasvirga e¢’tiborni jalb qilishi ham,
gaytarishi ham mumkin. Siz quvonch, qizigish, sog‘inch, qo‘r-
quv, zerikish kabi ranglarni o‘zgartirgan holda hosil qilishingiz
mumkin.

Ranglar juda ko‘p, lekin psixologlarning ta’kidlashlaricha, har
bir shaxsning o‘z xususiyatlari bilan bog‘liq bo‘lgan sevimli
ranglari bor. Shuning uchun ham ranglarni tanlashda o‘rtacha
tomoshabinning tavsiya qgilingan psixologik portretiga ham suyanish
kerak.

Qo‘shimcha murakkablik shundan ham kelib chigadiki, rang
obyektiv fizikaviy kattalik sifatida tabiatda bo‘lmaydi. Ranglarni his
qilish, garchi elektromagnit nurlanishlarning obyektiv faktorlari
ta’sirida ro‘y bersa ham subyektiv deb hisoblanadi. Bundan tashqari,
ranglarni tasvirlashda turli mamlakatlarda milliy-madaniy an’analarga
asoslangan turlicha rang modellaridan foydalaniladi. Kompyuter
grafikasi bilan professional tarzda shug‘ullanadigan har ganday
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kishi duch keladigan ranglardagi tasvirlarning rang-barangligini
shu bilan tushuntiradi.

Shakldan farq qilib, subyektiv tushunchaligiga garamay,
ranglar olamida dizayner bilishi va amalda go‘llay olishi kerak bo‘lgan
umumiy qonuniyatlar mavjud.

Biz oldin rang qanday tuzilganligini tahlil qilib olishimiz kerak.
Aslida bu jiddiy monografiyaning mavzusi, shuning uchun biz
fiziologik va spektral xususiyatlariga to‘xtalib o‘tirmaymiz, balki
hammasini soddalashtiramiz.

Dastlab rangni tashkil etuvchilarga ajratamiz. Barcha mavjud
modellardan fagat HSV (Hue — Saturation — Value, Rang —
To‘yinganlik — Yorginlik) gina uni biz odatlangan holda tasvirlaydi
va ko‘nikishni talab gilmaydi.

HSV tizimi uchta komponentaga ajratiladi.

¢ Rang (Hue) — bu bevosita rang to‘g‘risidagi ma’lumot. Buni
oddiy tilda tushuntirish giyin, shuning uchun o‘z garashlaringizga
ishoning.

¢ To'yinganlik (Saturation) — ranglar, kundalik hayotdan siz
bilasizki, u yoki bu darajada to‘yingan bo‘ladi. Oddiy tilda ko‘proq
to‘yingan rangni ko‘proq suvli deyishadi.

¢ Yorginlik (Value) — osongina topish mumkinki, yorginroq
rang yorug‘roqdek gabul gilinadi.

Shuni ta’kidlash kerakki, nafagat har bir inson, balki butun
xalglar bir xil rangga turlicha munosabat bildirishadi. Bu shu xalg
tarbiyalagan an’analar bilan bog‘liq. Masalan, Yevropa mamla-
katlarida oq rang — tozalik va begunohlik rangi, ba’zi bir sharq
xalglarida esa u motam rangi hisoblanadi.

Asosiy ranglarni xarakterlashga urinib ko‘ramiz.

Ranglarning issiq va sovugqa bo‘linishi 1.9-rasmda tasvirlangan.
Bu bo‘linish ma’lum darajada shartli: rang ganchalik yuqori va
quyi yarim doiralarga yaqin bo‘lsa, uni issiq yoki sovuqqa ajratishga
ishonch shuncha kamroq.

Qizil

Ko‘pchilik kishilarda gizil rang olov bilan to‘g‘ridan-to‘g‘ri
bog‘lanish hosil giladi. Shuning uchun ham uning ta’siri ham har
xil bo‘lishi mumkin — salbiydan tortib ijobiygacha. U pulsni
tezlashtirish va qorachig‘ni kengaytirish xossasiga ega, lekin o‘zining
yorqinligi tufayli tez charchatadi, aynigsa, ko‘p migdorda bo‘lsa
(masalan, agar xona devorlari shu rangda bo‘lsa).

10



Sariq

Qizil Yashil
ILIQ
SOVUQ
Binafsha Zangori
Ko‘k

1.9-rasm. Ranglarni sovuq va issigqa bo‘linishini ko‘rsatuvchi
aylana doirasi.

Toza gizil rang — bu xavotirlanish va hayajonlanish rangi, lekin
uning turlari (jigarrang, qizg‘ish) tinchlantiruvchi ta’sir qgiladi. Qizil
o‘ziga digqatni jalb etadi (deyarli barcha ogohlantiruvchi belgilar
qizil fonda yoki gizil yozuvda qilinishi tasodifiy emas).

Bu rang kompyuter grafikasida ko‘p qo‘llaniladi, lekin charchatib
go‘ymasligi uchun u bilan ishlashda ehtiyot bo‘lish kerak.

Qizil rang to‘g‘ri keladi:

» Agressivlikni, faollikni ta’kidlash uchun. Masalan, eng yaxshi
sport mashinalari, jumladan, Ferrari asosan qizil rangda ishlab
chiqariladi;

s Kuchli hisni, seksual xohishni. Buni shu bilan tasdiglash
mumkinki, erotik dasturli tungi klublar bezagida juda ko‘p qizil
rang ishlatiladi;

» Ayovsizlikni ifodalash uchun (qizil — qon rangi);

» Boylik, dabdabalilikni ta’kidlash uchun (aynigsa qora rang
bilan birgalikda).

Sarig

Bu rang doirasidagi eng yorqin rang. U yaxshi kayfiyat,
umidvorlikni uzatish uchun juda mos rang. Aynan shuning uchun
sariq — turistik kompaniyalar reklamasida eng ko‘p qo‘llaniladigan
ranglardan biri.
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Bundan tashqari, sariq rang — bu oltin rangi. Shuning uchun
u ko‘pchilikda omad, boylik va dabdaba tuyg‘ularini vujudga keltiradi.

Binafsha rang

Ilig, musbat, yorgin va zamonaviy rang tetiklashtiradi. Pulsni
tezlashtiradi va gorachig‘ni kengaytiradi. Zamonaviy duzaynda,
aynigsa, web-dizaynda ko‘p go‘llaniladigan ranglardan biri.

Binafsha rang, agar xohlasangiz, quyidagilarni ta’kidlash uchun
ishlatilishi mumkin:

s Zamonaviylik. O‘zini brendining asosiy qirrasi sifatida
zamonaviylikni tanlagan ko‘plab kompaniyalar «firma rangi» sifatida
binafsha rangni tanlashadi. Bu aynigsa, uyali telefon operatorlari
orasida keng tarqalgan:

s Harakatchanlik;

a Optimizm. Yorqgin plakatlarni yaratish uchun binafsha rang
bachkana, lekin amaliy jihatdan ideal variant.

Tajribalarning ko‘rsatishicha, binafsha rang yashil rang bilan
birga juda yaxshi ko‘rinadi.

Lolarang

Ranglar doirasini gizil rangdan ko‘k rangga borgan sari sekin-
asta o‘tishini paygamay qolamiz, axir xuddi o‘sha yerda ajoyib
rang berkinib turibdi — lolarang. Bu gabul qilishga juda giyin rang,
chunki u tabiatda deyarli uchramaydi. U xuddi ko‘k va yashil
ranglarga o‘xshab sovuq guruhga kiritiladi. U torlik, chegaralanganlik
tuyg‘usini hosil gilish xususiyatiga ega. U yana tez charchatadi va
faollikni susaytiradi.

Lolarang «yerlik emas», unga gandaydir yashirinlik xos.
Yagingacha mistikada lolarangga alohida o‘rin ajratilgan. Agar siz
ko‘zboylog‘ichlarning tomoshalarini ko‘rgan bo‘lsangiz, ularning
kiyimi, narsalari, pardalarida bu rang juda ko‘p. Lolarang kishilarda
noaniq, tushunarsiz qo‘rquvni hosil gila oladi.

Shunday qilib lolarang quyidagilar uchun to‘g‘ri keladi:

» mistik kayfiyatni hosil qilish uchun;

s yashirinuvchanlikni ta’kidlash uchun.

Kok

Ko‘k rang sovuq guruhga kiradi, rang doirasining eng quyisida
joylashadi. U tinchlantiradi, ba’zan melanxolik kayfiyatni targatadi.

Bu rangni «doimiy muzlik» zonasi ranglariga kiritish mumkin:
u sovuq va tozalik sezgisini uzatadi. Tinchlantirib, juda yaxshi ta’sir
giladi, yotogxonalarning dizayni uchun juda mos.
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Toza ko‘k rangning to‘yinganligi va yorginligining o‘zgarishi
bizga juda ko‘p ranglarni berishi mumkin (to‘g‘ri, CMYK —
tizimning o‘ziga xosligi tufayli aynan ko‘k rangni bosib chigarishda
yaxshi tasvirlanmaydi).

» Sokinlikni ta’kidlash uchun ko‘k rangdan foydalaning;

» Tozalik. Siz ¢’tibor bergan bo‘lsangiz kerak, barcha sifatli
tozalovchi vositalar ko‘k yoki yashil rangda bo‘ladi. Bu tasodifiy
emas: olimlarning isbotlashicha aynan shu rang ko‘pgina kishilarda
tozalik tuyg‘usi bilan mos keladi:

» Mustahkamlik.

Zangori

Ajoyib rang. U ham ilig, ham sovuq bo‘lishi mumkin, ammo
ko‘pincha u birlashgan joyda yotadi, shuning uchun uni ham sovugq
guruhga, ham iliq guruhga kiritish mumkin.

Zangori rang tinchlantiruvchi ta’sir giladi, qon bosimini pasay-
tiradi, qon aylanishini normallashtiradi. Bu eng tabiiy va eng «tirik»
rang. Uning dizayndagi asosiy vazifasi aynan shunda — obyckt
bilan tabiat alogasini uzatish. Umuman olganda, logotiplar ko‘rib
chigsa, zangori rang asosan tabiat resurslarini gazib oladigan
kompaniyalarda yoki ekologik tashkilotlarda uchraydi.

Agar siz zamonaviy blokbasterlarni ko‘rsangiz, u holda biologik
qurollar, boshga dunyo jonzotlari va boshqga biologik mavjudotlar
yashil (aynigsa yorqgin yashil) rangda bo‘lishiga ¢’tibor bergan
bo‘lishingiz kerak.

Bundan tashqari, zangori rang — mistika va yashirinlilik rangi.

Zangori rang quyidagilarni uzatish uchun mos keladi:

» barcha biologik ko‘rinishdagi tiriklik;

= tabiat bilan aloqa;

s yashirinlik.

Yashil

Yashil rang tinchlantiradi va sovitadi. Bunday natija sovuq suv
va muzga o‘xshashligi tushuntiriladi. Ba’zan yolg‘izlik tuyg‘usini
vujudga keltiradi.

Asosiy ranglar: qora va oq

Siz sezgan bo‘lsangiz kerak, biz barcha asosiy ranglarni ko‘rib
chigdik, lekin rang aylanasining hamma yerida bo‘lgan va shu bilan
hech qayerda ko‘rinmaydigan ikkita rang — qora va oq ranglar
hagida so‘z yuritmadik.

Qora rang o‘zining takrorlanmas yaxlitligi bo‘yicha — o‘zida
zerikish, alamni olib yuruvchi og‘ir rang. Charchog va o‘ng‘ay-
sizlikni keltirib chigaradi. Shunga gqaramasdan kishilar shu rangdagi
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kiyimlarni tanlashadi. Bu holda u klassikaga, shu bilan birga aniq
bir stil hosil giladi. Yana bu rang qolgan barcha ranglar bilan u yoki
bu darajada kelisha oladi. Qora rang — bu dabdaba rangi, aynigsa,
gizil rang bilan birgalikda. Bizning an’analarimizda uni motam rangiga
kiritish gabul qgilingan.

Oq rang — juda quvnoq rang. Toza havo bilan bog‘ligligi tufayli
u yengillik, erkinlik va vaznsizlik tuyg‘ularini hosil giladi. Pulsni
tezlashtiradi va qorachig‘ni kengaytiradi. Oq rang fonni yaratishda
anchagina ko‘p qgo‘llaniladi. Oq rang o‘zicha hech ganday ma’lumot
yetkazmaydi, boshga barcha ranglar bilan yaxshi moslashib,
yorginroq rangli ohanglarni hosil giladi. Bu rang begunoh va tozalik
ramzi hisoblanadi.

Ranglarning o zaro mosliklari

Ranglarning ozaro mosligi masalasi — bu dizayndagi eng bahsli
va turlicha talgin etiladigan savollardan biri. Hagigatan bu yerda
«har kimning ta’bi har xil» tamoyili hamma narsadan ustun.
Shuning uchun universal qoidalar to‘g‘risida, afsuski, gap ham
bo‘lishi mumkin emas.

Lekin gandaydir gonuniyatlarni topish mumkin. Shunday
qilib, birinchi va eng sodda tamoyil — yorqin ranglarni tanlash.
Kiyimni «ohang» bo‘yicha tanlanganidek, web-sahifada ham
ranglarni tanlash mumkin.

To‘g‘ri, bunday yondashuv juda goloq va professional ishlar uchun
to‘g‘ri kelmaydi. O‘zaro mos keladigan ranglarni qidirish uchun
ranglar doirasidan foydalanish gizigarliroq (1.10-rasmga qarang).

Sariq

Qizil I % Yashil

X /mo \/

e

Binafsha ¥ / Zangori

Ko‘k

1.10-rasm. Rang aylanasidagi ranglarning munosabati.
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s Aralash ranglar yomon o‘rin almashmaydi, ammo bunday
variantni tanlash odatda zerikarli va bachkana hisoblanadi.

s Bir-biriga garama-qarshi joylashgan ranglar yomon
kelishadigan ranglar hisoblanadi. Yagona istisno — ko‘k rang sariq
bilan juftlikda yomon ko‘rinmaydi.

= Eng yaxshi tanlov — 1.10-rasmda to‘g‘ri chiziq bilan
tutashgan ranglardan bitta keyingi rang. Bu ranglar o‘zining ko‘plab
turlariga juda yaxshi mos keladi, asosiysi yorginlikda juda katta farg
bo‘lmasligida.

Yana bir muhim narsa, gora va oq golgan barcha ranglar bilan,
aynigsa, bir-biri bilan juda yaxshi mos keladi. Shuning uchun,
agar tanlash imkoniyati bo‘lsa, ishni aynan shu ranglar yordamida
osonroq bajariladi.

Lekin ranglarni tanlashda asosiysi oriyentir bo‘lib bari bir ta’b
(kimdadir bu tug‘ma bo‘ladi) va tajriba (vaqt o‘tishi bilan orttirilgan)
bo‘lishi kerak. Axir har qanday ranglar to‘g‘risida nazariyalarga
tushmaydigan, lekin sifatli va talantli dizaynerlik ishining namunasi
bo‘la oladigan juda ko‘plab yechimlar mavjud-ku.

1.3. Shakl

Shakl — bu har ganday obyektning eng muhim gismidir. Biz
rang, tekstura, o‘lcham to‘g‘risidagi ma’lumotlarni tushurib
goldirishimiz mumkin, lekin shakl to‘g‘risida doimo eslashga to‘g‘ri
keladi. Har qanday dizaynerlik ishi obyektlar uchun shakllarni
tanlab olishdan boshlanmog‘i lozim.

«Shakl» tushunchasiga ta’rif berish ancha murakkab. Agar ozgina
bo‘rttirib gapirsak, bu obyektning barcha geometrik munosabatlari
yig‘indisidir. Judayam ko‘p migdordagi shakllar bor, shuning uchun
ularni fagat qurilishiga ko‘ra sinflarga ajratish mumkin.

a Ko pburchaklar. Bunday figuralar to‘g‘ri chiziglardan quriladi.
Ularga biz o‘rganib qolgan to‘g‘ri chiziq, uchburchak, kvadrat,
yulduzchalar hamda murakkabroq figuralar ham kiradi (1.711-
rasm, a).

a Egri chiziglilar. Bu figuralar silliglangan chiziglarga asoslangan
figuralardir (1.11-rasm, b). Ularga doira, oval, yoy va boshqgalar
kiradi.

s Amorf. Bular aniq bo‘lmagan murakkab shakllardir (7.71-
rasm, d). Amorf figuralar teksturalarga juda yaqin bo‘ladi, shuning
uchun ba’zida ularni differensiyalash qgiyin bo‘ladi.
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a) b) d)

1. 11-rasm. Figuralarning uch tipi: ¢ — ko‘pburchak; » — egri chiziglilar;
d — amorf.

Shakllar bilan ishlash — bu dizaynerlik ishining eng oddiy va
eng qiziqarli gismidir. Shakllarning mosligi to‘g‘risida ko‘p
avlodlarning tajribalari mavjud, shuning uchun ko‘pchilik shakllar
bilan ishlaganda (rang bilan ishlagandagidan farq qilib) o‘z
garashlari yetarli bo‘ladi. Lekin shakllarning asosiy formalari
to‘g‘risida keyinroq gaplashamiz.

Chiziq
Chiziq — geometrik figuralarning eng soddasi. Nazariy jihatdan
u fagat bitta o‘lchamga — uzunlikka ega bo‘ladi. Garchi amalda
ularning rangi, tipi (aytaylik, punktir chiziglardan foydalanish
keng targalgan) va yo‘g‘onligini ham berishga duch kelamiz. Ba’zida
chizig bilan to‘g‘ri to‘rtburchak o‘rtasidagi fargni bilish giyin.
Chiziglarning ikkita asosiy funksiyalari bor: boshga obyektlarni
ajratish va birlashtirish.
Ajratish — kitoblarni bezashda
0Q QORA keng rivojlangan va rivojlanayotgan
klassik usul hisoblanadi. Dizaynda
ham u juda faol ravishda ishlatiladi
(1.12-rasm).
. Lekin chiziglarning qo‘llanilishi
(tipografiya terminologiyasida
ajratish chiziqlari deb ataladi)
bachkana va judayam oshkora usul
1.12-rasm. Chiziglarni ajratish hisoblanadi. Agar sizga ishni oddiy
uchun foydalanish. va tez qilish kerak bo‘lsa, bu yaxshi
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variant, lekin agar ajratish chiziglari yordamida original nimadir olmogchi
bo‘lsangiz, ishlashga to‘gri keladi.
A\-tayluk, matn bloklarini ajratish uchun Sabeb
fondagi ranglar fargidan yoki bo‘sh blok-
lardan foydalanish gizigarlirog.
Chiziglarning birlashtirish funksiyasi
gizigarlirogq. Aytish mumkinki, bu zamonaviy
dizaynning eng yorqin va keng targalgan

girralaridan biri. Chiziglar bu holda ma’lu- v
motlar bliklari yoki grafik komponentalar Ogibat
o‘rtasidagi o‘zaro muhim ta’sir funksiyasini

bajaradi (1.13-rasm). 1.13-rasm. Chizig-

larning birlash-

Chiziglar —bu xohlagan vagtda yordamga tiruvehi funksiyasi.

kelishga tayyor bo‘lgan o‘ziga xos «kaltak-
qutgaruvchi». Bu mutaxassisning ishida doimo bo‘lishi kerak
bo‘ladigan ikki narsa: yaxlitlik va dinamizmni kompozitsiyaga
kiritishning eng oddiy usuli.

Ish davomida chiziglar o‘quvchilar uchun bir elementdan
ikkinchisiga o‘tishni ko‘rsatib turuvchi yo‘naltiruvchi rolini o‘y-
nashlari kerak. Shuning uchun ulardan foydalanishda nafagat tashqi
jozibani, balki mantigiy asoslanganlikni ham o‘ylash kerak.

Tog™i to‘rtburchak

To‘g‘ri to ‘rtburchak —dizayn uchun butunlay o‘ziga xos figura,
kompyuter dizayni uchun aynigsa. Vabuning sababi oddiy. Ko‘pgina
saglovchilar: plakatlar, kitob sahifalari —deyarli barcha poligrafik
mahsulotlari, kompyuter ekrani to‘g‘risida gapirmayoq, to‘g‘ri
to‘rtburchak shaklida bo‘ladi. Bunday holat bu figurani avtomatik
tarzda eng ko'p ishlatiladigan, eng keng targalgan figura gilib go‘yadi.

To‘g‘ri to‘rtburchakka asoslangan dizayn —bu eng oddiy va
oshkora ko‘rinib turgan yo‘l. Buning isboti sifatida siz ko‘plab web-
sahifalarni ko‘rishingiz mumkin va ishonch hosil qgilishingiz
mumkinki, ulaming barchasi shu formadan kelib chiggan.

To‘g‘ri to‘rtburchaklar bilan ishlaganda eng muhimi —
proporsiyani to‘g‘ri tanlash. Kvadratga yaqin keluvchi figuralar
unchalik yaxshi variant hisoblanmaydi: bunday yechim o‘zining
simmetrikligi tufayli modadan golgan hisoblanadi. Lekinjudayam
cho‘zilgan ham yomon: agar gorizontal bo‘yicha bo‘lsa, «yer-
lashganligi» vertikal bo ‘yicha muvozanatsizligi tufayli cho‘zilgan
bo‘ladi.
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Qadimdan oltin kesim deb ataluvchi to‘g‘ri to‘rtburchak
tomonlarining nisbati ma’lum. Bu nisbat 0,618 ga teng. Albatta,
bu har qanday vaziyatdan chiqish degani emas, lekin uni albatta
hisobga olish kerak — butun klassik arxitektura oltin kesimga
asoslangan.

Uchburchak

Bu figura ko‘p jihatdan yaxshi, lekin
chiziglar yoki to‘g‘ri to‘rtburchaklar
singari keng tarqalmagan. Sababi
shundaki, uchburchak kompozitsiyadagi
golgan figuralar bilan giyin moslashadi.

Uchburchak, aytaylik, logotip asosida TRANSPORTSERVIS
yomon ko‘rinmaydi (1.14-rasm).

Bu holatda figura asosining pastga
go‘yilganligi ajoyib tuyg‘uni — figuraning
va bu esa o‘z navbatida kompaniyaning mustahkamligini beradi.
Bunday effekt anchadan beri ma’lum, shuning uchun butun
dunyodagi ko‘plab firmalar uchburchakni o‘z belgilari qilib
tanlaganlar.

Bu figura bilan erishiladigan ikkinchi effekt — «ko‘rsatuvchi»
effektdir. Uchburchakning strelkani — biz ko‘nikkanimizdek,
yo‘nalishning standart ko‘rsatkichini eslatishi uni tomoshabinlar
e’tiborini yo‘naltiruvchi element sifatida ishlatishga imkon beradi.
Masalan, 1.15-rasmda shartli idea.com saytidagi so‘zlarning
giymatlariga e’tibor garatilgan.

1. 14-rasm. Uchburchak
asosidagi logotipga misol.
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1. 15-rasm. Fondagi uchburchak bu misolda ko‘rsatkichli strelka
vazifasini o‘taydi.
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Fon sifatida ishlatiladigan uchburchak yordamida biz bir
tomondan saytning sifatlarini ajoyib tarzda gruppaladik, ikkinchi
tomondan — bu ma’lumotni birdaniga sayt nomiga yo‘naltira oldik.
Boshqga usullar bilan bunga erishish oson emas.

Doira

Doira ko‘pgina rivojlangan jamiyatlarda eng mukammal, ilohiy
figura hisoblangan. Doira quyoshning belgisi bo‘lgan. Magbara va
qurbonlik uchun mehroblar doira shaklida qurilgan.

Zamonaviy dizaynda bu figuraga talab qolmagan. Doira sahifalari
va ekranning to‘g‘ri to‘rtburchak shakli judayam kontrastga kirishadi.

Albatta, kontrast — bu unchalik yomon emas, lekin kompyuter
dizayni sohasida kontrast asosida sifatli ishlar bajarish — buni haqiqiy
professional mutaxassisgina bajara oladi.

1.16-rasmda bosmaxonalardan birining saytini birinchi sahifasi
ko‘rsatilgan. Sahifaning yaxshi chigishiga sabab shuki, rubrikator
aylananing butun uzunligi bo‘yicha tarqatilmagan, uning bir
tomoni bo‘ylab kompakt tarzda joylangan. Bundan tashqari,
yuqgoridagi yirik gorizontal matnli blok kompozitsiyaga stabillik
go‘shadi. Lekin baribir brauzer oynasida sahifa unchalik muhim
ko‘rinish olmaydi.

PUBLISHING HOUSE .
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u
"

1. 16-rasm. Aylana asosida qurilgan web-sahifa.
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Siz o‘zingiz eslashga urinib ko‘ring, aylana asosida qurilgan
saytlarni ko‘p ko‘rganmisiz. Bu sahifani original tarzda bezatishning
eng yaxshi usuli, lekin shu bilan birga uni buzib qo‘yishning ham
eng oddiy usuli hisoblanadi.

Hozirgacha doira o‘zini to‘la oqlaydigan yagona narsa bu
logotiplarni yaratishdir. Deyarli barcha firmalardagi belgilarning
yarmi o‘zining asosidagi doirani gabul qilgan. Garchi, faqat
ba’zilarini istisno gilganda, bu ishlar ma’no jihatdan ham, bajarilishi
jihatdan ham originalligi bilan ajralib turmasa-da, eng keng targalgan
misol — aylana yordamida «O» harfiga o‘xshatiladi (/. /7-rasm).

1.17-rasm. Aylana yordamida «O» harfiga o‘xshatish — bu figuradan
dizaynda muvaffagiyatsiz foydalanishga misol.

Bir so‘z bilan aytganda, agar sizda tajriba kam bo‘lsa, bu figura
bilan hozircha ishlamagan ma’qul. Qachon yaxshi mutaxassis
bo‘lganingizda aylana bilan ishlash siz uchun bartaraf qilinib,
original natijalarni olsa bo‘ladigan giyinchiliklarni chaqiruvchisi
bo‘lib goladi.

Egri chiziglar

Egrilik — bu bir nechta har xil darajadagi egrilikka (matematik
til bilan u ikkinchi tartibli egri chiziq deyiladi) ega bo‘lgan chiziq
(1.18-rasm).
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1.18-rasm. Ikkinchi tartibli egri chiziglardan tuzilgan figura.

Zamonaviy kompyuter dizaynida bu figuralar yetarli darajada
keng qo‘llaniladi (asosan ular to‘g‘ri chiziglar bilan bir xil
magsadlarda ishlatiladi). Ammo ular bilan haddan tashqari qiziqib
bo‘lmaydi: siz asrning boshlarida urf bo‘lgan Modern stilida
bajarilgan ishni olishingiz mumkin, bu esa, unchalik sifatli emas.

Formaning yo‘qligi

Albatta, formaning yo‘qligi to‘g‘risida gapirish unchalik ham
to‘g‘ri emas — forma doimo mavjud bo‘ladi. Lekin uning
murakkabligi tahlil gilish imkoniyatini yo‘q gilsa, bunday obyektni
formasiz deb atash mumkin.

Formasiz obyektlardan foydalanish — to‘g‘ri burchakli for-
malarning qat’iy mantiqgiyligiga garama-qgarshi go‘yiluvchi
zamonaviy dizaynning yana bitta ustunligidir. Va undan u yog‘iga
borish mumkin bo‘lmagan simmetriyaga garshi kurashning
chegarasidir.

Formasizlikni quyidagilarni ta’kidlash uchun ishlatish mumkin:

« mustaqillik;

« ultra zamonaviylik;

« ommaviylik;

s €'tiroz;

a hostandartlilik.

Formasizlik aynigsa shrift bilan hamkorlikda yorgin namoyon
bo‘lishi mumkin. Bu ko‘rinishda u insonning originalligi, agressiv-
ligini juda to‘g‘ri aks ettiradi.

Formaning yo‘qligi kamchilik hisoblanmaydi, ko‘proq aksincha —
axir boshga hech nima original yechimni topishda bunchalik keng
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imkoniyatlar bermaydi. Bu yerda obyektlarning kompanovkasi
figuralarni tanlashdan kam ahamiyatga ega bo‘lmaydi. Ammo bu
haqda keyinroq gapiramiz.

Shriftli dizayn

Shriftlar bilan ishlash — dizayner ishining eng qizigarli, ko‘proq
rejali va eng murakkab gismidir. Agar siz matnlar bilan u yoki bu
darajada shu kasbning ustasi bo‘lmoqchi bo‘lsangiz, shriftlarning
dizayni bo‘yicha maxsus adabiyotlarni sotib olib va ularni o‘rganishga
ancha vaqt sarflashingiz kerak bo‘ladi.

Shunday qilib shriftlar asosan uch turli bo‘ladi:

a bezakli;

= qat’iy;

= erkin stilda.

Design
a) Design

b) Design
d)

1. 19-rasm. Shriftlarning uch tipi: @ —bezakli; b — gat’iy;
d — erkin stilda.

Garnitura

Shriftlarning dizaynida biz yuqorida aytib o‘tilgan yaxlitlik va
kontrastning boshqa tamoyillari ishlaydi. Kesimli va maydalangan
shriftlar ko‘proq mos keladi. Bunga tajriba davomida ganchalik
ko‘p ishlatilishini ko‘rib, ishonch hosil qilishlari qiyin emas.

Maydalangan shriftlar qo‘lyozma ko‘rinishida ishlangan shriftlar
bilan ham mos kelmaydi, lekin bu absolyut qoida emas. Dekorativ
va kesimli shriftlar bir-biri bilan juda yomon moslashadi — bunday
go‘shnichilikdan qochishga harakat qiling.

O‘Ichov

Yozuvlarning o‘Ichovini tanlash anchagina murakkab hisoblanadi.
Dastlabki keladigan fikr — agar birorta yozuv katta bo‘lsa, u holda
ko‘ruvchilar tomonidan ham unga qiziqish katta bo‘ladi. Lekin bu
unchalik qgizigarli emas.

o
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Information
&
Design

1.20-rasm. Judayam yirik matn ko‘ruvchi informativlik funksiyasini
yo‘qotadi va dizayn elementi sifatida gabul gilina boshlanadi.

Ammo vyirik harflar logotiplar, sarlavhalar, ko‘rsatkichlar —
bir so‘z bilan aytganda dekorativ funksiaysi informativlik
funksiyasidan kam bo‘lmagan hamma elementlar tarkibida juda
yaxshi ko‘rinadi.

Mayda shriftlar o‘zida harfni ham jamlaydi. Bizning ishda u
o‘quvchi giynalmay o‘qiy olishi uchun unchalik ko‘p bo‘Imasligi
kerak. Bundan tashqari, alohida matnli bloklar yetarli darajada
mustaqil, ya’ni bo‘shliq bilan ajratilgan bo‘lishi kerak.

Rang

Umuman olganda bu bo‘limda aytilgan rangli dizaynga
bag‘ishlangan barcha qoidalar matnlar uchun ham o‘rinlidir.
Faqgat bir fikrni qo‘shib qo‘yish kerak: agar siz bitta so‘zdagi
bitta harfni yoki bitta gapdagi bitta so‘zni ajratib ko‘rsatmoqchi
bo‘lsangiz, u holda yoki rangdan foydalaning, yoki garnituradan.
Ularni birgalikda ishlatish hayratlanarli darajada yomon natijaga
olib keladi (1.21-rasm).

PHOTOSHOP PHOTOSHOP
PHOTOSHOP

1.21-rasm. Fragmentni ikki marta ajratib ko‘rsatish
(garnitura va rang bilan) — yomon usul.
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1.4. Qisqacha kompozitsiya to‘g‘risida

Kompozitsiya to‘g‘risida suhbat boshlash hech bo‘Imasa shuning
uchun murakkabki, bu mavzu alohida ¢’tibor talab giladi. Biz
kompozitsiyalar mavzusini ochishga talabgor emasmiz — buning
uchun, agar siz haqiqatda tajribali dizayner bo‘lmogqchi bo‘lsangiz,
o‘gishingiz mumkin bo‘lgan maxsus kitoblar bor. Ammo agar siz
kompozitsiyalar nazariyasi bilan umuman tanish bo‘lmasangiz,
bu bo‘limni diggat bilan o‘qib chiging.

Kompozitsiyalar nazariyasining asosida biz ko‘p narsani
ixtiyorsiz, instinkt va reflekslar darajasida gabul qilishni tushu-
namiz. Obyektlarning bir xil joylashishida barcha kishilarda bir xil
reaksiya hosil bo‘ladi. Masalan, 1.22-rasmdagi aylana bilan
to‘rtburchakning ganday joylashishida sizda havfsirash, o‘ng‘ay-
sizlik tuyg‘usi hosil bo‘ladi. Mualliflarning ishonchi komilki, bu b
variantdir.

a b

1.22-rasm. Kompozitsiyadagi obyektlarning turlicha joylashuvlari garama-
garshi tuyg‘ularni vujudga keltirishi mumkin: ¢ — stabillik; b — o‘ng‘aysizlik.

Shunday qilib, har ganday kompozitsion ish asoslangan
bo‘lishi kerak. Dizaynda esa, ko‘pchiligimizni hayratlantirgan,
nazariyani bilmasdan turib, kerakli natijaga deyarli erishish
mumkin emas.

Kompozitsiyaning asosida ikki tushuncha yotadi: yaxlitlik va
kontrast.

Yaxlitlik

Bu tushuncha o‘zida bitta magsadga olib kelishi kerak bo‘lgan
ko‘plab talablarni jamlaydi. Hatto aytish mumkinki, yaxlitlik —
bu usul emas, balki dizayndagi maqgsad, yakuniy natijada ish, u
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logotip yoki Web-sahifa bo‘ladimi, yaxlit butun ko‘rinishga
bo‘lgan talabdir.

Amalda esa, bu o‘zini vositalar tomonidan chegaralashni
bildiradi. Sodda qilishdan qo‘rgmang! Aksincha, sizning
dizayningizdan soddaroq nimadir o‘ylab topish qgiyin bo‘ladigan
darajada soddalikka intiling. Agar shriftning bitta garniturasidan
foydalanishga imkoniyat bo‘lsa, bitta garnitura ishlating, imkoniyat
bo‘lsa, butun dizaynni bitta figuraga keltiring.

Yaxlitlik tamoyiliga ko‘pincha boshlovchi web-ustalar amal
gilishmaydi. Bizningcha, siz GIF-animatsiyalar, katta hajmli
elementlar, ulkan sarlavhalar va juda yorqgin ranglarda yaratilgan
ijod namunalarini ko‘p ko‘rgansiz. Aynigsa, o‘zlarini tajribali
dezayner hisoblovchi va o‘z xizmatlarini anchagina katta mablag’
evaziga taklif giluvchi bu asarlarning mualliflari juda o‘ng‘aysiz
ko‘rinishadi. Ularning xatolarini takrorlamang, aqlsiz yoki uquvsiz
ko‘rinishdan go‘rgmang — oddiylikka intiling.

Kompozitsiyada yaxlitlikka erishishning eng muhim kompo-
nenti — bu muvozanatga crishish. Muvozanat — sizning ishingisni
ko‘rgan kishilarda «bu yerda nimadir yetishmayapti», degan tuygu
hosil bo‘lmasligi kerak.

Kompozitsiya muvozanatiga nafagat obyektlarning nisbatan bir
tekisda tagsimlanishi hisobiga emas, balki ularning o‘lchamlari,
rangi, yorqginligi, formasi hisobiga ham erishiladi. Masalan, web-
sahifaning bir tomonida sizda kattagina matnli blik bo‘lsa, u holda
ikkinchi tomondan bezak yoki qora fon hisobiga muvozanatga
keltirish mumkin.

Muvozanat asosan ikki tipli bo‘ladi: rasmiy va norasmiy.

Rasmiy muvozanat kompozitsiyaning optik markazi atrofidagi
simmetriyani nazarda tutadi. Rasmiy muvozanatga ko‘proq
simmetriyaning hisobiga erishiladi.

Rasmiy muvozanat — bu kompozitsiyadagi garmoniyaga
erishishning eng oddiy usullaridan biridir. Lekin u simmetriyani
nazarda tutadi, simmetriya esa, bu kitobda bir necha bor ta’kid-
langanidek, zamonaviy dizaynda deyarli aqlli yechim deb hisob-
lanmaydi. Har holda kompozitsiyasiz simmetriya bilan ishlagan
ma’qulroq. Bu hech bo‘Imasa shu narsani bildiradiki, klassik san’at,
ayniqgsa, klassik arxitektura, o‘z asosida rasmiy muvozanat
tamoyillariga amal qilib keladi, ya’ni oltin kesim proporsiyasi,
formalarning qat’iyligi, absolyut simmetriya.
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Rasmiy muvozanatni quyidagi sifatlar aniq ta’kidlashi mumkin:

s konservatizm;

a doimiylik;

= mustahkamlik;

s« munosiblik.

Ammo hozir ikkinchi tip — norasmiy muvozanat ko‘proq
ishlatiladi. U rasmiy muvozanat kabi aniq-ravshan belgilarga ega
emas, shuning uchun unga tajriba yordamida va ta’bga asoslangan
holda erishish mumkin.

Norasmiy muvozanatga ko‘plab usullar bilan
erishish mumkin, lekin ularning mazmuni bitta —
anchagina sodda fikrga olib keladi: simmetriyadan
tashgari hamma narsa mumkin. Ya’ni agar siz web-
sahifada yoki reklama varaqchasiga yirik figurani
joylashtirgan bo‘lsangiz va u boshqalardan kuchli

: S o y 1.23-rasm.
darajada ustunlik gilayotgan bo‘lsa, boshqga figura- Vivik Patols
larning ranglarini o‘zgartirish hisobiga uning plok o‘lchami
yorqinligini kamaytirish mumkin. Va teskarisi, yirik  bo‘yicha ancha
matnli blok o‘lchami bo‘yicha ancha kichik, lekin  kichik, lekin
butun figuralar bilan yengil muvozanatga kirishadi ~ butun figuralar
(1.23-rasm). bilan — yengil

Norasmiy muvozanatga erishishda eng Ez:}?ﬁ;natga
murakkabi biz shu bobdagi qoidani buzmaslik — '
hammasini oddiy qilish. Variantlarning ko‘pligi shunga olib keladiki,
biz u yerga ozgina qo‘shamiz va bunga qo‘shimcha qo‘shamiz, natijada
zamonaviy dizaynni o‘rniga obyektlar uyulmasini hosil gilamiz.

Kompozitsiyaning yaxlitligi uchun barcha elementlar (iloji
boricha) yagona ritmga rioya gilgan holda joylashsin. Ritm — bu
kompozitsiyada obyektlar bilan bo‘sh o‘rinlarning yoki obyektlar
bilan boshga obyektlarning belgilangan tartibiga rioya qilishdir
(1.24-rasm).

| | | COLOMNS inc.

1.24-rasm. Logotip dizaynida ritmdan foydalanish.
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Aniq bir ritmga erishishga intilishda (axir u ishning umumiy
«kayfiyatiga» kuchli ta’sir giladi) eng oddiy yechimdan — oshkora
simmetriyadan qochishga harakat qiling.

Kontrast

Kontrast to‘g‘risida biz oldin gapirib o‘tdik. Kontrast — bu
zamonaviy dizaynning asosi. U yoki bu darajadagi professional
ishlar kontrastga asoslanadi yoki komponenta sifatida kontrastga ega
bo‘ladi.

Bir tomondan, kontrast — yaxlitlikning garama-qarshisidir.
Bu bilan kompozitsiyadagi butunlikka erishilmaydi, aksincha,
kontrastning maqgsadi obyektlar o‘rtasidagi farglarni ta’kidlashdir.
Lekin bu ikki tushunchalarni bir-biriga qarshi qo‘ymaslik va ular
o‘zaro kelisholmaydi deb o‘ylamaslik kerak. Aynan kontrast bilan
yaxlitlik o‘rtasidagi «oltin oraligrga intilish kerak.

Kontrast to‘g‘risidagi asosiy fikrlar oldinroq aytib o‘tildi.
Shuning uchun hozir biz oldinroq aytilganlarni kompozitsiyadagi
kontrastning har biri to‘g‘risida bir nechta so‘z qo‘shgan holda
jamlaymiz.

a O‘lcham. Kontrastga erishishning eng yaxshi usullaridan biri —
bir xil geometrik figuralar o‘lchamlari o‘rtasidagi farq. Lekin shuni
esda tutish kerak: agar bu farq yetarli darajada katta bo‘lmasa,
tomoshabin uni dizaynerning ishi deb emas, balki xatolik deb
gabul qiladi (1.25-rasm).

a b

1.25-rasm. Kontrast: a — figuralar orasidagi yetarlicha bo‘lmagan farq xatolik
singari gabul gilinadi; b — bu fargning orttirilishi holatni tuzatishi mumkin.

Forma

Formadan yaxshisi kompozitsiyani yaxlitligini ta’kidlash uchun
foydalangan ma’qul. Masala shundaki, egri chizigli va to‘g‘ri chiziqli
figuralar o‘zaro oshkora, qo‘pol, naturalistik kontrastga egaki,
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fagat ko‘pchilik professional ishlami bajara olmaydi. Agar figuralar
bir-birlariga o‘xshamasa (masalan, kvadrat va uchburchakdek), u
holda ulaming birlashtirilishi yakunlanmaganlik tuyg‘usini beradi,
tomoshabinlami g‘ashini keltiradi (1.26-rasm).

1.26-rasm. Kontrast: a — egrichizigli va to‘g‘richizigli figuralar juda qo‘pol
kontrast yaratadi; b —bir tipdagi formalar orasidagi farq unchalik sezilarli
ifodalanmagan.

m Rang. Ranglardagi farglar yordamida toMa kontrastga erishib
boMmaydi. Lekin u toMdiruvchi sifatida, «ikkinchi ovoz» uchun
juda ajoyib variant.

mShrift. Shriftlar 0‘z-o0°zidan formalaming oshkora kontrastlikni
namoyon qgiladi. Shuning uchun gamituralar o‘rtasidagi ortigcha
oshkora farglami gidirish dizayndagi tavtalogiya kabi rolni o‘ynaydi.
Ehtiyot boMing!

Butun kompozitsiya bo‘yicha kontrast —bu hamma sanab
o‘tilgan kontrastlaming yig‘indisi. Unga erishishda meyorga e’tibor
bering: masalan, uning oMchamlari tufayli shundog ham yaxshi
kontrast berayotgan elementni alohida rang bilan ajratmang.

Il. CORELDRAWDA ISHLASH
2.1. Hujjatni yaratish va ochish

CorelDraw dasturi ishga tushirilgandan keyin ekranda COREL
DRAWga XUSH KELIBSIZ (welcome to Corel DRAW) so‘zi
nomayon bo‘ladi va dasturni ishga tushirishning bir nechta
variantlarini tanlashni so‘raydi: Yangi hujjat (New Graphic), oxirgi
ishlangan hujjatni ochish (Open Last Edited), hujjatni ochish
(Open Graphic), tayyor shablonlami ochish (Template), dastur
0°‘rgatuvchini ishga tushirish (CoreITUROR), nima yangilik?
(What is New?)
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Welcome to CorelDRAW

‘-“"L"'lc.mirr:

Yangi hujjatni yaratish uchun menyuning Fayl (File) va Yangi
hujjat buyrug‘i (New) yoki uskunalar panelidagi maxsus tugma
bosiladi. Hujjatni ochish uchun menyuning Fayl (File) va Ochish
(Open) buyruglari yoki uskunalar panelidagi maxsus tugmalar
yordamida amalga oshiriladi.

Corel DRAW dasturida bir vaqgtning o‘zida bir nechta hujjatlar
bilan ishlash imkoniyatlari bor, shu bilan birga kerak bo‘lmagan
hujjatlarni yopib qo‘ysa ham bo‘ladi. Bu esa, menyuning Fayl
Yopish (Close) buyrug‘i yordamida amalga oshiriladi.

Dastur interfeysi

Dastur ishga tushirilgandan keyin ekranda dastur oynasi
namoyon bo‘ladi, bu oyna foydalanuvchi interfeysi (user interface)
yoki ishchi joyi (workspace) deb ataladi. Interfeys foydalanuvchi
va kompyuter orasidagi mulogotni o‘rnatadi, ishlash uchun kerak
bo‘lgan barcha sharoitni yaratadi.

Shuni nazarda tutish kerakki, interfeys foydalanuvchi
tomonidan o‘zgartirilgan bo‘lib, umumiy ko‘rinishidan o‘zgacha
bo‘lishi ham mumkin.

Foydalanuvchi interfeysi quyidagilardan tashkil topadi: sarlavha,
bosh menyu, hujjatlarni ko‘rish uchun ishchi oynalar, tasvirlarni
muharrirlash uchun bir nechta panellar yig‘indisidan iborat.

Oynaning markazidagi katta bo‘sh joy ish joyi deb nomlanib,
har bir hujjat uchun alohida ochiladi.
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Bosh menyu
Ekranning yuqori gismida bosh menyu buyruglari (menu bar)
joylashgan bo‘lib u quyidagilardan tashkil topadi:

¢ Fail (File) e Rastrli tasvirlar (Bitmaps)
e Mubharrirlash (Edit) e Matn (Text)

e Ko‘rish (View) ¢ Servis (Tools)

¢ Kompanovkalash (Layout) ¢ Oyna (Window)

e Boshgqarish (Arrange) e Yordam (Help)

Effektlar (Effects)

Har bir guruhning bir-biriga yaqin amallarni bajaruvchi buy-
ruqlar yig‘indisidan, masalan, Matn (Text) menyusi matnlar ustida
amallar bajaradigan buyruglar, Effektlar (Effects) menyusi —
vektorli va rastrli tasvirlar uchun har xil effektlar berish va
muharrirlashda foydalaniladigan buyruglardan tashkil topgan.

Shu bilan birga go‘shimcha menyu (Context-sensitive menu)ga
kiritilgan bu menyu vazifasi joriy bo‘lgan asbobning obyektlari
hagida ma’lumot beradi.
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Vositalar satrlari

Menyu satri tagida asboblar satri (Toolbars) joylashgan.
Asboblar satrini ekranning xohlagan joyiga va har xil ko‘rinishda
joylashtirish mumkin.

Ekranda kerakli oynalarni joriy gilish uchun menyuning oyna
(Window)si yordamida amalga oshiriladi va ular ustida quyidagi
amallar bajariladi: Asboblar (Toolbars) satriga sichqonchani o‘ng
tomoni bilan chertib mulogot oynasini tashkil etamiz va
Parametrlar (Options), Rostlashgan kerakli bo‘lgan asboblar
tanlanadi.

Xossalar (Property Bar) satri

CgoiictBa (Property Bar) asboblar satridagi maydonlar va
tugmalar yig‘indisi foydalanilayotgan asboblar yoki tanlangan
obyektga bog‘liq bo‘ladi, masalan, asboblar satridagi matn bloki
tanlanganda matnning parametrlari ko‘rsatiladi.

A
2 lLADeledAlmticTw v || Tp AvantGarde BKBT « 24 - BZU K~ < == 8 € |7 o
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CnoiictBa (Property Bar) satridagi asboblardan birontasi
tanlanmagan bo‘lsa, hujjatning umumiy parametrlari ko‘rsatiladi,
masalan, sahifa formati, uning oriyentatsiyasi va hokazo ko‘rsatiladi.

=
2 v a (500 e, W | ¥
A v BT 210 0% e = [@2sion 3 [QEERM TR 42 4y @ k(| 62

Holat satri (Status Bar)

Ekrandagi ishchi oynaning pastgi gismida holat satri (Status
Bar) joylashgan, bu satrda obyektlar hagida ma’lumotlar beriladi
yoki quyidagi parametrlar: obvodka va zalivkalar, shrift turlari,
tanlangan obyekt ma’lumoti va joriy asboblar hagidagi ma’lumot-
lar beriladi. Holat satrining ko‘rinishi va tuzilishini o‘zgartirish
ham mumkin.

kst ot AvrtGorde 85 B1 (Mool on Lays 1 Fit Blach -
158,33 167689) 0.0 Hore ><

Asboblar paneli (Toolbox)

Asboblar paneli ishchi oynaning chap tomoniga joylashtirilgan
bo‘ladi. Asboblar panelidagi grafik obyekti ustida quyidagi amallar
bajariladi — obyektlarni yaratish, ajratish, muharrirlash va
ko‘chirish.

Asboblar bilan ishlash paytida kursor tanlangan obyektga qarab
shaklini o‘zgartiradi. Shu bilan birga, asboblar panelidagi ba’zi bir
asboblar guruhini «Suzuvchi»(«IlnaBatoime») panel ko‘rinishida
yoki «Flyout» ko‘rinishida sozlash mumkin.
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Docker ko‘rinishidagi panel

Docker ko‘rinishidagi paneli mulogot oyna shaklida bo‘ladi. Bu
panellar har doim ekranda mavjud bo‘ladi va ishchi oyna yonida
joylashadi. Ekranga kerakli bo‘lgan panelni chaqirish uchun
menyuning Oyna (Window) va Docker (Dockers) ko‘rinishidagi
panel buyrug‘i va ochilgan ro‘yxatdagi panellardan bittasi tanlanadi.

e Object Manager paneli (ducneruep oObekTOB) — Obyekt
parametrlarini tasvirlaydi, obyekt iyerarxiya gatlamlarini boshgaradi.

e View Manager paneli (lucneruep BUJIOB) — «tasvir
ko‘rinishlari»ni tasvirlaydi va boshqgaradi.

e Graphic and Text Styles paneli (Ctwim Tekcra v rpaduku) —
grafik va matn stillarini yaratadi va o‘zgartiradi.

e Color Styles paneli (LLBeroBbie ctuin) — obyektlar bilan
ishlashda ranglarni tanlaydi va ular yordamida amallar bajaradi.

e Symbols and Special Characters paneli (CumBoJibl U
cneumanbHbie 3HakM) — mavjud bo‘lmagan belgilarni tasvirlashda
foydalaniladi.

e Internet Bookmark Manager paneli (Jlucneruep 3aknajiok
Internet) — gipermatnlarni boshqarish va yaratishda ishlatiladi.

e HTML Object Conflict paneli (AHaimm3arop KOH(MJIMKTOB
oobektoB HTML) — Internetda nashr etilgan avvalgi hujjatlar-
ning to‘g‘riligini tekshiradi va noto‘g‘rilarini tuzatadi.
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e Script and Preset Manager paneli (J/Iucneryep MakxpocoB u
roToBbIX 00pa3ioB) — makro dasturlarni yozishda foydalaniladi.

¢ Object Data pancli (ma’lumotlar jamg‘armasi) — har bir
obyektning jadvaldagi ma’lumotlari berkitiladi, masalan, narxi,
o‘lchami va hokazo ma’lumotlar.

e Object Properties paneli (CpoiicTBa 006bekTOB) — hujjat-
dagi obyektlarning barcha parametrlari hagida ma’lumot beradi va
o‘zgarish kiritadi.

e Link Manager paneli (lucnerdep cBsS3aHHBIX HU300pa-
XeHuit) — hujjatda mavjud emas, fagat u bilan bog‘langan
tasvirlarni boshqaradi.

¢ Bitmap Color Mask paneli (LIBeToBasg Macka TOUYCYHOTIO
n3obpaxeHus) — rastrli tasvirlar bilan ishlashda ranglar maskasini
yaratadi.

e Lens paneli (Jlunza) — linza turini tanlash va uning
parametrlarini o‘rnatadi.

o Artistic Media paneli (Mmurtauusi) — vektorli galamning
murakkab turlari bilan ishlaydi.

¢ Transformation paneli (TpancgopmupoBanue) — obyektlarni
siljitishning har xil turlari bilan ishlash.

e Shaping paneli (MU3menenue ¢dopmnl) — bir nechta
obyektlarni uch xil ko‘rinishda biriktirish.

e Color (IIBet) va Color Palette Browser (lIBeToBbIE
nautpel) panellari — ranglar bilan ishlash.

e Browse (O630p) paneli — hujjatlarni boshqarish va ularni
har xil ko‘rinishlarda ko‘rish.

e Cliparts (BexTtopHbele uszobpaxenusi), Photos (®Potor-
pacdun), 3Dmodels (TpexmepHsie Monmenu) panellari — dastur
bilan birgalikda o‘rnatilgan kompakt disklar bilan ishlash (CD-
ROM).

¢ FTP Sites (Catitet FTP) paneli — FTP saytlarini saglash va
katta massivli ma’lumotlarni ko‘chirish uchun ular bilan tez
bog‘lanish.

Agarda yuqorida ko‘rsatilgan menyuda gandaydir buyruq
bo‘lmasa u holda menyuni (Menu) Parametrlar (Options)
yordamida qo‘shish mumkin.
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Interfeysni saqlash va o‘zgartirish

Corel DRAW dasturi interfeysini foydalanuvchi o‘zi xohlaganday
qilib rostlashi va uni xotirada saqlash imkoniyati bor.

Uning uchun quyidagi amallar bajariladi: Menyuning (Tools)
dan Optsii... (Options) buyruq tanlanadi va ochilgan muloqot
oynasidan Interfeys (Workspace) tanlanadi. Yangi... (New) tugmasi
ckranga Yangi interfeysni (New Workspace) yoritadi. Yangi
interfeysni (New Workspace)da interfeysning yangi parametrlarini
kiritish uchun foydalaniladi; masalan, Nom-maydoniga yangi
interfeys nomi (Name of new workspace) kiritiladi va yangi
interfeysni joriy qilish uchun belgi (Set as current) qo‘yiladi.

2 x|
MName of new workspace: MIBAGE
Base new workspace on: ,_default < [
Description of new workspace: [

| Set as current workspace

| 0K I Cancel Help
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Hujjatlarni xotirada saqlash

Corel DRAW dasturida hujjatlarni xotirada bir nechta usul bilan
saglash mumkin.

Menyuning Fayl (File) va Saqlash (Save) buyrug‘i yordamida
joriy hujjatni joriy jildda saqlaydi. Bu amal asboblar panelidagi
maxsus tugma yordamida ham amalga oshiriladi.

CoxpaHuThb Kak... (Save As) buyrug‘i esa joriy hujjatni boshga
nom va boshga jildda, va boshgacha formatda saglash imkoniyatini
beradi. Bu amalni bajargandan keyin yangi hujjatni xotirada saglab,
ekranga Tasvirni saqlash (Save Drawing) ni beradi.

e Versiya (Version) ro‘yxatidan CorelDRAW dasturining
avvalgi variantlaridan birini yoki yangi variantini tanlab hujjatni
mos formatda xotirada saglaydi.

Faqat dasturning eski variantlarida hujjatlarni saglaganda bir
nechta parametrlar yo‘qolib ketishini esda tutish lozim.

24x]
o — ; =i | ‘
Manka: | 3 SYSTEM (C) R l== Save |
_|_RESTORE i g6546.cdr 4 Backup_of Cancel
inf £ 66546222222.cdr «¥*Backup_of
_IProgram Files =2 Backup_of _66546,cdr # Backup_of
_Junzipped 22 Backup_of _66546222222.cdr 1 Backup_of Version:
_IWINDOWS " Backup_of_Graphicl.cdr = Graphicl.c \T/;;&n 30 =i
_IMom AcKyMeHTEl 4 Backup_of _WEB.cdr 1 WEB.cdr g
Thumbnall:
< | * 10K feolo) ¥
File name:  |Julia.cdr pad|
Files of type: | CDR - CorelDRAW | Advanced.. |
Sottype: | Defaul ] (=
== | Selected only
Keywords: — |i0un [ EmbedICC profile
Notes: LiseTHoi ofbext | No white spaces, special characters

| Embed Fonts usingTrueDoc (TM)

| Save with embedded YEA Project

e Thumbnail ro‘yxati xotirada saqlashning bir nechta
variantlarini beradi: hujjatlarning o‘lchamini bir qancha kichik qilib
berishi ham mumkin, faqat keyinchalik fayllarni qidirganda
giyinchilik tug‘diradi. 1K (mono), 2K (mono), 4K (color), 8K
(color) oq va qora, yoki rangli tasvirlarni har xil sifatda xotirada
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saglasa ham bo‘ladi. Agarda hech biri tanlanmagan bo‘lsa, u holda
maxsimal sifatli tasvirli hujjat xotirada saglanadi.

e Selected only (Fagat tanlangan obyektlar) tanlanganda yangi
faylga ajratilgan obyektlar saglanadi, shu bilan birga boshqa faylda
obyektning alohida gismini ham saglash mumkin.

¢ [CC profile (ICC profilini joylashtirish) hujjatdagi ranglarni
boshqgarishda dastur fagat CPT CDR, TIFF, JPEG, PICT wu
EPS formatli fayllar bilan ishlaganda bajariladi.

e No white spaces, special characters (Bo‘sh joy va maxsus
belgilarsiz) belgisi hujjatni xotirada saglaganda bo‘sh joy tagini
chizish bilan, maxsus belgilarni Web standartidagi belgilar bilan
almashtiradi.

e Embed Fonts using TrueDoc (Shriftlarni TrueDocdan
foydalanib yozish) hujjatda TrueDoc texnologiyasidan foydalan-
gani hagida ma’lumot beradi.

o Keywords (kalit so‘zlar) va Notes (Tuchunsha berish)
hujjatlarni tez topish uchun ularga tushuntirish so‘zlari yoziladi.

e Advanced tugmasi... (Qo‘shimcha) ekranga Save (saglash)
dialog oynasini va Options, parametrlari o‘rnatilgan bo‘ladi.

e Save presentation exchange (Boshqa muharrirlagichlar
formatida saglash) CMX formatida ishlaydigan boshga muharrir-
lash faylini oching. Buni ishga tushirganda faylning o‘lchami katta
bo‘ladi.

Save ME
# Workspace | B Save presentation exchange (CMX)
= Document Use current thumbnai
General
4-Page File optimization:
- Guidelines |v Use bitmap compression:
Grid |v Use graphic object compression
Rulers
Styles Textures:
Save + Save textures with the fle
- Publish To Internet Rebuild textures when opening the file
# Global
Blends and extrudes:

Save blends and extrudes with the file
+ Rebuild blends and extrudes when opening the file

_ Omena | Hep |
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e Use current thumbnail (mavjud miniaturadan foydalanish)
rastrlangan hujjatni miniatura yordamida saglashni ta’minlaydi. Bu
faylni saglashga mo‘ljallangan vagtni ma’lum migdorda kamaytiradi,
ammo agarda hujjat bir necha marta gayta ishlangan bo‘lsa, xatolikka
olib kelishi mumkin.

¢ File optimization maydonida (faylni optimallashtirish) ikki
xil turdagi fayllarni saglaydi, rastr (Use bitmap compression) vektor
tasvirlarni va bu faylning o‘lchamini kichik giladi.

eTextures maydoni (Matn zalivka) va Blends and extrudes
(«Ketma-ket o‘tish» va «Ekstrudiya») tarkibiga garaganda bir
xil:

» Save ... with the file (fayl bilan saglash) fayl o‘lchami katta
bo‘ladi, fagat hujjat o‘qilganda tezroq ochiladi;

»Rebuild ... when opening the file (ITocTpouTb ... IPU OTKPLITUHA
(aitta) — yuqoridagi teskari faylni o‘qish ko‘p vaqt talab etadi va
o‘lchami katta bo‘ladi.

Ekranda tasvirlash

Vektor grafikasi muharrirlarining ekranida (ishchi maydonda)
ganday tasvirlar bo‘lsa, bosmadan shu ko‘rinishda chiqariladi.
Ekrandagi ishchi oynada tayyor bo‘lgan tasvirlarni ko‘rish uchun
menyuning Ko‘rish (View) dan foydalaniladi. Dasturda besh xil
ko‘rinishni ko‘rish mumkin: Oddiy konturli (Simple Wireframe),
Konturli (Wireframe), Chernovoy (Draft), Normal (Normal),
Yaxshi (Enhanced).

Agarda hech biri tanlanmasa u holda normal (Normal) holatini
kompyuter o‘zi tanlaydi.

Ekranni masshtablash

Ekrandagi tayyor bo‘lgan rasmlarni katta va kichik hollarda
ko‘rish funksyalari mavjud. Shuning uchun asboblar panclidagi
(Toolbox) Masshtab (Zoom) tanlanib, kattalashtirish yoki ki-
chiklashtirish parametri ko‘rsatiladi.

E|
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= Standart asboblar paneclida
A masshtablash parametrlari berilgan va
A ular quyidagilar: Ajratilgan obyektlar
@}.‘ (To Selected), hamma obyektlar (To
Y Fit), Sahifa (To Page); Sahifaning eni
CT bo‘yicha (To Width), Sahifaning bo‘yi
o bo‘yicha (To Height); 10%, 25%, 50%,
o 75%, 100%, 200%, 400% ga
é{ masshtablashga bo‘linadi.
=t Ekrandagi tasvirlar kattalashtiril-
O ganda hujjatdagi ba’zi bir obyektlar ko*-
b rinmay qoladi. Obyektlar bilan ishlashga
w) to‘g‘ri kelganda shu obyektlar siljitiladi.
o, Buning uchun quyidagi ikkita imko-
&, niyatlardan bittasi tanlanadi:
&, 1. Vertikal va gorizontal siljitishlardan.
2. Maxsus asbob Panoramadan

(Pan). Bu holda ekrandagi kursor qo‘l shaklini oladi va obyektni
xohlagan tomonga siljitishi mumkin.

Chizg‘ich

Chizg‘ich ekranda ko‘rinib turadi, agarda u yo‘q bo‘lsa menyu-
ning Ko‘rish (View) tanlanib Chizg‘ich (Rulers) buyrug‘ini
belgilash kerak bo‘ladi, ikkinchi marta bu amal bajarilsa ekrandan
chizg‘ich olib tashlanadi.

Chizg‘ichni ekranning xohlagan joyiga qo‘yish mumkin. Buning
uchun <Shift> tugmasi bilan birgalikda sichqonchani olib borib
xohlagan joyga qo‘ysa bo‘ladi. Agarda <Shift> tugmasi bilan birgalikda
chizg‘ichga ikki marta sichqoncha bilan chertilsa avvalgi holiga
gaytariladi.

Agarda <Shift> tugmasisiz ikki marta chertilsa, u holda
chizg‘ichning (Rulers) Parametrlari (Options) ckranda namoyon
bo‘ladi.

CorelDRAW dasturidagi chizg‘ich har xil o‘lchov birliklarida
beriladi. O‘Ichov birliklari (Units) quyidagilardir:
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21|

Rulers v [Ries =
[#-Workspace ~Units ‘
(= Document Horizontal: ' millimet = Hint: Changing the Horizontal
General | rilnoters _ I Ruler Unis sets the |
[+ Page Vertical millimeters v default drawing units.
- Guidelnes [ Same units fof 2! 2kal nders
Grid MhmsSiamndpomiatoc) yards
S miles
;L:iers Origin centimeters | Tick divisions:
es . et B e
S Horizontal origin: [eters Sl | 10 per tick v ‘
[+ Publish To Internet Vertical origin: {00 —] millimeters [v Show fractions
[+ Global = !
v Show Rulers ‘
Edit Scale.. | ‘
\
|
\

e dyuymlar (inches), 1(engliz) dyuymi 24,5 MM teng;

e millimetrlar (millimeters);

e pikalar (picas), 1 pika 12 punktga teng;

e punktlar (points), 1 punkt 1/72 engliz dyuymiga teng (24,5 Mm);

o pixellar (pixels), nisbiy o‘Ichov birlik (absolyut giymatga ega
emas);

e sisero (ciceros), 1 sisero 12 punktga teng;

¢ Dido punktlari (didots), 1 Dido punkti 1/72 farang dyuymiga
teng (27,06 mMm);

o futlar (feet), 1 fut 304,8 MM ga teng;

e vardlar (yards), | yard 914,4 mm ga teng;

e milar (miles), 1 mil 1609 m ga teng;

e santimetrlar (centimeters);

e metrlar (meters);

e kilometrlar (kilometers).

Hujjatning umumiy ish maydoni 45 x 45 metrga teng. Bu esa,
dasturdagi ko‘rgazmalar va katta hajmli obyektlar bilan ishlaganda
juda qo‘l keladi.
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Sahifalarning parametrlari

C :gg;gg;g:: [0 O[] rmeee = |@2stom —S{QERm T2 33 @@ AR &

o [

Legs

é:;"mw Ekrandagi hujjatning sahifa formati to‘g‘ri to‘rt-

oy burchak shaklidagi ko‘rinishda bo‘ladi. Agarda sahifa

Broad Sheet . . . . . w

20 formatini o‘zgartirmoqchi bo‘lsangiz CBoiictsa (Property

2‘5 Bar)dan foydglansa bo‘lafii. . - .

§§ B Agarda Kitob (Portrait)ni tanlasangiz hujjatning bo‘yi
[ . wykre . A

B41s0) bo‘yicha ko‘rinishda, Albom (Landscape)ni tanlasangiz

B30 hujjatning eni bo‘yicha ko‘rinishda sahifalaydi.

c4

5

§g L Yugqoridagi sahifalashninig o‘lchamlarini bosmadan

Eﬁfm% chigariladigan payti bilan chalkashtirmaslik kerak.

Erakpe 2

Ervelope #14

Ervelope Monaech

Envelope Check

DL

OO SO, IO PO POV JOVOO. SOOIV OO

Tpanuya nevatHom obnacru

Agar tayyor bo‘lgan hujjatni bosmadan chiqarmoqchi bo‘lsangiz
menyuning Ko‘rish (View)ni tanlab bosmaga chiqishi kerak bo‘lgan
maydon tanlanadi (Printable Area) va ekranda shtrix chiziglar bilan
bosmaga chigadigan maydon chegaralangan bo‘ladi.

2.2. Vektor va rastr grafika

Rastr grafikasida obyektlar bit kartasidagi torda rangli nuqtalar
(piksellar) yordamida tasvirlanadi.

Rastrli tasvirlar bilan ishlash uchun rastr muharrirlaridan
foydalanamiz. Rastr tasvirlarni boshqa formatlardan rastr
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ko‘rinishiga o‘tkazish (Convert to Bitmap) yo‘li bilan amalga
oshiriladi. Rastr tasvirlarni muharrirlaganda piksel ranglarini
o‘zgartirish imkoniyati tug‘iladi, fagat ranglarni o‘zgartirganimizda
obyektning shakli o‘zgarishiga o‘z ta’sirini o‘tkazadi.

Vektor grafikasi matematik obyektlar ustida tashqi qurilmalarga
(monitor,printer) bog‘ligsiz holda amallar bajaradi.Vektor
grafikasida birinchi navbatda obyektning formasi o‘zgaradi, rangi
esa ikkinchi darajali bo‘ladi. Sababi vektor grafikasida rang bilan
shakl bir-biriga bog‘liq emas, shakl birinchi darajali, rang esa
ikkinchi darajali bo‘ladi.

2.3. Obyektlar bilan ishlash

Corel DRAW dasturi vektorli tasvirlarni yoritishda yupqa
chiziglardan tortib har xil shaklga ega kistlardan foydalaniladi.

Vektor grafikasi «qo‘l yordamida» chizishdan yiroq, shuning
uchun avval obyektning vektorli konturini chizib, keyin esa, uni
ganday qilib muharrirlashni o‘ylab ko‘rish kerak.

Shuni nazarda tutib CorelDRAW dasturi geometrik figuralarni
(to‘g‘rito‘rtburchak, ko‘pburchak, ellips, spiral va hokazo) chizish
va muharrirlash imkoniyatiga ega va yanada «erkin chizish» (pero,
kalligrafik pero, va hokazo), gradient torlar (Mesh Fill) va har xil
egri chiziglarni chizish uchun Bezie (Bezier) asboblariga ham ega.

Vektor konturlarni muharrirlashda gqanday asbob bilan
yoritilganidan qat’iy turda Forma (Shape) va maxsus muharrir
panelidan (Node Edit) (tugunlarni muharrirlaydi) foydalanadi.

Konturlar va tayanch nugqtalar

Kontur — bu dasturning obyektlarni chizishda foydalaniladigan
to‘g‘ri chiziq bo‘lib, obyektning tuzﬂmasml tashkll q1|ad| Kontur
keyinchalik To‘ldirish (Fill) va 7.
Chegaralash (Outline) sifatida
foydalanilib bosmaga ham chiqga-
rilishi mumkin. Agarda kontur-
ning ba’zi bir parametrlari yo'q | P
bo‘lsa, oddiy holda kontur Ko~ | cssts ouine)
rinmaydi, fagat maxsus ko‘rish |
imkoniyati bor va bosmaga chiqa-
rilmaydi.

xouTyp (patch)
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Forma (Shape) asbobi yordamida
ajratiladigan kontur alohida obyekt (object)
bo‘lib hisoblanadi.

Kontur goplangan segmentlardan tash-
kil topgan bo‘lib, u Bezie egri chizig‘i,
tayanch nugqtasi va tugunlar (nodes)dan
iborat bo‘ladi. CorelDRAW dasturida
konturning uch xil turi mavjud. Agarda bitta
tayanch nuqtasi o‘zgartirilsa, u bilan bog‘liq
shakl ham o‘zgaradi. Segmentning shakli
o‘zgartirilgani, boshqarish nuqtalarining
ham o‘zgarishini beradi.

Standart obyektlar asboblari

2
I8

i
5

100
i

@
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Standart geometrik obyektlar (to‘g‘ri to‘rtburchak, kvadrat,
ellips, aylana va hokazo) yordamida murakkab geometrik obyektlarni

chizishi mumkin.

To‘g'ri to‘rtburchak asbobi (Rectangle)

To'g'ri to‘rtburchak asbobi (Rectangle) to‘gri to‘rtburchak-
lar, kvadrat va uchlari aylana shaklidagi to‘g‘ri to‘rtburchaklarni

chizishda foydalaniladi.

To‘g‘ri to‘rtburchak chizish uchun asbobni ishga qo‘shib
sichqoncha tugmasini kerakli shaklga ega bo‘lguncha surilib,

sichqoncha qo‘yib yuboriladi.

Agarda markazdan to‘g‘ri to‘rt-
burchak chizmoqchi bo‘lsak, <Shift>
tugmasi bilan birgalikda ishlatiladi.
Kvadrat chizish uchun <Ctrl> tugmasi
bilan birgalikda ishlatiladi.

Obyektning parametrlarini o‘zgar-
tirish uchun obyekt ajratilib sichqon-
chaning o‘ng tomon tugmasi bosiladi va
menyu ochiladi, bu yerda Xossalar
(Properties) dan obyektning Xossalari
(Object Properties) tanlanadi.

Agarda to‘g‘ri to‘rtburchak uchlarini
aylana shakliga keltirmoqchi bo‘lsangiz,
Xossalar (Properties) dan foydalanib
(Corner roundness)dagi har bir to‘rt-
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burchak uchining gancha foyzga aylana hosil qgilishini ko‘rsatish
kerak. Har bir uchini alohida aylana qilish imkoniyati ham mavjud
bo‘lib, u Xossalar (Property Bar) yordamida amalga oshiriladi.

S N s Ellips asbobi (Ellipse)

{=e) g Ellips asbobi (Ellipse) ellips va
= Emv aylanalarni chizish uchun ishlatiladi.
gj Ellipsni ekran markazida chizish
. 3 uchun <Shift> bilan birgalikda,
3 W e aylanani chizish uchun esa <Ctrl>
1o bilan birgalikda ishlatiladi.

10, Obyektning xossalaridagi ellipsni
5 A har xil o‘zgartirishlar gilish mumkin.
1 %= M Bu yerda ellips turlarini tanlash mum-
gf 2; - kin: Ellips (Ellipse), Sektor (Pie)
%‘ yoki Yoy (Arc).

2] §> } Obyekt (Object) guruhi asboblari

Uchta asbobdan tashkil topgan bo‘-
lib, ular quyidagilardir: Ko‘pburchak
(Polygon); Spiral (Spiral); Kordinat sistemali qog‘oz (Graph Paper).

Ko‘pburchakning asbobi (Polygon)

Ko*pburchakni tomonlari berilgan geometrik obyekt deb tushunish
mumkin. Ko‘pburchak turlaridan biri yulduzcha hisoblanadi, uning
uchlari gavariq ko‘pburchak ichiga joylashgan va maydonni kesib o‘tib
tutashtirilgan tomonlardan iborat figura bo‘ladi.

Ko‘pburchaklarni yuqorida keltirilgan obyektlarga o‘xshatib
chizilgan.

Agarda <Ctrl> bilan birgalikda chizilsa, muntazam ko‘pburchak
chiziladi, ya’ni ko‘pburchakning hamma tomonlari teng bo‘ladi.

Parametrlarni o‘zgartirish uchun Obyektning Xossalaridan
(Object Properties) foydalaniladi.

Ko‘pburchaklarni chizganda (Polygon) tanlanadi va uchlar,
tomonlar soni ko‘rsatiladi. O‘ng tomonda joylashgan oynada
obyektning ganday ko‘rinishda bo‘lishi ko‘rsatiladi.

Uchlarining ganaga ko‘rinishda bo‘lish kerakligi (Sharpness)
yordamida beriladi, ya’ni obyektning tomonlari gancha ko‘p bo‘lsa,
uchlari chuqur bo‘ladi. Ko‘pburchak (Polygon) va Yulduz (Star)
turlaridan birini tanlash uchun ko‘rsatkich berilgan.
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Bu ko‘rsatkichlar asboblar paneli Xossa (Property Bar) da
berilgan.

[T 21

| Polygon Tool ~ PolygonTool

Memory Al Polygon
Plug-Ins (" Star
& Text o
T '* Polygon as Star
= Toolbox

Pick Tool

Shape Tool 3 5 =
K Tool Number of points/sides: .13 |

Eraser Tool Sharpness: - J W
Zoom, Pan Too
Freehand/Bezi
Dimension Tool
Angular Dimens
Connector Too
Rectangle Tool
Elipse Tool ~
Polygon Tool
Spiral Tool
Graph Paper Tc
Mesh Fill Tool
=l Customize >4 |
</ Jis|

| oK | Orvens | Help 71

Bu yerda shuni nazarda tutish kerakki, dasturda asboblar
panelidagi (Polygon Tool) ko‘pburchaklar parametrida ko‘p-
burchakning yana bir turi — yulduz ko‘pburchak (Polygon as
Star) ham mavjud.

= ":; - l?o B Spiral asbobi (Spiral)
2] x ‘ Spiral asbobi (Spiral) asosan ma’lum
{4 \&))) bir radiusga va o‘ramga ega geometrik
o obyektlarni chizishga mo‘ljallangan.
[* (@) Bu asbob bilan ishlash to‘g‘ri
- H to‘rtburchaklarni chizishga o‘xshaydi. Bu
., v " yerda spiral turini simmetrik (Sym-

metrical) va logarifmli (Logarithmic)
turning bittasini tanlash kerak.
(D)) Eni va uzunligi teng bo‘lgan spiral-
/) lar <Ctrl> tugmasini bosib turib chiziladi.
Spiral parametrlarini (Property Bar)
o‘zgartirsa bo‘ladi.

200
Bes BE,* 20 0RG
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Koordinat qog‘ozi (Graph Paper) |. 7 “ o S
Koordinat qog‘ozi (Graph Paper) {E=
yordamida oldindan berilgan para- |z 2
metrlar bilan katakcha quriladi. Bu | { ¢
katakchalarni grafiklar, diagram- &,
malar chizganda foydalansa bo‘ladi. & 2
Katakcha chizish yuqoridagi ilm| " o 7
asboblarga o‘xshash bo‘ladi, [ A
masalan, to‘g‘ri to‘rtburchak bilan | : ;'v
ishlaganga o‘xshaydi. Faqat bitta o | - v
fargi katakcha o‘lchamli bo‘ladi. U [*] o, ‘
Koordinat qog‘oz asbobi (Graph 14 ‘
Paper Tool) va mulogot oynasining |1 %] - : :

Parametrlari (Options) orqali
amalga oshiriladi.

Katakchalar soni eniga (Number of cells wide) nechta katakcha,
katakchalar soni (Number of cells high) esa bo‘yiga nechta katakcha
joylashtirishni ko‘rsatadi. Agarda kvadrat shakldagi katakcha kerak
bo‘lsa, u holda <Ctrl> tugmasi bilan birgalikda ishlatiladi. Para-
metrlarini esa Xossalar (Property Bar)dan o‘zgartirsa bo‘ladi.

Egri chiziglar guruhining asboblari (Curve)
Egri chiziglar guruhining (Curve) asboblar paneli: Chizish
(Freehand), Bezie (Bezier), Pero (Natural

Pen), O‘lchovli chizig (Dimension), cv'v In q:'

bog‘lovchi chiziglar (Connector Line) va
bog‘lag‘ich (Connector) dan iborat.

Chizish asbobi (Freehand)

Chizish (Freehand) asbobi
asosan xohlagan turdagi chiziglarni
chizishga mo‘ljallangan. Bu asbob
yordamida chizilganda avtomatik
ravishda tayanch nugtalari tanlangan
vektor konturi tashkil qilinadi. ¥
Kontur chizilgandan keyin
mubharrirlanadi.

Bu asbob bilan chizilganda mos
chiziq qgalinligi va rangi tanlanadi.
Xohlagan paytda chizilgan chizigni
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davom ettirib chizsa bo‘ladi, buning uchun kursorni chizigning
oxirgi nuqtasiga keltiriladi va kursorning ko‘rinishi o‘zgaradi, shu
paytda sichqoncha bilan chizigni davom ettirsa bo‘ladi. Chizish
(Freehand) asbobi bilan asosan to‘g‘ri chiziq chiziladi, buning uchun
dastlabki va oxirgi nuqtalar ko‘rsatilsa bo‘ldi.

Imitatsiya asbobi (Artistic Media)

Imitatsiya (Artistic Media)
asbobi rastr grafikasiga tegishli
asboblardan biri bo‘lib hisoblanadi.
CorelDRAW dasturi ham bu asbobga [
ega. Bu asbob shtamp ko‘rinishidagi
peroga o‘xshaydi. X

Imitatsiya asbobining quyidagi
turlari mavjud:

e Oopasen (Preset) rejimi tay- ,&
yor formadagi namunalardan qalinligi [ ﬁ -
o‘zgaradigan obyektlar chizish. Bu * s
rejimda obyektlar figurali shtrixlar | 7%& A i
bilan chiziladi. (peeossare)

e Kuctp (Brush) rejimi har
xil murakkab shakldagi formalarni va matnlarni bo‘yashda
ishlatiladi.

e Pacnbumutens o6bekToB (Object Sprayer) rejimi  har xil
grafik elementlarni trayektoriya uslublaridan foydalanib joylash-
tiradi. Bu rejim asosan murrakab romlar, girlyandlar va hokazolar
yaratishda ishlatiladi.

o Kamnurpapus (Calligraphic) rejimi pero yordamida qiya
ko‘rinishdagi obyektlarni chizishda ishlatiladi.

e Haxum (Pressure) rejimi har xil shtrixlarni yoritishda
ishlatiladi.

2\. @ w 7{)’
2| PacIBUTHT €JIb OGLGKTOB

(Ob_]r ::Fuyer) ?grx;asae%x
é ‘Q KHCTh (brush) ?

KauErpadgus
(ca]llg;:gpgc)

|peolm *.01 280 ok -

Obpaszey (Preset) rejimi

Bu O6pasen (Preset) rejimi tanlanganda quyidagi parametrlar
bilan ishlash imkoniyatini beradi:

CrnaxuBanue (Freehand Smoothing) maydonida (rasmda |
raqami bilan berilgan ) 0—100 gacha asosiy shtrixning silliglanish
darajasini ko‘rsatadi.

Tomuuna (Width) maydoni (ragam 2) dekorativ shtrixning
0,764—254 mm diapazondagi maksimal qgalinligini aniglaydi.
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Preset Stroke (®opma mrpuxa)da (ragam 3) dekorativ
shtrixlarning har xil formalari berilgan.

[Property Bar : Artistic Media Preset K|
e By 0 2|10 & | Bsam 3|0~

1 2 3

Bu asbob bilan ishlash Pucosanue (Freehand)dan hech ganday
fargi yoq.

Kucmo (Brush)rejimi

Kucts (Brush) rejimi tanlanganda Csoiictea (Property Bar)ning
asboblar satrida quyidagi parametrlar bilan ishlash imkoniyati tug‘iladi:

CraaxusBanue (Freehand Smoothing) Maydoni (rasmda |
ragami bilan berilgan) 0—100 gacha asosiy shtrixning silliglanish
darajasini ko‘rsatadi.

Tomumumnua (Width) maydoni (ragam 2) dekorativ shtrixning
0,764—254 mm diapazondagi maksimal qalinligini aniglaydi.

®opma kuctu (Brush Stroke) (ragam 3)da dekorativ shtrix-
larning har xil shakllari berilgan.

Coxpanuth (Save) tugmasi (ragam 4) kistni berilgan obyekt
shaklini xotirada saglaydi. Buning uchun obyektni ajratish kerak,
Mmurtauus (Artistic Media) ishga tushiriladi, keyin Kuctb
(Brush) rejimi tanlanadi va Coxpanuts (Save) tugmasi bosilgandan
keyin yangi kistga nom berishni so‘raydi va uni CMX formatli
faylda xotiraga yozadi.

Ynamute (Delete) — tugmasi (5 ragami) bosilganda ro‘yxatdagi
variantlardan tanlangani o‘chiriladi.

|
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Pacnviaumenv o6sexmoe (Object Sprayer) rejimi

Pacneumutens 00bekToB (Object Sprayer) rejimi tanlanganda
CsoiictBa (Property Bar) ning asboblar satrida quyidagi
parametrlar bilan ishlash imkoniyati tug‘iladi:
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Crinaxusanue (Freehand Smoothing) Maydoni (rasmda 1
ragami bilan berilgan) 0—100 gacha asosiy shtrixning silliglanish
darajasini ko‘rsatadi.

Pasmep (Size) maydoni (ragam 2) 1 dan 999% gacha
maksimal va minimal dekorativ shtrix o‘lchamini foiz nisbatida
aniqlaydi.

Ilepeuenb o6bekTOB (Spraylist) (ragam 3) har xil shakldagi
dekorativ ko‘rinishdagi burkagich turlari.

Save (ragam 4) yuqoridagi Kucte (Brush) dagiga o‘xshash
vazifani bajaradi.

Ynamute (Delete) tugmasi (ragam 5) ro‘yxatdagi keraksiz
so‘zlarni o‘chiradi.

IMopsinox pacnbiieHust (Spray Order) ro‘yxati (ragam 6)
kontur enidagi obyektlarni har xil ko‘rinishda joylashishini bildi-
radi — Cayuyaitno (Ramdomly) xohlagancha, IlTocienoBarenbHO
(Sequentially) ketma-ket, Mo HanpasaeHuio (By Direction)
yo‘nalishida berilgan.

JoGaBuTth B cnmcok 0o0bekToB (Add to Spraylist) (ragam 7)
yangi elementlarni obyektlar ro‘yxatiga qo‘shadi.

AxTuBmM3aumsi cnmcka oobekToB (Spraylist Dialog) tugmasi
(ragam 8) ckranga yangi clementlar (Create Playlist) chigariladi
va u ikkita oyna: Barcha obyektlar ro‘yxati (Spraylist) va aktiv
bo‘lgan obyektlar ro‘yxatini chigaradi (Playlist).

O6wekTel/UuTepBael (Dabs/Spacing) (ragam 9) obyektlar
nisbatini va intervalini o‘zgartiradi. MUuTepBansr (Spacing)ning
pastgi qgismida obyektlar orasidagi interval aniglanadi, yuqoridagi
O6nwekThl (Dabs)da esa — har bir interval nuqtasidagi obyektlar
soni aniglanadi.

Bpauicaue (Rotation) tugmasi (ragam 10) barcha obyeckt-
larning aylanish parametrlarini o‘zgartiradi.

Cwmemenue (Offset) tugmasi (ragam 11) obyektlarning
konturga nisbatan siljish giymati va yo‘nalishi beriladi.

BoccranoButh 3HaucHus (Reset Value) tugmasi (ragam 12)
avval faylda saglangan parametrlarni qayta tiklash uchun
ishlatiladi.

|
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Kanauepapua (Calligraphic) rejimi

Kanmurpacdus (Calligraphic) rejimi ishga tushirilganda asboblar
panelidagi CsoiictBa (Property Bar)da quyidagilar bilan ishlash
imkoniyati tug‘iladi:

Crnaxusanue (Freehand Smoothing) (rasmda 1 ragami bilan
berilgan), Tomummua (Width) (ragam 2) maydonlari yuqoridagi
Kucte (Brush) rejimiga o‘xshash xizmatni bajaradi.

Angle (Yron) (ragam 3) «mepo»ning qgiyalik burchagini
bildiradi.

Property Bar : Artistic Media Calligraphic gl
H‘y@@r@ﬁ’mo #I315,4mm :‘40,0 =

1 2 3

Haxcum (Pressure) rejimi

Haxwum (Pressure) rejimi tanlanganda CsoiictBa (Property
Bar)sida quyidagi parametrlar bilan ishlash imkoniyati tug‘iladi:

Crnaxusanue (Freehand Smoothing) (rasmda | ragami bilan
berilgan), Tommuua (Width) (ragam 2) maydonlari yugoridagi
Kucte (Brush) rejimidagiga o‘xshash xizmatni bajaradi.

Kistning galinligi tanlanganda <A\> (qalin qilish uchun) va
<\¥> (qalinligini kamaytirish uchun) tugmalaridan foydalaniladi.

besve (Bezier) asbobi e
Bezie (Bezier) asbobi yordamida | &=
maksimal aniqlikdagi xohlagan egri | ‘:
chiziglarni chizish mumkin. Bu asbob | { ¢ *— —
yordamida xohlagan shaklni chizish |1 £ /
imkoniyati bor. : ':;
1 B,
To‘g'ri chizigli segmentlarni qurish |~ “?
To‘g‘ri chizigni chizish uchun | { &=
Bezie (Bezier) asbobidan foydalaniladi. |g] &,
Buning uchun Bezie asbobi tanlanib, 1 &,
kursorni boshlang‘ich nugtaga olib | { &
borib, sichgonchani chap tomon |1 e

tugmasi bilan chertiladi. Chertilgan
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joyda gora rangli nugta paydo bo‘ladi, bu segmentning birinchi
tayanch nuqtasi, bu nuqgta boshga nuqta tanlanguncha joriy bo‘lib
turadi. Kursorni keyingi nugta joylashadigan joyga siljitib, sichqoncha
bilan chertiladi, natijada ikkita nuqta birlashtirilib to‘g‘ri chiziq paydo
qgilinadi.

Tayanch nugtalar turlari

CorelDRAW dasturida segmentning bir nechta nuqtalarini
birlashtirishning uchta turi bor: _ - -

1. Tkkita egri chizigni «egrilikga» | =tk
birlashtiruvchi tayanch nuqta —
burchak tayanch nuqta (cusp |%
node) deyiladi. Bu turdagi tayanch | | f\
nuqtani boshqgarishda to‘g‘ri
chiziglarning «richaglarining»

5
Yy

uzunliklari va yo‘nalishlari bir-biriga | 1 A\

bog‘liq bo‘Imaydi. 2 \}
2. Ikkita egri chizigni birlash- :

tiruvchi tayanch nuqta silliq | | v

L2)

tayanch nugta (smooth node)
deyiladi. Bu turdagi tayanch
nuqta boshgarish to‘g‘ri chiziglarining fagat uzunliklari bilan farq
giladi, yo‘nalishi esa umumiy bo‘lgan urinma bo‘ladi. Birinchi
boshqarish to‘g‘ri chizig‘ining siljitilishi, ikkinchi to‘g‘ri chizigning
siljishiga olib keladi.

3. Ikkita egri chizigni bir xil egrilik bilan birlashtirilgan bo‘lsa,
simmetrik tayanch nuqta (symmetrical node) deyiladi. Bu turdagi
tayanch nuqtaning boshqarish to‘g‘ri chizig‘i va yo‘nalishi bir-
biriga bog‘lig bo‘ladi.

0
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Egri chizigli segmentlar

Bezie asbobi yordamida egri chiziqgli segmentlarni ham yaratsa
bo‘ladi. Buning uchun asbobni ishga qo‘shib, kursorni boshlang‘ich
nuqtaga olib kelinadi va sichqonchani chap tomon tugmasi chertilib
yon tomonga suriladi. Paydo bo‘lgan tayanch nuqtadan boshqarish
to‘g‘ri chizig‘i olinadi. Boshqaruvchi to‘g‘ri chiziq uzunligi va qiyalik
burchagidan segment egriligi aniglanadi.

Qavariq segmentni olish uchun birinchi tayanch nugqtani
gavariq tomonga, ikkinchisini esa, teskari tomonga surish kerak.

Agarda ikkinchi nugtani ham shu tomonga sursa S-ko‘rinishidagi
egri chiziq paydo bo‘ladi.

Murakkab konturni hosil gilishda kamroq tayanch nugqtalarni
hosil gilgan magsadga muvofiq bo‘ladi.

¢ Bitta yo‘nalishga ega egri chiziq bitta tayanch nuqtani talab
giladi.

¢ Oz yo‘nalishini sekin o‘zgartiradigan egri chiziq ikkita tayanch
nugta talab qiladi (boshida va oxirida).

¢ Yo‘nalishini burchak ostida o‘zgartiruvchi egri chiziq uchun
har bir egrilikda tayanch nuqta kerak bo‘ladi.

Pasmepnas aunus (Dimension) asboblari

£

R A, EBOOCHA%Y 7% 0,0

: £
[T » & & B Decimal ~ | om il || Tun | Prefic Sulfic Dyname | 85
123456

Chizmalar va sxemalar bilan ishlaganda shakllarning to‘g‘ri
chizilishi bilan bir qatorda ularning razmerlarining to‘g‘ri bo‘lishi
katta ahamiyatga ega. Vektor grafikasi dasturlari sxemalar chizish
uchun qo‘l keladi. Dasturda bu amallarni bajarish uchun oltita
asbob mavjud:

1. ABToMaTuyeckast pazmepHast auHust (Auto Dimension) asbobi
sichqonchani qaysi yo‘nalishda siljishiga garab o‘lchamli to‘g‘ri chiziq
chizadi. (Vertikal, gorizontal o‘lchamli to‘g‘ri chiziglarning bir-biriga
o‘tish <Tab> tugmasi yordamida amalga oshiriladi.)

2. BeprukanbHasi pazmepnasi aunus (Vertical Dimension)
asbobi faqat vertikal o‘lchamli to‘g‘ri chiziq paydo qiladi.
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3. lNopusonTtanbHasi pasmepHast aMHusi (Horizontal Dimension)
asbobi faqgat gorizontal o‘lchamli to‘g‘ri chiziq paydo giladi.

4. Haknonnasi pasmepHas JuHust (Slanted Dimension) asbobi
fagat giya bo‘lgan o‘lchamli to‘g‘ri chiziq
paydo qilib obyekt o‘zgarishi bilan v [« % . % . % ..
ham o‘zgaradi. &

5. BeiHocka (Callout) asbobi
obyektlarga biriktirilgan yorliglarni
yaratadi.

6. YrinoBasi pazMmepHasi JUHUS
(Angular Dimension) asbobi bur-
chakning giymatini ko‘rsatadigan ‘
o‘lchagich yoy yaratadi. . Memwox] e

—
Mleasox "

12,05 cm

700
:

Xohlagan turdagi o‘lchamli to‘g‘ri chiziq yaratish uchta
bosqichdan tashkil topadi:

e Birinchi chertish boshlang‘ich nuqgtani aniglaydi;

e [kkinchi chertish oxirgi nuqtani aniglaydi;

e Uchinchi chertish o‘lcham yoziladigan yerdan to‘g‘ri
chiziggacha masofani bildiradi.

Obyektga o‘lchamli yoki ulanuvchi to‘g‘ri chizigni bog‘lash
uchun joriy bo‘lgan nuqtalarning biriga kursorni olib kelib,
sichgoncha bilan chertiladi.

Burchakni o‘lchovchi chizigni paydo etish to‘rtta bosqichdan iborat:

e Birinchi chertilish burchakning
dastlabki nugtasini aniqglaydi; P .

e Ikkinchi va uchinchi cherti- |
lishlar nurda burchak nugtalarini ] i
belgilaydi; i ¢ :

e To‘rtinchi chertish esa nurdagi |smeie 90 degrees
nugtalardan o‘lcham yozilgan yozuv- { £ /
gacha bo‘lgan masofani belgilaydi. e
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4-it lleasox

Buvinocka (Callout) asbobi
Boinocka (Callout) asbobi
obyektning bironta nuqtasi bilan matnli yoki tushuntirma so‘z
bilan bog‘laydi. Shu bilan birga <BsiHocku>lar obyektga bog‘langan
bo‘ladi.
Bu amal quyidagicha bajariladi: dastlabki chertish obyektning
tayanch nugqtasiga bog‘lashni bildiradi, ikkinchi chertish egilish
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nugtasini ko‘rsatadi va nuhoyat uchinchi chertish matn Kkiritish
uchun ishlatiladi.

Coeduriumenvras aunusa (Connector Line) va Humepaxmuenotil
coedunumens (Interactive Connector) asboblari

CoenunurenbHas uHust (Connector Line)ning asosan xizmati
ikkita obyektni bir-biri bilan bog‘lash uchun ishlatiladi. Bu esa,
birlashtirilgan obyektlarni surish va transformatsiya qilish
imkoniyatini beradi. Agarda obyektlar mavjud bo‘Imasa oddiy to‘g‘ri
chizigda aylanib qoladi. Agarda faqat bitta obyekt bo‘lsa, u holda
ikkinchi tomoni sahifaga bog‘langan bo‘ladi.

Biriktiruvchi chizigni hosil gilish uchun obyektlarning mos tayanch
nugtalariga sichqoncha yordamida chertiladi. Chizigning parametrlari
(rangi, qalinligi) o‘zgartirilsa ikkita obyekt ham o‘zgaradi.

UnrepaktusHbiii coeauautess (Interactive Connector) asbobi
har xil blok sxemalar yaratishga mo‘ljallangan. CoeaquHUTEIbHAS
auHusi (Connector Line) asbobidan farqi fagat vertikal va
gorizontal chiziglar yaratadi. Shu bilan birga obyektlar siljitilganda
tayanch nuqtalarga bog‘lanish saglanadi, agar kerak bo‘lsa uni
olib tashlasa ham bo‘ladi.

WurepaktuBHbIi coenuuuTenb (Interactive Connector) asbobi
yordamida ikkita obyektni bog‘lash uchun dastlab kursor birinchi
obyektning tayanch nugtasiga olib kelinib, sichgoncha bilan chertiladi
va ikkinchi obyektning tayanch nugtasigacha chiziq tortiladi.

Berilgan obyektni transformatsiya gilganda biriktiruvchi chiziq
avtomat ravishda o‘zgaradi va bog‘lanishni uzmaydi. Agar biriktirilgan
obyektlardagi tayanch nuqgta o‘chirilsa, eng yaqin nuqta tayanch
nugta qilib olinadi.
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Cmpeaxa (Pick) asbobi

Obycktklar ustida ganaga amal baja- [ W w
rilmasin obyekt boshqalaridan ajratilgan
bo‘lishi kerak.

Bu amalni bajarish uchun maxsus
ajratish asbobi Crpenka (Pick) ishlatiladi.

Obyekt ajratilganligini uning yonidagi
markerlardan va obyekt markazidagi krestdan
bilsa bo‘ladi. Agarda bir nechta obyektlar
ajratilgan bo‘lsa, markerlar katta to‘rtburchak
shaklida bo‘ladi. s

1550
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Obyektlarni ajratish usullari

Crpenka (Pick) asbobi yordamida
obyektlar bir nechta usullar bilan ajratiladi: %

e Alohida obyektni sichqonchani
chertish bilan ajratsa bo‘ladi.

e lltpuxoBoit pamka (marquee) yordamida obyektlarni
ajratganda belgilangan maydondagi obyektlar ajratiladi va ular
shtrixlangan ramka ko‘rinishida bo‘ladi.

¢ Obyektlarni ajratishda klaviaturadan ham foydalanilsa bo‘ladi.
<Tab> tugmasini bosish orqali obyektlarni ketma-ket, <Shift>
+ <Tab> — tugmalari bilan birgalikda ishlatilsa teskari holatda
ajratiladi.

e Hamma obyektlarni ajratish uchun O6BekTBl (Objects)
buyrug‘i va menyuning Penaktuposars/Briaenuts Bce (Edit/
Select All) tanlanadi. Bu amalni Crpenka (Pick) asbobining
tugmasini ikki marta bosish bilan amalga oshirsa bo‘ladi. Ajratishni
bekor gilish uchun ish joyidan boshqa yeriga sichqoncha bilan

chertiladi yoki <Esc> tugmasi bosiladi.
P

SesEeRpoonsar T

i

Cmpeaka (Pick)asbobining boshqa
Sfunksiyalari

Crpenka (Pick) asbobini ishlatganda
obyektlarni ajratilganlik markeri fagat
ajratilganlik belgisini bildirib qolmay,
boshga magsadlarda ham ishlatiladi.

Marker yordamida obyektlarni massh-
tablash mumkin. <Shift> tugmasi bilan
ishlatilsa markazdan masshtablanadi.
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<Ctrl> bilan birgalikda ishlatilsa bir [+ ___ x I
butunga kattalashadi. Yon tomondagi
markerlar esa noproporsional masshtab-
laydi.

Ikkinchi marta obyektlarni ajratganda
markerlar yo‘nalish shaklini oladi.

Burchakdagi yo‘nalishlar yordamida |
obyektni o‘q atrofida aylantiradi.

Yon tomondagi yo‘nalishlar esa
obyektni gorizontal yoki vertikal tomonga
giyshaytirishni bildiradi. i

Shuning bilan birga Crpenka (Pick)
asbobi obyektlarni yoki obyektlar
yig‘indisini ko‘chirishi mumkin, shu-
ning uchun obyektni olib, kerakli to-
monga surish mumkin.

250
i

Dopma (Shape) asbobi

®opma (Shape) asbobi vektor &
konturlarini muharrirlashga mo‘ljal-
langan. Bu asbob obycktning shaklini
o‘zgartiradi, ya’ni tayanch nuqtalarni
ko‘chiradi, yangi tayanch nuqtalar
go‘shadi va hokazo amallar bajaradi.

®opma (Shape) asbobi yordamida
ajratilgan obyektning hamma tayanch
nugtalari ko‘rsatiladi, kursor olib borilgan
nuqtalari esa joriy bo‘ladi.

®

160
PesBEEL o 0nsas T

i

Dopma (Shape) asbobi yordamida standart va xohlagan
obyektlar bilan ishlash

IIpssmoyronsHuk (Rectangle) asbobi yordamida yaratilgan
obyektlarning tayanch nugtalarini o‘zgartirish natijasida aylana
shaklini olishi mumkin.

Snnunc (Ellipse) asbobi bilan yasalgan obyektlar esa sektor
yoki duga shakliga keltirilishi mumkin.

MmuoroyroabHuK (Polygon) asboblari bilan yasalgan obyektlar
esa simmetrik tarzda obyektning boshga turiga o‘zgaradi.

Matnli obyektlar bilan ishlashda esa harflar orasidagi va so‘zlar
orasidagi intervallarni o‘zgartirish imkoniyati tug‘iladi.
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Peoaxmop y3a06 (Node Edit) paneli

Hamma tayanch nugqtalar, segmentlar bilan ishlaydigan amallar
Penaxrop y3108 (Node Edit) panelida joylashgan. Bu panel menyuning
Docker (Window/Dockers) tipidagi Oxno/Ilanemudan PemakTop
y3i0B (Node Edit) ishga tushiriladi yoki <Ctrl> + <F10>
tugmalari yordamida ishga tushiradi.

®opma (Shape) asbobini ishga tushirganda PenakTop Y3108
(Node Edit)ning ma’lumot berish satrida (CsoiictBa (Property
Bar)) bu panelning barcha buyruglari namoyon bo‘ladi.

X
ol AT |IARN MO BC 20 =

12 3 4 56 7 8 9 10111213 14151617 18

Tayanch nugtalarni qgolshish va olib tashlash

Egri chizig ko‘rinishidagi obyektlarga xohlagancha tayanch
nuqtalarini qo‘shsa bo‘ladi. Buning uchun segmentning nugta
qo‘yish joyiga sichqoncha bilan chertiladi va paydo bo‘lgan nuqta
gora doyra shaklli ko‘rinishdagi potensial nugtaga ega bo‘lamiz. Bu
potensial haqiqiy nuqtaga aylanishi uchun yana panelning
xossasidagi «+» tugmasi bosiladi (rasmda 1 ragami bilan berilgan).

Keraksiz tayanch nuqtani o‘chirish uchun avval o‘chiriladigan
nuqtalar ajratiladi va «-» belgisi bosiladi (2 ragam).

To‘g'ri chzigli segmentlarni egri chizigli segmentlarga o‘tkazish

Har ganday segment ikki xilda bo‘lishi mumkin, to‘g‘ri yoki
egri chizigli. ®opma (Shape) asbobi yordamida tayanch nugta
ajratilganda holat satrida segment turi —To‘g‘ri (ITpsimoit) (Line)
yoki Egri (Kpusoit) (Curve) ko‘rsatiladi.

Segmentning bir turdan ikkinchi turga o‘tishi uchun segment
tanlanadi. CsoiictBa (Property Bar)dagi ikkita holatdan biri
tanlanadi: To‘g‘riga o‘tish (To Line) (5 ragam ) yoki Egriga (To
Curve) o‘tish (6 ragam).

Egri chizigli segmentdan to‘g‘ri chizigli ko‘rinishga o‘tish tez
amalga oshiriladi, teskarisi birmuncha vaqtni talab giladi — segment
egriligi qo‘l yordamida bajariladi.

Konturni birlashtirish va uzish
Ochiq konturni yopiq konturga aylantirish uchun boshidagi va
oxiridagi nuqtalar biriktiriladi, bu amal ikkita uslub bilan bajariladi:
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I. Ikkita nuqtani birlashtirish uchun avval nugtalar ajratiladi
va CaorictBa (Property Bar)ning asboblar satridagi CoeauHuTth
nBa y3na (Join Two Nodes) (3 ragamli) tanlaniladi. Agarda ikkita
nuqgta ustma-ust joylashgan bo‘lsa, ikkita nuqgta bitta nuqtaga
aylanadi. Agarda gandaydir masofada joylashgan bo‘lsa, o‘sha
masofa markazidan birlashtiriladi.

2. Chetdagi nuqtalarni birlashtirish to‘g‘ri chizigli segment bilan
amalga oshiriladi. Bunig uchun CsoiictBa (Property Bar) asboblar
satridagi ABTomMaTu4eckKoe 3aMblKaHue KOHTypa (Auto-close) (13
ragamli) tugmasi bosiladi.

3. Agarda konturni uzmoqchi bo‘lsangiz, avval o‘sha nugqtalar
ajratiladi. CpoiictBa (Property Bar) asboblar satridagi Pazopsarb
kpusyto (Break Curve) ( 4 ragamli) tugmasi bosiladi va natijada
bitta nuqta o‘rnida ikkita nugta paydo bo‘ladi.

Konturni bir nechta konturlarga ham ajratsa bo‘ladi, buning
uchun obyektning kamida bitta tayanch nuqtasi tanlanib W3Bicub
nonkoHTyp (Extract Subpath) tugmasi bosiladi.

Tayanch nugqtalarni tekislash

Shriftlar yoki maxsus belgilar bilan ishlaganda nugqtalarni

gorizontal yoki vertikal joylashtirishga to‘g‘ri keladi.
Cpoiictsa (Property Bar)

B 2
satridagi BolpaBHUBaHUE y3/10p sl 2
(Align Nodes) tugmasi (16 ragam) v Align Horizontal

mulogot oynasini ekranga chaqiradi. v Align Vertical

Bu oynada xohlagan sondagi
tayanch nugqtalarni gorizontal va vertikal
holatda joylashtirishlar mavjud.

Boshgarish nugtalari bilan bir-
galikda tayanch nugtalarni tekislash
(¢pmaxok BripaBHMBaHUC ymnpaB-
jsioux Touek (Align Control Points)) amali bilan bajariladi.

v Align Control Points

Cancel ’

Segmentlarni masshtablash va aylantirish

CorelDRAW dasturida obyektlarni transformatsiyalash bilan
cheklanib qgolmay, ba’zi bir segment gismlari bilan ishlash
imkoniyati bor. Bu amal CgoiictBa (Property Bar) asboblar
satridagi ikkita tugma bilan bajariladi.

¢ PacTspkeHue u MmaciutabupoBaHue y3i10B (Stretch And Scale
Nodes) (14 ragam) tugmasi bosilganda ajratilgan segment atrofida
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markerlar paydo bo‘ladi. Masshtablash amalida Crpenka (Pick)
asbobidagi amallar bajariladi.

¢ Bpauenue u HakioH y310B (Rotate And Skew Nodes) (15
ragam) tugmasi bosilganda, ajratilgan segment atrofida markerlar
paydo bo‘ladi. Atrofidagi aylanish amalida Crtpenka (Pick)
asbobidagi amallar bajariladi.

o DnactuuHbli pexum (Elastic Mode) (17 ragam) ajratilgan
obyektlarga alohida transformatsiya beradi.
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Hoxc (Knife) va Jlacmux (Eraser) asboblari

®opma (Shape) asbobi oynada — Hox (Knife) va Jlactuk
(Eraser) asboblari joylashgan bo‘lib, berilgan vektorli obyektni
bir nechta bo‘laklarga bo‘ladi.

Hox (Knife) asbobi obyektni bir nechta konturlarga yoki bir
nechta obyektlarga bo‘ladi. Konturni kesish uchun dastlab birinchi
tayanch nugta tanlanadi va pichoq ko‘rinishidagi kursor vertikal
ko‘rinishga kelgan holda chertilishi kerak. Ikkinchi nuqtaga
«pe3uHoBasi tuHuUs» tortiladi. Ikkinchi marta chertilishi esa kesishni
bajaradi. Bu amalni rasm chiqgarish orqgali bajarsa bo‘ladi, buning
uchun birinchi nugtaga kursorni qo‘yib sichgoncha tugmasi bosilib
turib xohlagan chiziq chiziladi. Tugma ikkita kontur birlashganda
go‘yib yuboriladi.
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(Property Bar) ning asboblar panclida ikkita tugmasi
mavjud:

o CoxpamHTh Kak ogHH 00BeKT (Leave as one object) bitta
obyekt qilib saqglash.

e ABTOMATHMYCCKOE 3aMbIKaHMe KoHTypa (Auto-Close On
Cut) Hox (Knife) asbobi bilan ishlashni tugatgandan keyin
avtomatik ravishda yopiq konturni chizadi.

Jlactak (Eraser) asbobi vektor obycktining kerakmas joy-
larini o‘chiradi. Agar bu asbob bilan o‘chirilsa, ikkita bir-biriga
bog‘lig bo‘lmagan obycktlar paydo bo‘ladi.

O‘chirish kengligini 0,025 mm dan 2540 MM gacha ofzgartirsa
bo‘ladi. Bu amal CsoiictBa (Property Bar) asboblar satridagi
Iwuprna nactuka (Eraser Thickness) da bajariladi.

Ceobodnoe mparnchopmuposanue (Free Transform) asbobi

Bu asbob ishga tushirilganda Cpoiictsa (Property Bar)da to‘rtta
tugma bilan ishlash imkoniyati tug‘iladi: CBobGomHOe BpaIicHmHe
(Free Rotation) erkin holda aylanish (1 ragami), CBoGomHOe
orpaxcHue (Free Angle Reflection) (2 ragam) erkin holda
akslanish, Csobomaoe macintabuposanue (Free Scale) (3 ragam)
erkin holda masshtablashtirish va Codonubrit Hakimon (Free Skew)
erkin holda qiya qilish (4 ragam).

CpobomHoe BpamernHe (Free Rotation) asbobida obyektni o‘zi
atrofida aylantirish uchun avval sichqoncha yordamida tayanch
nugta tanlanadi va aylanish richagi paydo bo‘ladi, yo‘nalish aylanish
burchagidan aniglanadi. Bu yerda ko‘rsatilgan kursor esa burish
burchagi hisoblanadi.

Agar burchak markazdan gancha olis masofada joylashgan bo‘lsa,
anigligi ham yaxshi bo‘ladi. Burchakning giymati holat satrida
ko‘rsatilib turadi. CBobomHoe otpaxeHue (Free Angle Reflection)
asbobining ishlash prinsipida yuqoridagiga o‘xshagan, ya’ni
shtrixlangan chiziq axslanish chizig‘i hisoblanadi.

Cpobomnoe macmradbuposanme (Free Scale) asbobi yuqori-
dagi ikkita asboblarga o‘xshash ishlatiladi, fagat shtrixlangan richagi
bo‘lmaydi.

Cpobomunrit HakitoH (Free Skew) asbobi yuqoridagi asboblarga
o‘xshash ishlatiladi, fagat holat satridagi o‘qlarga nisbatan siljish
ko‘rsatkichi, akslanish burchagi va masofasi beriladi.
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2.4.Matnlar bilan ishlash

CorcIDRAW dasturining eng yetishgan tomonlaridan biri
matnlar bilan ishlash bo‘ladi. Dasturda matnni har xil garniturada,
ranglarda, keglda va shriftlarda berish imkoniyati bor. Shriftlarni
sirtqi ko‘rinishlarini bezashning cheksiz turlari bor.

Matn ishchi oynadan PepaktupoBanue tekcra (Edit Text)

yordamida kiritiladi.

CorelDRAW dasturida
matn ko‘rinishi ikki turda
bo‘ladi: sarlavha (artistic) va
abzas (paragraph). Matn turi
Texer (Text) asbobi yorda-
mida kiritiladi.

Sarlavha matni (Artistic
Text)

Texer (Text) asbobi yor-
damida xohlagan joyga xohla-
gan matnni kiritsa bo‘ladi.

Sarlavha matnini Kkiritish
uchun Tekcr (Text) asbobi
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ishga tushuriladi va kursorni matn kiritiladigan joyga olib borilib,
sichgoncha bilan bir marta chertiladi, natijada ekranda matn kiritish
kursori paydo bo‘ladi.

Satrni yangi qatordan boshlash uchun <Enter>tugmasi yorda-
mida kursor ko‘chiriladi.

Abzas (blokli) matn (Paragraph Text)

Asosiy matn (main text) katta hajmga ega bo‘lib kolonka ichiga
olib yoziladi va uni blokli matnlar deb ataydi. Ikkinchi fargi uning
kolonka yoni bo‘yicha avtomatik ravishda qo‘yiladi, agarda matnlar
o‘chirilsa yoki qo‘shilsa avtomatik ravishda siljiydi. Bu turdagi
matnning asosiy elementlaridan biri abzas hisoblanadi va abzasli
matnlar deb ham aytiladi. Blokli matnlarni yaratish uchun Tekct
(Text) dan quyidagicha foydalaniladi:

e Asbobni ishga tushirib,
matn Kiritiladigan to‘g‘ri to‘rt- s —w W o w w w =

burchak yoki ellips ko‘rinishlar | =
tanlanadi. Matnli to‘g‘ri to‘rt- & ; .

»

Mpumep abs3auuHoro !
TeKcTa: !

burchak hech ganaqa para-
metrlarga ega bo‘lmaydi va
bosmadan chigarilganda fagat
matnning o‘zi chiqariladi.

e Matnli to‘g‘ri to‘rtburchak

20
i

1
i

260

Ecnu TekeT
"npeBblwaet pasmep

B0 UAD

e 5| 3HaK “nepenonHenua” |
yasalgqugn ].<e){m 1shga tayyor % | B BUAE TPEYONLHOM |
ckanligini bildiruvchi yonib- # | crpenku i
o‘chib turuvchi kursor chap il iy

s &l g
tomonda paydo bo‘ladi. M

Blokli matnlarni kiritish
paytida dastur o‘zi avtomatik
ravishda kelasi satrga o‘tkaziladi, foydalanuvchi fagat abzas oxirida
<Enter> tugmasini bosishi kifoiya.

Agarda belgilangan to‘g‘ri to‘rtburchakda matn ko‘rsatilganda
ko‘payib ketsa, to‘g‘ri to‘rtburchak tagida maxsus belgi — qizil
rangli uchburchak shaklidagi yo‘nalish belgisi ko‘rsatiladi.

Matn to‘rtburchagi o‘lchamlarini o‘zgartirish uchun Crpenka
(Pick) asbobidan foydalaniladi.

Dastur tomonidan matnning hajmiga va parametrlariga garab
balandligini tanlaydi.

Bu rejimga otish uchun A63aunbiii Teker (Paragraph Text)
bo‘limidagi IlTapamerpsr (Options) oynasidan matnning hajmiga
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garab to‘g‘ri to‘rtburchakni katta yoki kichkina gilish (Expand
And Shrink Paragraph Text Frames To Fit Text) ga belgi qo‘yish
orqali amalga oshiriladi.

Sarlavha (Artistic Text) matnini abzas matniga (Paragraph
Text) o‘tkazish

Sarlavha ko‘rinishida yozilgan matnni abzas ko‘rinishiga yoki
teskari abzas ko‘rinishida yozilgan matnni sarlavha ko‘rinishida
yozishga to‘g‘ri kelib goladi. Bu hollarda dastur tomonidan bir
turdan ikkinchi turga o‘tkazish imkoniyatlari bor.

Sarlavha matnini ajratgan holda Tekct (Text) menyusidagi
abzasni matnga o‘girish (Convert to Paragraph Text), abzas matni
ajratilganda esa sarlavha matniga o‘girish (Convert to Artistic Text)
so‘zlaridan foydalaniladi.

E|
% 361,185 m*¥ 288783 mm [ 1000 % | ~ o 7

% 123363m 3 236063mm | 1000 %81 B == A
Hp Arial CYR v|605% v | B 7 U|F o = AO

KoHnBepTipoBarb TekcT *

Bir turdan ikkinchi turga o‘tkazishni tezlatish uchun CsoiicTsa
(Property Bar) da joylashgan Konsepruposarh Tekct (Convert
Text) tugmasi bosiladi.

Matnni formatlash (Format Text)

CorelDRAW dasturi shriftning parametrlarini boshqarish
imkoniyatiga ega. Matnni kiritmasdan avval parametrlarini belgilab
olib, kiritilgandan keyin matnni formatlasa ham bo‘ladi.

Matnni formatlash menyuning Tekct (Text) va dopma-
tupoBaHue TekcTa (Format Text) buyrug‘i bilan amalga oshiriladi.
Mulogot oynasida abzasning matnlari uchun oltita parametrlar
berilgan bo‘ladi: lpudr (Font), Beikmouka (Align), UHTepBan
(Space), TaGynasinusi (Tab), Pamxu u xononku (Frames and
Columns); Dd ekt (Effects) yoki sarlavha matni uchun uchta:
pudt (Font), Beikirouka (Align), MuTepsan (Space) beriladi.

Hlpugpm (Font) bo‘limi
Mpudr (Font) bo‘limi bu matndagi shriftning garniturasini,
keglini va boshga parametrlarini tanlashni bildiradi.
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Shrift garniturasi deganda nomi 25

Fert | fign | Space| Tats | Piames ard Cokmmne | Elbects |

va tasviriga ega bo‘lgan belgilar — Fem e

majmuasi tushuniladi, masalan, sex 500 ] m obares v -

Times, Helvetica, exop, Jla- ™" S

3ypckoro garnituralari va hokazo. 2 e
[Ipudpr(Font) ro‘yxatida

operatsion sistemaga o‘rnatilgan FONT

shriftning bitta garniturasi tanla- [ ] oo S

nadi. Hauepranue (Style) — esa

quyidagi to‘rttasidan bittasi tanlanadi: HopMaabHOe mnpsimoe
(Normal), HopmanbHoe kypcuBHoe (Normal-Italic). [TomyxupHoe
npssmoe (Bold) u IMonyxupHoe kypcusHoe (Bold-Italic).

Size (Kernp) ro‘yxatida esa 0,001 dan 3 000 punktgacha bo‘lgan
kegl tanlanadi.

O‘Ichov birligini Eauauua maydonidan o‘zgartiriladi. IToa-
yepkuBaHue (Underline), [TepeuepkuBanue (Strikethru) va
Hanuepkusanue (Overscore) matnini muharrirlash paytida
foydalaniladigan chiziglarni bildiradi va u quyidagilarni oz ichiga
oladi: be3 nuuum (None), OgunouHasi ToHKas (Single Thin),
OnunouHast Toncras (Single Thick). [IBoitHass ToHkas (Double
Thin), JBoiinasa toncrass (Double Thick).

Penaktuponats (Edit...) tugmasi esa chiziglarni muharrirlashni
bildiradi. Tomuuna (Thickness) va CmelieHue OTHOCUTEIBHO
6aszoBoit uHum (Baseline Shift) maydonlari chiziq galinligi va
joylashishini bildiradigan son giymatlaridan iborat.

Qo‘shimcha Boixarouxa (Align)
Beixmouka (Align) fagat abzasning matniga tegishli. Bu yerda
matnning ganaga tartibda

kiritilish parametrlari be- (I EE—————— A

rilgan. F—T;..::m | Space| Tabs | Frames and Comes | Effects | —
Tekislanishlar (Align) - Hesmse e P

chap tomondan, o‘ng to- e e e

mondan, markazdan va kil

berilgan format bo‘yicha Chaccte it e

turlari mavjud. Bomomouka || Besse P Sxares | etk [0 Sl

(Alignment) maydonida ™ © 7 e 4 S

yangi tipni paydo qilsa ham il e |

bo‘ladi. G T ]
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B Npaso

Format bo‘yicha va to‘liq turdagi chegaraviy intervallarni
aniglash kerak. So‘zlar orasida maksimal bo‘sh joy qoldirish (Max.
word spacing), So‘zlar orasida minimal bo‘sh joy qoldirish (Min.
word spacing ), Harflar orasida maksimal bo‘sh joy gqoldirish
(Max. char. spacing) parametrlari dastur uchun matnni kiritganda
avtomatik verstka gilinadi.

Abzas tushunchasi matnning chetidan joy qoldirishni bildiradi.
Bo‘sh joy qoldirish deganda matnning o‘ng, chap tomonidan va
s0‘z boshidagi bo‘sh joyni goldirish tushuniladi.

Orctynsl (Indents) maydonida shu parametrlarni o‘zgartirish
imkoniyati bo‘ladi: Kpachast ctpoka (First line) so‘z boshi, Cnena
(Left) chapdan, CnpaBa (Right) o‘ngdan.

Bir yoki bir nechta belgilarni ajratganda CMellieHue cumBojia
(Character shift) da maydon bilan ishlash imkoni tug‘iladi. Bu
yerda (nmone Horizontal) gorizontal siljish, vertikal siljish (rmone
Vertical), (none Rotation) berilgan burchakga burilish amallari
bajariladi.

Qatordagi barcha belgilar (baseline) chizig‘iga garab to‘g‘ri-
lanadi va uning parametrlari, har bir belgi uchun shriftlar faylida
saglanadi. Bu esa, birinchidan matnning satrlarini to‘g‘ri kiritishni
ta’minlaydi, ikkinchidan bazaviy chizigdan vertikal yo‘nalishda
ba’zi bir masofaga siljitishni ta’minlaydi.

Vertikal siljishda shriftlarni kichiklashtirganda har xil indekslar
(pastki, yugoridagi) avtomat ravishda formatlanadi, tasviriy san’atda
ham buni ishlatsa bo‘ladi.

Humepeaa (Space) bo‘limi
UnurepBansl (Space) da har xil intervallarni qo‘yish yana
avtomat ravishda keyingi satrga o‘tishni ta’minlaydi.
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CuMBOJIBI (Character)
maydonida so‘zlar orasidagi maso-
falar beriladi, ya'ni (Word) —
foiz nisbatida shriftning orasidagi
masofani beradi, UHTepanHbSIX
(Line) maydonida — foiz nisbatida
shriftning kegili va shrift balandligi
beriladi.

Nutepiuubsixem (leading)
da matn terilganda qo‘shni ga-
torlar orasidagi masofani bil-
diradi. Bu matnlarni kiritish katta
ahamiyatga ega.

Ao63an (Paragraph) may-
doni abzasning atrofidagi ma-
sofalarni bildiradi, /o a63ama

Fot | Ahgn  Space | Tabs | Fuamas sod Cokm | Effects |
~Chracter

Faaysh =
Belowe paragraph 1000 < %ot Char hoight

Al poragiaph. 1000 =4 %ok Chr hiight

Hyphansion
I Use sutomatic byphenation

21

R

Hyphenation Settings 1

| Break capitalized Min. word length:

Hot zone: ﬁZJmm-j Min. characters before: |3 ==

Min. characters after:

o]

Cancel

P =

Help

(Before paragraph) abzasdan oldin va abzasdan keyin (After
paragraph), agarda bu ikkitasi qo‘shni abzaslarga tegishli bo‘lsa ular

go‘shiladi.

Asromatuueckuii nepeHoc (Use automatic hyphenation)ga
bayrogcha qo‘yilsa, Ycranosku neperoca (Hyphenation Settings...)
tugmasi bilan ishlash imkoniyati tug‘iladi.

l'opsivuasi 3oHa (Hot zone) maydoni matnni ko‘chirish
maydonini bildiradi, o‘lchov birligi yonidagi maydonlardan

kiritiladi.

Tabyaauusa (Tab)

bo‘limi

Taoynsauus (Tab)
bo‘limi asosan jadvallar
bilan ishlaganda kerak
bo‘ladi, sababi uning
yordamida ustunlarni
tekislash amali bajariladi.

Mulogot oynasining
chap tomonidagi hujjat-
ga o‘rnatilgan tabulyator-
ning ro‘yxati keltirilgan.

2%
Fort | Afign | Space Tabe |F:wmmdl:olum|€lfedsl

|__Tebs | Mgrmenl Lescered 4|  Addtab |

12700 men | LLett =0 |

| 25400 men L et O _ Deletetab | DeloteAl

| e

pmrrm LLeft m} o
om0 || elebeey] (127 =

83500 mm  Lieft O

7o 200w LUk o ~Tialing Leadet —
133900mm  LLeht (] [ —

101 €00 LLet O s =

[ 114300 Lo o Sparing: [ =

| 127,000 men LLett o =~ [G D| ‘
lchcm ek n oo e

oK I Orvena | Npsasessas Help |
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Tabynstopsl (Tabs) ustunida gorizontal chizig bo‘yicha
koordinatalari ko‘rsatilgan. Bu koordinatalarni osongina o‘zgartirsa
bo‘ladi, kerakli katakchaga chertib koordinatalari o‘zgartiriladi.
BreipaBHuBanue (Alignment) ustunida tabulyator tipi o‘rna-
tiladi. Uni o‘zgartirish uchun kerakli katakcha tanlanib, sichqon-
cha bilan chertiladi va u ro‘y-
xat ko‘rinishiga keladi: JIebrii mm 2L
(Left), ITpaBwiit (Right),
Hentpanvubiit (Center).
Jecsirmanbiii (Decimal).
Mulogot oynasidagi tug- ;
ma yana bitta tabulyatsiya =2 -

. . . . . . . [wtoirnwdn

kiritish imkonini beradi | S EaerrE

(knomka /lo6aButh (Add R

tab)), agarda tabulyatsiya soni P T

bir nechta bo‘lsa (Y craHoBuThH
TaOyITOPBI KaXable (KHOMKA
Set tabs every)) yordamida teng bo‘lgan masofalardan berilgan
o‘lchamda go‘yiladi.

Ynanute Tadynsitop (Delete tab) va Ymanuts Bce (Delete All)
tugmalari bitta yoki ajratilgan ro‘yxatdagi tabulyatsiyalar o‘chiriladi.

Pamxu u xoaonxu (Frames and Columns) bo‘limi
Pamku u xononku (Frames and Columns) bo‘limi fagat abzas
matnida ishlaydi. Uning

yordamida ko'p kolonkali 213
maydonlar bilan ishlash = ra [asn | ssce] Tate | Fisns miCobnes Eics |
imkonini beradi. s z)) stk

Ywucio kKoimoHoK (Num- o (EETE—] [ .

. - 2 sl I B
ber of columns) maydoni- Lo FEEEE
dan kolonkalar soni kiri- oo | ~al]
tiladi. ==l

Indents
bonbioe nose Hupu- Pt (00 o — =
Ha KOJIOHKU U TIpOOECibI = =
P Bullsted Hanging Indent
(Column width and -~ —

. -DK Omeonz Npurstame Halp

gutter)lar kolonka o‘lchami- : !

ni va ular orasidagi maso-

fani bildiradi. Homep xosnonku (Column #) ustunida kolonka
tanlanadi, IHupuna (Width) kolonkaning eni beriladi, ITpo6en
(Cutler) — ustunida kolonkalar orasidagi bo‘sh joylar beriladi.
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PasHas mmpuna konoHok (Equal column width)da bayrogcha
go‘yilgan bo‘lsa, kolonkalar o‘lchami bir xil bo‘ladi, fagat bitta
kolonka parametrlarini kiritish kifoya.

Iupuna a63auHoi pamku (Paragraph frame width) maydonida
ish maydonidagi barcha kolonkalar hajmi ko‘rsatilgan.

Beprukanbroe BeipaBHuBaHuMe (Vertical justification) to‘liq
bo‘lmagan kolonkaning joylashishi beriladi: Csepxy (Top), Ilo
ueHTpy (Center), Cauzy (Bottom) va Ilo ¢dopmary (Full).

Dppexmot (Effects) bo‘limi

Bddexter (Effects) bo‘limi ro‘yxatlarni bezatishda, bosh
harflarni (drop caps) yozishda ishlatiladi.

Tun sdpdexra (Effect Type) ro‘yxatida quyidagilarni
tanlashimiz kerak:

e Mapkep a63aua (Bapuant Bullet) matn boshiga joylashtirilib,
boshgacha ko‘rinishda yoziladi va matndan alohida bo‘lib turadi.

e Bapuant Byksuua (Drop cap) so‘zining birinchi harfi katta
qilib yozilgan bo‘ladi.

Orcrynbl (Indents) matnni kiritishdagi chegaralarni belgilash
shu matnga nisbatan qo‘yiladi. Ilpocroit mapkep (Bulleted) varianti
abzas ichidagi markerning joylashishini, BeicTynmaromuii mapkep
(Hanging Indent)varianti esa abzasdan tashqaridagi joylashishni
bildiradi.

Font | Align | Space| Tabs | Frames and Columns Effects ]

Effect Type: jrbrop cap hd

Dropped ines: |3 =

- Indents -
Distance from text: 1,764 :J mm

Il
ll

Dtogggd Han;ingﬁlndent
Orera | ﬂpumme Help

Abzas markerlari fagat abzas matniga qo‘yiladi.
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Paccrosinue ot Tekcra (Distance from text) maydondagi katta
harf bilan oralaridagi masofani bildiradi.

ITpocrasi 6ykBuna (Dropped) varianti harfni butkul matn
bo‘yicha joylashtiradi, Beictymaromas oyksuna (Hanging Indent)
varianti esa asosiy matndagi so‘z boshini bildiradi.

CsoiictBa o0obekTa (Object Properties) panelidagi CsoiicTsa
(Property Bar)ni yordamida formatlash.

X
% 141421 m *¥ 27 654 mm | 1000 % | o | B
w176278m $ 7764mm | 1000 %@ |2 00 | =

& O

iy AvantGardeBKET v (24 v | B 7 U|F off|

o
Jel

Shriftning parametrlarini Coiicta (Property Bar) ma’lumotlar
satri yordamida ham formatlash mumkin.

Matnni ixtiyoriy shaklli obyektga joylashtirish

CorelDRAW dasturi kolon-
kalarning xohlagan turini yaratish
imkoniyatiga ega. Buning uchun
yopiq grafik konturni matn uchun A
konteyner qilib olinadi. Matnni 7 Texcmn
konteynerga joylashtirish uchun -
Texcr (Text) asbobini ishga tu- .
shurish kerak va kursorni obyekt- obwexme
ning konturiga olib kelib sichqon-
cha bilan chertiladi. Shtrixlangan
kontur yuzaga kelgandan keyin S SO
matnni kiritishni boshlash kerak.

=\ 8

Matnni ixtiyoriy trayektoriya bo‘ylab joylashtirish

Obyekt bilan bog‘langan matnni nafagat obyekt ichiga joylash-
tirish mumkin, ya’ni konturlar yordamida xohlagan shaklga ham
keltirish mumkin.

Matn bilan egri chizigni bog‘lash uchun avval ikkalasini ham
ajratish kerak va menyuning Texkct (Text), onpaBuTh TEKCT IO
tpacktopuu (Fit Text to Path...) buyruglari bajariladi.
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Matnni kontur trayekto-
riyasida ko‘rinadigan holga
keltirish uchun Tekcr (Text)
tanlanadi va kursorni konturga
olib kelganda kontur shakli
o‘zgaradi, oxirida sichqoncha
bilan chertiladi. Matn kursori
paydo bo‘lgandan keyin matn
kiritiladi.

? 0. 20 30 0
. 1 1 1 1

/:_Y,E‘I{QT, E 70

4 3
QG :
Hoy-groxk™
@
3 i 0@".
% —O,Th'pbﬂ—of'o' 3

Bog‘langan dinamik ob-
yektlarni boshqgarish uchun menyuning Oxno/Ilanenun Tuna
Docker (Window/Dockers), HanpaBuTtb TEKCT 1O TpacKTOpUHU
(Fit Text to Path) buyrug‘i yordamida amalga oshiriladi.

E|
m v qrst ¢ - ‘ abe - |;f 0.0 mm -~ |m 30743mm o ‘ -

1 2 3 4 °© b6

Opuenrauust tekcra (Text Orientation) (1 ragam) trayekto-
riyaga nisbatan matnning yo‘nalishini aniqlash.

BeprukaibHoe BbipaBHuBaHue (Vertical Alignment) (2 ragam)
vertikal trayektoriyaga nisbatan matnning joylashishi.

Agarda matn ochiq kontur bo‘yicha joylashgan bo‘lsa, Harnpa-
BUTH TekcT 1o Tpackropum (Fit Text to Path) panelida N'opuson-
taabHoe BbipaBHUBaHUe (Horizontal Alignment) da paydo bo‘ladi,
bu esa, matnni gorizontal bo‘yicha joylashtirishni bildiradi.

I'opuszonTaibHoe BhipaBHuBaHue (Horizontal Alignment) yopiq
kontur uchun matnning kvadrat shakli ichiga olib yoziladi (3 ragam).

PenaktupoBars (Edit...) buyrug‘i HanpaButh TekcT 1o
tpackTopuu (Fit Text to Path) panelida joylashgan bo‘lib, ekranga
mulogot oynasini chigaradi. Bu oynada matnni trayektoriya bo‘yicha
(Fit Text P Offset) gorizontal yoki vertikal siljishini bildiradi.

Matnni egri chiziglarga o‘tkazish

Grafika va verstka dasturlarida shrift har xil transformatsiyaga
uchraydi, lekin harfning qismlarini o‘zgartirish imkoniyatiga ega
emas.

Shriftlar maxsus dasturlarda yoritiladi, shu dasturlar yorda-
mida shriftlar gayta muharrirlanadi va mos formatlarda faylga yoziladi.
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Operatsion sistemaga o‘rnatil-

«0

gandan keyin barcha amaliy
dasturlarda ishlash imko-
Harfni alohida egri chiziqqa

aylantirishni garaylik, buning ,

uchun belgilangan matnni e C’ l 1
(Arrange) dan «[Ipeobpaso- ' i
BaTh B KpuBbie» (Convert to Curves) buyrug‘i yordamida amalga
oshiriladi va natijada alohida bo‘lgan obyektlarga ega bo‘lamiz. Bu
avval mos keluvchi shrift tanlanadi va firma nomi Kiritilib,
formatlashning barcha usullari ishlatiladi, keyin har bir shrift
egri chizigqa konvertizatsiya qilinadi, natijada olingan matnga

e e S . O, S S O
niyatiga ega bo.‘ladi. ! Te kCT
menyuning «YrnpasjieHue»
buyruq grafik dizaynda keng foydalaniladi. Logatiplarni yoritishda
xohlagancha ishlov beriladi.

100 1
™
=3 | |

ObTekanue obbekra pabsaunbim Tekctom ODT |

2kaHue obbekra ab3aunbim TekcTom
= ObTrekan \ue obpekTa ab3auHnm
o 1

rekcTom —_ObTekanue o

-

Dml\ra abza unum‘\ FERCTOM |
_{"ObTekanue obvek ] Ta ab3aunbim -
= frel\crom ObTekanue \ obbekra a i

Hiaunnm TekcTom \/ ObTekanue obpekTa abmu

Houm TekcTom Obrekanue obbekra
2] ab3auHbpm

- 2 e L

Grafik obyektni matn bilan joylashtirish

CorelDRAW dasturida obyektli matnlar bilan ishlaganda
obyektga matn bog‘lanmaydi, grafik obyektga fagat chegaralash
beriladi, shu sababli abzasning matndagi obyektini joylashtirganda
avtomatik ravishda chegaralash bajariladi.

Obyektni «obrekaembiii» qilish uchun kursorni obyektga olib
kelib sichqonchaning o‘ng tomon tugmasi bilan chertiladi, keyin
Oo6tekath ab3auHbiM TekcToM (Wrap Paragraph Text) buyrug‘i
bajariladi. Asboblar panelidagi CsoiictBa (Property Bar)da
Oorekarp ab3auHbiM TekctroMm (Wrap Paragraph Text) tugmasi
ham shu amalni bajaradi.
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Obyekt bilan matn orasidagi masofani o‘zgartirish uchun:
kursor obyektga olib kelinib sichqonchaning o‘ng tomon tugmasi
chertiladi va «CsoiictBa» (Properties...) buyrug‘i bajariladi. Bu
quyidagicha amalga oshiriladi. «CoiicTBa o6bekTa» (Object
Properties) panelidan «O6wme» (General) tanlab, «CwmeleHue
oorekaHus Tekcta» (Text wrap offset)ga masofa uzunligi Kiritiladi.

: 20
T Bangkok Cyr |2 ] Bry REEEES T
& oK ]
1 Cancel |
310 BoABUTOE NOAC NPEAHAZHAUCHO AR Help

BBOJA pedakTupoBaHiul u
dopMaTuUpOBaHLLA
1ekcTa

Edit Text dialog oynasi

Core] DRAW maxsus matn maharriri bo‘lmagani bilan matn
muharriridagi barcha funksiyalar mavjud bo‘lgan maxsus
mubharrirlash oynasi «PenaktupoBanue Tekcra» (Edit Text)ga ega.
Bu oyna menyudagi «Tekct» (Text) yordamida ishga tushiriladi.

Oynadagi katta joy matnni kiritish, muharrirlash va formatlash
uchun mo‘ljallangan. Bu oynaga matn fayllarini (kHonka Import...)
tugmasi yordamida import gilish imkoniyati ham bor.

Oynaning yuqori gismida matnni formatlash amallari
(garniturni tanlash, kegl, abzaslarni markerlash va hokazo)
joylashgan.

®opmaTtupoBanue Tekera (Format Text...) tugmasi esa matnni
tashqi bezashga mo‘ljallangan. «Omumu» (Options) tugmasi esa
asosan matn imlosini tekshirishga bag‘ishlangan.
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Grafik obyektlarni matnga joylashtirish

Dasturning grafik obyektlarini matnli —
blokga joylashtirish imkoniyatlari mav- [z Symbols and Special Characters |
jud, bu obyektlar shriftlarga propor- % OmemenTT ~  *
sional ravishda masshtablanadi. Bu . &

funksiyalar matnga grafik elementlarni @ \-‘_‘,f. gz_ (]
joylashtirganda juda qo‘l keladi, masalan, " ) P
logatiplar bilan ishlaganda. Grafik T g:‘fl? B
elementlarni matnli blokga qo‘yish

38

paytida, Clipboard bilan ishlanadi yoki _gg_ (4 Bl 1,
menyuning Penaktuposarth (Edit)dagi g ez e,
Konuposarts (Copy), Beipesats (Cut), gﬁ )/A\( o |9%
BcraButh (Paste) amallaridan bittasi = |5 AN
ishlatiladi. | ICAIEE <
KeyStroke = w[ *

Belgilar va maxsus belgilar

CorelDRAW dasturida CumBosIbI va
CneuuansHbele 3Haku (Symbols and
Special Characters) panelleri mavjud bo‘lib, ekranga menyuning
Oxkno/IManenn tuna Docker (Window/ Dockers) orqgali
chagqiriladi.

Bu panelning obyektlari ikki xil xossaga ega: agarda hujjatga
alohida qo‘yilsa, grafik obyekt hisoblanadi, matnga qo‘yilsa — belgi
hisoblanadi.

CumMmBonbl va crneunuyanbHbie 3HakKu (Symbols and Special
Characters) panelning yuqori gismida shriftli fayllar ro‘yxati
beriladi, tagidagi maydonda esa, tanlangan fayldagi belgilar
ko‘rinishi beriladi.

Belgini tanlash uchun sichqoncha bilan tanlab chertiladi yoki
Knasuia (Keystroke) ga maxsus —

Alt-[belgi kodi] tugmalardan | p————+ ‘ -
kiritiladi. ]

Belgi o‘lchovi Kernb (Symbol | 1
Size) yordamida amalga oshi-
riladi. : e

JlekopaTuMBHasl CeTKAa U3 CUM- | |
BOJIOB Va CMELMAIbHBIX 3HAKOB | |
(Tile Symbol/Special Character) :
buyrug‘i palitradan bitta belgini | .{ ——
bir xil masofalarda joylashtiradi. 1 /=
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Torning parametrlari ITapamerpsr aekopatusHou cetku (Tile
Options) yordamida o‘zgartiriladi.

Pa3smepnr cetku (Grid size) maydoniga torning gorizontal va
vertikal parametrlari o‘rnatiladi.

Imloni tekshirish

CorelDRAW dasturi matnlar bilan ishlashning barcha
funksiyalari bilan ishlash imkoniga ega, shu funksiyalardan biri
matnning imlosini tekshirishdan iborat. Imloni tekshirganda so‘z-
ning to‘g‘ri yozilishi ta’minlanib, noto‘g‘ri so‘zlarni o‘chirib
to‘g‘risi bilan almashtiriladi.

2.5. To‘ldirish va chegaralash
parametrlari

Zalivka va obvodka parametrlari bilan ishlashda CorelDraw dasturi
biriktirilgan ikkita guruh asboblariga ega: 3anuska (Fill) O6Boaka
(Outline).

i £
AFPEEBXE| 49Nt ——=mm
1234567 12 3 2

Agarda yuqgoridagi asboblardan foydalanmaydigan bo‘lsak, be3
samuBku (No Fill) (Fill Flyout ) (6 ragami bilan berilgan) va
be3 o6Boaku (No Outline) (Outline Flyout 3 ragami bilan
berilgan)lar tanlanadi.

Bir xil rangli zalivkalar

Obyektlarni rangli qilib bo‘yash-
ning (zalivka) eng tez usuli ITanurpa
BeroB (Color Palette) panelidan
foydalanish bo‘ladi, bu panel ekran-
ning o‘ng tomonida hammavaqt
ko‘rinib turadi. Agarda ranglar
foydalanuvchining ta’biga to‘gri
kelmasa menyudagi Oxxo (Windows)
buyrug‘i va LIBeToBbIC MaTUTPHI
(Color Palettes) orgali boshga panel
tanlanadi.
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Tanlangan obyektga zalivka gilish uchun sichqonchaning chap
tomondagi tugmasi chertiladi, obvodka qilish uchun o‘ng tomon
tugmasi chertiladi. Bu amalni «nepetackusanusi» usuli bilan ham
amalga oshirsa bo‘ladi. Buning uchun kerakli rangni tanlaymiz va
obyektga olib borib tashlaymiz, agarda <Shift> tugmasi bosilgan
holda bajarilsa zalivka gilinadi, <Alt> tugmasi bosilgan holda amalga
oshirilsa obvodka bo‘yaladi.

Oonomonnas 3aauexa (Uniform Fill) mulogot oynasi
Rangning spektrlari
va imkoniyatlari bilan 21 x|

iShlaSh OHHOTOHHaﬂ L] MW"O Micers | Q] Fixed Palettes | %) Custom Palettes |
2 EMYK - (- Reference -
saauBka (Uniform e IS ‘

Fill) oynasi yordamida -

amalga oshiriladi. Bu

3anuska (Fill Flyout)

panelidagi 1 ragamini

bosish orqali bajariladi.

O6Boaka (Outline

Flyout) ga rang berish

uchun paneldagi 2 =

ragamiga sichqoncha  swrepaete |+] Opons = [ 0K | Omens | Copssea |
yordamida chertiladi va
LIBer o6Boaku (Outline
Color) oynasi paydo bo‘ladi.

Bu oynaning to‘rtta rejimi mavjud:

e [IBeToBbic momenu (Models). Bu ranglar maydonidan
berilgan rangga mos rangni tanlashni taklif giladi.

e Cmecutenu (Mixers). Bu amal birinchidan ranglar seriyasini
to‘rtta rangdan bittasini olishni, ikkinchidan «garmonik akkord»
ranglarni yoritishni taklif etadi.

e Crannaptubeie (Fixed Palettes) va Iloab3oBaTtenbckue mna-
autpel (Custom Palettes). Obyektlarga ranglarni berishni taklif
etadi.

e [IBeToBoe mone Mcxonuwiit user (Old) obyektning rangini
o‘zgartirmasdan avvalgi rangni, Hosbiii et (New) maydoni esa
joriy mulogot oynasidagi rangni bildiradi. CocTaBasroinue msera
(Components) maydonida ranglar modelining rang parametrlari
tanlanadi.

e Nmst (Name) ro‘yxatidagi yangi rangga nom beradi.
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Ileem (Color )paneli

Lset (Color) paneli asboblar panclidagi mos bo‘lgan 3anuska
(Fill) tugmasi (7 ragami bilan berilgan) bosish orgali ko‘rsatilgan
amallarni bajaradi.

Ipaduenmnvte 3aauexu (Fountain Fill) oynasi

Gradiyent zalivkalar bitta tonli ranglardan bo‘lgan zalivkalar-
dan farq qgiladi. Foydalanish yuqoridagi oddiy rang parametrlari
bilan ishlashga o‘xshash bo‘ladi.

I'papucHTHaAst 3anuBKa (Fountain Fill) oynasini ekranga
chagirish uchun 3anuska (Fill) panelidagi tugmani bosish kerak
(2 ragami bilan berilgan).

E— i

Type: — Options—————————
~Center offset ———————— Angle; m

Hbrizontal ”—a # Steps |ﬁ .9.'

vettcalh [0 =% | | Edosped P =H=
i Color blend

(s Two color (1 Eustom

From: -~ |.7

Leg B LI 2

3 2

Mld-pomt; I J* lﬁ

Presets: :I + | S I Fostsenpt Options,. [

0K|Cmcei|Help|

Gradiyent zalivkalarning to‘rtta turi mavjud bo‘lib, ular Tun
(Type) ro‘yxatidan tanlanadi.

e 3anuska Jluneitnas (Linear) tipining to‘g‘ri chiziq bo‘yicha
bo‘yash.

o 3anuska PagnansHas (Radial)ni aylana shakli bo‘yicha bo‘yash.

o 3ammBka Konnueckasi (Conical)ni konus shakli bo‘yicha bo‘yash.

 3aymBka kBanpatHast (Square)ni kvadrat shakli bo‘yicha bo‘yash.
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Shu bilan birga gradiyent zalivkalar oddiy (bitta berilgan rang
ustida) va murakkab (bir nechta ranglardan bir-biriga o‘tishi)
bo‘ladi.

Agarda JIyxusetHasi pactsokka (Two color) joriy bo‘lsa, u
holda birinchi va oxirgi ranglar Ot (From) va /1o (To) tugmalaridan
aniglanadi. Ikkita rangning bir xil proporsiyada olinishi uchun surgich
markazda bo‘ladi, agar zarur bo‘lgan holda uni Cpeansisi Touka
(Mid — point) yordamida o‘zgartirsa bo‘ladi.

exopamuenvte 3aauexu oynasi

JexopatusHasi 3anuBka (Pattern Fill) mulogot oynasini
ckranga chagirish uchun asboblar paneclidagi 3anuska (3 ragam
bilan berilgan) tugmasi bosiladi. /lekopaTuBHasg 3aauBKa
(Pattern Fill)ning uchta turi mavjud: ikkita rangli, to‘ligrangli
va nuqtali.

Jleyxueemmnsie dexopamuenvie zaauexu oynasi

Ikkita rangli dekorativ za-
livkasini ishga tushirish uchun PattenFil 21 x|
2-uBeTHas 3ajauBKa (2- :

. (v 2-color ; =
color) tanlanadi va Jlekopa- ‘ Front |~ |

TuBHas 3anuska (Pattern = MO Bk [ 17|
Fill) muloqot oynasi quyi- ' Bimp
dagi ko‘rinishga ega bo‘ladi. || ||

Mulogot oynasi marka-

Fus Oﬂgll'l ~Size

zida 2-LlBeTH'a$I' 3a1114131<aping Mo = 505 =
tayyor turlarini tanlaydigan ‘ ; o =
tugma joylashadi. oo &8 e =
Ikkita rang]i zalivkada Transform Fow or column offset
rasm rangi (TTepenuumii oray | Skew  [00° <5 || Row ( Column
(Front)) va fon rangi (3amamii | Roate [00° = 0 = %of te size

mran  (Back) bo‘ladi. .
(Create...) tugmasi va mByx- oo

uBeTHO# 3anuBku (Two- [ox ] comsl |  new
Color Pattern Editor) mu-
harriri yordamida yangi ikkita
rangli zalivkalarni yaratish yoki eskilarini muharrirlash mumkin.
Shuning uchun chizilgan bit kartasi (o‘lchamini Pazmep 6b1T0BO#M
kaptel (Bitmap size) yordamida o‘zgartirsa bo‘ladi) «shtrix»
o‘lchami (Pen size)dagi pero o‘lchamida qo‘yiladi.
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2134
~ Bitmap size —
16%16

? ‘ o Px3R

—Pensize-——
O 13
2%2

Iloanousemnvie exmopnbvie u moveyunvie 3aau6Ku oynasi
PatternFill 21|
(" 2-color e

" Full color

'+ Bitmap =]

Load... I Delete l
~ Origin ~Size
% 00mm = Width: 50,8 mm ﬁ
v (00mm = Height: |50.8 mm =
~Transform—————— [~ Row or column offset——
Skew: 100° 5 ‘¢ Bow ( Column
Rotate: [00° = |0 = % of tile size

[ Transform fill with object

ot | b |

To‘liqg rangli zalivka o‘zining dekorativ maydoniga ega bo‘lib, u
alohida *.pat kengaytgichga ega bo‘lgan vektor elementlaridan tashkil
topadi. Agarda IlToamHousetHasi 3aauBka (Full color) yoki
IMonHouBeTHas ToucyHasi 3anuBKa (Bitmap) joriy bo‘lsa, u holda
JlexopatuBHas 3anuBka (Pattern Fill) oynasi quyidagicha bo‘ladi.
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Texture librany:
0K

[Samp[es 9 _
Texture list: Cancel I
Oven Element H

Owl's Eve elp

Plateaus 2

Quilt ~ Options...

Solar Flare

Solder

Steel Wool Tiing... |
- Style Name: Solder

Texture #: 19195 [3 | Eastemlights% |50 .-.; [l
# of drops: 60 ﬂ ‘@ | Nothem light +%: |50 j al

Mindropwidth % [0 < @| | Shade: -
Max drop width %: |75 ﬂ @ | Mid-shade: - 6
Phaseoffset+% 100 < @[ | Light v a
Ripples density %: 25 i’ @ | Brightness % m al

Texcmypnoie 3aauexu oynasi

Core] DRAW dasturidagi matn zalivkalari nuqtali tasvirlardan
tashkil topgan bo‘ladi, ular xohlagan tasvirlardan ixtiyoriy ravishda
tanlanishi, fraktal asosida olinishi mumkin, masalan, oynadagi
sovugning ko‘rinishi.

Matnli zalivkalarning parametrlari TekcTypHasi 3aiuBKa
(Texture Fill) oynasida beriladi. Bu oyna asboblar panelidagi
3anuska (Fill) (4 ragami bilan berilgan) tugmasini bosish bilan
paydo bo‘ladi.

Matnni yozish uchun but6auoreka Texkctyp (Texture library)
maydonidan bittasini tanlash kerak, keyin Texkctypsl (Texture
list) ro‘yxatidan matnning turi tanlanadi. Mulogot oynasining
pastki gismida boshqgarish maydonidagi har bir matn turi hagida
ma’lumot beriladi va u har bir matn turi uchun alohida ko‘r-
satiladi.

Har bir maydonning o‘ng tomonida qulf shaklidagi belgi bo‘ladi.
Uning vazifasi quyidagicha: agarda qulf ochiq bo‘lsa, u holda matnni
tanlash ehtimoli bor. Masalan, belgining ranggi bir giymatda
o‘zgarmaydi.
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Hamma parametrlar o‘zgartirilgandan keyin tasvirni oynada
ko‘rish uchun ITpocmotp (Preview) tugmasi bosiladi va tasvirni
dasturda qayta ishlab ekranda ko‘rsatadi.

PostScript — 3aauexu oynasi

21x

B LT L] 0K
Basketweave | Tl -

Birds Cancel
Bricks TN IO o —
Bubbles NENENININMENEN)

Carpet Rimtmemimememl e
CircleGrid

ColorBubbles INININENINENEN

ColorCircles = Sl
| Foloimeshatekion 2 T T ITTTT] v Previewfil

Iz,..... prrTST—— ‘n.éﬁe..sﬁ....‘ .._....,él

- Parameters —

Width: \10 :ﬂ

Spacing (%): 100 :'i

Maximum gray: 100 —*

Minimum gray: 7 —,_j

PostScript — zalivka parametrlarini aniglash uchun PostScript —
s3anuBka (PostScript Texture) mulogot oynasidan foydalanadi,
bu oyna 3anuska (Fill) (5 ragami) panelidagi maxsus tugma orqali
ishga tushiriladi.

Zalivkani tanlash uchun ro‘yxatdan xohlagan bittasini tanlashi
kerak. Agarda Ilpocmotp 3anuBku (Preview fill)ga belgi qo‘yilgan
bo‘lsa, oynada zalivkani real ko‘rinishi namoyon bo‘ladi.
PostScript — zalivkalar matn zalivkasidan parametrlar berilishi
bilan bir-biridan farq qgiladi. Agarda qandaydir parametri o‘zgar-
tirilgan bo‘lsa, yangi parametrlarni o‘zlashtirish uchun O6HoBICHUE
(Refresh) tugmasi bosiladi.

Hucmpymenm Humepaxmuenas 3aauexa (Interactive Fill)
oynasi
WurepakTuBHas 3anuBka (Interactive Fill) CsoiicTBa
(Property Bar) asboblar paneli bilan birgalikda ishlatiladi.
Bu asbobni ishga tushurish uchun obyektni belgilab va asboblar
panelidan zalivka turini tanlaydi. Har bir zalivka turidan o‘zining
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parametrlari foydalanadi. Muharrirlash uchun CgoiicTBa
(Property Bar) asboblar panclida maxsus PemaktupoBaThb
(Edit...) tugmasi yordamida amalga oshiriladi.

Property Bar : Interactive Texture Fill A
N | Texnae Fil v | Samzless v B~ ‘ 18| Regenecale Texture | Tewture Oglions... | § Hadine v | 93

______ | Intera:|
2| 5, m

2OoOREF~T

;@Pf“&\efo

Ilapamempot o06600xku (Outline Pen) oynasi

Konturning barcha parametrlari O68oaka (Outline) ( | ragami
bilan berilgan) paneclidagi ITapamerpsr o6Boaku (Outline Pen)
oynasidan kiritiladi.

Lget (Color) obvodka rangini bildiradi. Bu tugmaga chertilganda
quyidagicha palitra ekranga chigariladi. Agarda boshqa palitra yoki
rangning boshqga turini tanlash kerak bo‘lsa, dpyrue (Other...)
tugmasini bosish orgali amalga oshiriladi va ekranda LIBer o6BonKM
(Outline Color) paydo bo‘ladi. Bu oynani boshgacha usul bilan
ham chagirish mumkin, uning uchun asboblar panclidan O6Bonka
(Outline) (2 ragami bilan berilgan) tugmasi bosiladi.

CoTE— 21
Color: [N ~ ' |
Width: - }'

1‘4,0 == | points ¥| i —
= s~ O

~Comers— Linecaps — \ﬁUD ‘_?17-
Oy Y (Ol — | ‘3‘5‘?'&—----0 . ‘
C o | G | [ =
A = vt |
]
| Behind fil | Scale with image
[ ok ] cacd | Hep |
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Tonummua (Width) maydoni [« % .~ ¢
obvodka galinligini o‘rnatadi. Uning | |
eniga mos keladigan o‘Ichov birlik-
larini tanlash mumkin. 2

Crunb (Style) chizigning har
xil stillarini tanlaydi — cruioiHoii,
MyHKTUPHOM, IITPUXOBOM, IITPUX | |
IMMYHKTUPHOI va hokazo. S

o = |
').’l!

LY

)0 U

Jo6asuth (Add) va 3aMeHUTH i ;;
(Replace) tugmalari ro‘yxatga yangi 7,

stillarni qo‘shadi yoki ularni boshga
stil bilan o‘zgartiradi.

Vrasl (Corners), Ilapamerpsl
oo6Bonku (Outline Pen) muloqot
oynasida joylashgan bo‘lib, o‘tkir
burchaklarni chizishda ishlatiladi.

(Options) parametrlari burchakni kesishlarda ishlatiladi. Birinchi
o‘tkazgich o‘tkir burchakni, ikkinchi o‘tkazgich burchakning
aylana shakliga kelishini, uchinchisi esa kesishni bildiradi.

Konusr aumuamit (Line Caps) maydoni chiziglarning,
shtrixlarning oxirini ganaqa bo‘lishini bildiradi.

Crpenku (Arrows) maydonidan yo‘nalishning ikkitasidan
bittasi tanlanadigan tugmalar — biri kontur boshini, ikkinchisi
esa oxirini bildiradi. Onuuu (Options) ro‘yxatni ochadi va
yo‘nalishlar bilan ishlashni bildiradi.

|, =
v =

el
Ny g R

¥
[ N

Bitta obyektning parametrlarini boshqa obyekiga qo‘llash

Foydalanuvchi obyektga qanday parametrlar berganligi va uni
ikkinchi obyektga qo‘llash uchun Core]DRAW dasturida maxsus
buyruq bor.

Dastlab parametrlar beriladigan obyekt tanlanadi, keyin
menyuning Penaktuposats (Edit) va Konuposats napamMeTpsl
y... (Copy Properties From...) buyruglari bajariladi, ekranda
Konuposats mapamerpsl (Copy Properties) oynasi paydo
bo‘ladi.

Oynadan kerakli bo‘lgan parametrlar tanlanadi: ITapameTpbl
ooBonku (Outline Pen). 1LIBer o6Bonku (Outline Color) 3anuBka
(Fill) u ITapametrpsr Tekcta (Text Properties).

82



2.6. Qatlamlar bilan ishlash

Qatlam deganimizda obyektlar joylashtiriladigan plyonkasimon
tekislikni tushunamiz. Bu tekislikni barcha obyektlari bilan siljitish,
o‘chirish, ekranda ko‘rsatish va bosmadan chigarishga bog‘liq bo‘ladi.
CorelDraw dasturida hujjat yaratilganda to‘rtta gatlam bo‘ladi:
birinchi gatlam — tasvir tushadigan (Layer 1), ikkinchisi —
(Master Grid) tori (setka) uchun, uchinchisi — (Master Guides)
yo‘nalish uchun va to‘rtinchi — «ish stoli» (Master Desktops)
uchun mo‘ljallangan bo‘ladi.

Yangi qatlamlarni qo‘shish obyektlar bilan ishlashda qgiyinchilik
tug‘dirmaydi.

Har bir sahifadagi gatlamlar soni bir xil parametrlarda va bir
xil nomda bo‘ladi. Agarda qandaydir qatlam bitta sahifada ko‘rinmas
holga kelib qolsa, boshqa sahifalardagi qatlamlar ham ko‘rinmas
holda bo‘ladi. Shu bilan birga barcha sahifada gatlamlarning joylashish
tartibi ham birdan o‘zgaradi.

Qatlamlar bilan ishlashning /lucnemuep ob6sexmoe (Object
Manager) paneli

Qatlamlar ustidagi hamma ope- ——————— -x
ratsiyalar (varatish, o‘chirish, to‘g’- [T Obiect Manage: ’
rilasl.l va hokazo) Ilncnmcp oﬁbcms il ’gg ‘ Iﬁae};irio;, >
(Object Manager) paneli yordamida

P % 3 E]C] Page 1
bajariladi.Bu eckranga menyuning P L v S/ Layert
Oxno\Illanenn Ttuma Docker  &-(C] N[Esterpage
(Windows\Dockers) va JlucneTtuep - 7 Gies
o6bekToB  (Object Manager) % :§§=
buyruglari bilan chagiriladi. L - arid

Panel sarlavhasi tagida to‘rtta tugma
joylashgan bo‘ladi (chapdan o‘ng
tomonga garab):

1. HoBmii caoii (New layer) tugmasi yangi gatlamni Croii
(Layer) nomi va mos raqamni qo‘shadi.

2. Iloka3arb cBoiictBa 00bekToB (Show Objects Properties)
tugmasi obyektning xossalarini ko‘rsatadi.

3. Jns pepakTupoBanus tugmasi barcha qatlamlar uchun
tuzatish kiritish imkoniyatini beradi, agarda u o‘chirilgan bo‘lsa,
faqat joriy gatlamda ishlatsa ham bo‘ladi.
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4. Bua mucmeryepa cioces (Layer Manager View) tugmasi
gatlamlar dispetcheri ko‘rinishini ko‘rsatadi.

Piktogramma sichgonchani o‘ng tomon tugmasi bilan chertilsa
gatlamning xossasini bildiradigan menyu chigariladi va uning yordamida
gatlamni o‘chirish yoki uning nomini o‘zgartirishi mumkin.

Yangi qatlam yaratish

Yangi gatlam Hosrrit crmoit (New Layer) tugmasi yordamida
yaratiladi. Foydalanuvchi xohlagancha qatlamlarni yaritish
imkoniyatiga ega, faqat chegaralanish kompyuter texnik para-
metrlariga bog‘liq bo‘ladi.

Qatlamga nom berish

Qatlamga yangi nom berish gatlam yaratilgan paytda bajariladi,
agarda gatlamga nom berilgan bo‘lsa, uning nomini o‘zgartirmoqchi
bo‘lsangiz, IlepeumenoBars (Rename) buyrug‘i bilan amalga
oshiriladi.

Qatlamni joriy qilish

Yangi yaratilgan obyckt xohlagan joriy gatlamga joylashtiriladi,
shu sababli obyektni o‘zimiz xohlagan gatlamga qo‘yishimiz uchun,
gatlamni IncneTaep oonekToB (Object Manager) panelining gatlam
nomiga sichqoncha bilan chertib belgilashimiz kerak. Qatlamning joriy
bo‘lganligini bilish uchun gatlam nomining rangiga qarash kerak,
agardau qizil rangda bo‘lsa gatlam joriy holda deb tushuniladi.

Qatlamlarning joylashish tartibini o‘zgartirish

Qatlamlarni tartibi Jucmetaep o6bekToB (Object Manager)-
dan o‘zgartiriladi, shuning uchun kerakli gatlamlarni sichqoncha
yordamida pastga yoki yuqoriga surib, joylashish tartibini o‘zgar-
tirish mumkin.

Qatlamlarni o‘chirish
Palitradagi ajratilgan gatlamni va unda joylashgan obyektlarni
o‘chirish uchun quyidagi amallar bajariladi:

e <Delete> tugmasini bosish kerak;
e Menyudan Ymamute (Delete) buyrug‘ini tanlab <Enter>ni
bosish kerak;
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e Menyudagi Jducneruep o6bekToB (Object Manager)
buyrug‘idan Ypamurte cnoit (Delete Layer)ni tanlash kerak.

Master Grid, Master Guides, Master Desktop — standart
e (datlamlarini o‘chirish mumkin emas.

Qatlamlarni fikserlash

Fikserlangan gatlam bitta butun hisoblanib, unda joylashgan
obyektlar ajratilmaydi, o‘zgartirilmaydi, siljitilmaydi va o‘chiril-
maydi. Fikserlanganlik belgisini JIucnietyep oobekTa (Object
Manager) panelidan qgatlamlar satridan «ko‘k rangdagi qalam»
joylashganligidan bilsa bo‘ladi.

Qatlamlarni fikserlash uchun galamning piktogrammasiga
sichgoncha bilan chertish kifoya, galam o°zinig rangini o‘zgartiradi.
Ikkinchi marta chertilsa fikserlanadi.

Qatlamlarni vagtincha ekrandan olib qo‘yish

Fikserlangan gatlamni muharrirlash mumkin emas. Qatlamda
joylashgan obyektlar ekranda ko‘rinish beradi. Agarda foydala-
nuvchiga bu gatlam kerak bo‘lmasa uni ekrandan olib qo‘yish
mumkin. Buning uchun gatlamni ekrandan vagtincha o‘chirib
go‘yish imkoniyatlari mavjud.

Jucnetuep o6bekToB (Object Manager) panelidagi CsoiicTna
cinosi (Layer Properties) oynasidagi Buaumbie (Visible)
bayroqgchasini belgilash (olib tashlash) orqali amalga

oshiriladi. E:J
/‘J
Macmep caosn (Master Layer)dan foydalanish )
Qatlamning xossasi CsoiictBa ciosi (Layer Properties) &,
oynasidan Mactep ciosi (Master Layer) ga bayrogcha U
go‘yadi yoki kontekst menyudagi Macrep cnoit (Master) =
buyrug‘ini xohlagan gatlamini Mactep cioii ga aylantiradi. ‘g‘
Uning vazifasi ko‘p sahifali hujjatlardagi hamma sahifalar %
joylashgan obyektlar ko‘rinadigan holga keltiriladi. Y/""
Agarda fagat joriy sahifada ko‘rinadigan holga keltirish &
kerak bo‘lsa, [IpumeHUTB CBOMCTBA C1051 TOJIBKO K TEKYILICH 2
crpanuil (Apply all property changes to the current page Q:
only)ga bayrogcha qo‘yish orgali amalga oshiriladi. ey
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Obyektlarni bitta qatlamdan ikkinchi qatlamga ko‘chirish

Har xil gatlamlarda joylashgan obyektlarni ko‘chirib, ulardan
nusxasini olsa bo‘ladi. Buning uchun menyuning panelidagi
[TepemecTuth Ha cioit (Move To Layer...) va KonuposaTh Ha cioi
(Copy To Layer...) buyruglaridan foydalaniladi. Amal bajarilganda
ekranda gatlam nomini ko‘rsatuvchi yo*nalishi chiqariladi.

Agarda obyektlarni joriy gatlamdan ko‘chirish kerak bo‘lsa, u
sichgoncha bilan amalga oshiriladi. Buning uchun obyekt yoki
obyektlar to‘plamini tanlash kerak va sichqoncha yordamida
ko‘chirish kerak bo‘lgan joyga olib borib go‘yiladi.

2.7. Rangli va vektorli effektlar

CorelDRAW vektor dasturida obyektning shaklini ®opma
(Shape) asbob yordamida o‘zgartirsa bo‘ladi, ko‘pchilik hollarda
obyektning har bir tayanch nugqtasi bilan ishlashga to‘g‘ri keladi,
bu esa, qiyinchilik tug‘diradi. Bu masalani yechish uchun effekt
ko‘rinishidagi maxsus dastur ishlab chigilgan.

Oddiy vektor effektlari

Oddiy vektor effektlariga oddiy obyektdan murakkabga yoki
teskarisi — murakkabdan oddiyga o‘tadigan obyektlardan tashkil topadi.
Natijada obyekt shakli hech ganday o‘zgarishga (deformatsiya)
uchramaydi, fagat uning tashkil etuvchilar yig‘indisi o‘zgaradi.

Kom6unuposats (Combine) buyrug'i

86



KoMm6unuposath (Combine) buyrug‘i, CpoiictBa (Property
Bar) menyuning tashkil etuvchisi ¥Ynpasaenue (Arrange)
yordamida bir yoki bir nechta obyektlarni bitta obyektga birlashtiradi.
Bu buyruq obyektlarning tayanch
nuqtalarini biriktirganda, niqobga |= . . %.. ... . . . T
olganda yoki teshikchalar paydo |
gilganda qo‘llaniladi. 1 // 7\\

Kom6unuposats (Combine) | | 7 7
buyrug‘ini foydalanishdan avval . —
biriktirilishi kerak bo‘lgan obyektlar |#
ajratiladi. Agarda obyektlar har xil
zalivkalarda bo‘lsa, biriktirilgandan
keyin eng pastdagi obyekt zalivkasi
olinadi. e >

Bu buyrugning ma’nosini yaxshi
o‘zlashtirib olish kerak: obyektlar applikatsiya prinsipiga asoslangan
holda o‘zining xossasiga ega bo‘lib, obyektlar bitta bosgichga olib
kelinib bo‘yaladigan va bo‘yalmaydigan obyektning gismlarini
gaytadan bo‘lishtiradi. Qayta bo‘lishtirilganda kesishmaydigan
obyektlar natijaviy obyektga kiradi, kesishadigan obyektlar esa,
ko‘rinmas holga keltiriladi.

60
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———

200 195 190 185 180 175 170 1685 16
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Jarayonni tushunish uchun shunday qoida bor. Agar o‘zimiz
chizigni chapdan o‘ngga o‘tkazsak, u holda obyektni kesib o‘tgan
birinchi konturdan boshlab zalivka boshlanib, ikkinchi konturda
zalivka tugatiladi («teshikcha» bo‘ladi) undan keyingisida zalivka
bo‘ladi va hokazo.

Pazoumov xombunauuro (Break Apart) buyrug'i
Ynpasnenue (Arrange) menyusida Kom6uauposats (Combine)
buyrug‘i birgalikda Pa36uth komOuHaumio (Break Apart) buyrug‘i
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ham mavjud bo‘lib, ko‘p konturli obyektni tashkil etuvchi
konturlarga ajratadi va ular alohida bitta obyekt deb tushuniladi. Bu
amal Kom6unuposats (Combine) buyrug‘ini bekor qilishda yoki
obyektni tashkil etuvchi konturlarga bo‘lib ishlashda foydalaniladi.
Obyektni belgilab CpoiictBa (Property Bar) panelidagi Ynpas-
nenue (Arrange) buyrugni tanlagandan keyin ishga tushiriladi.

S
% 169916 m** 41.067 mm | 1000 / B |
v 260107m $ 16.940mm | 1000 %8 Ja 920 ° | | H |-

[ = —= & z.,;]ﬁ 9 05p -

Hzmenenue popmot (Shaping) paneli

Ynpasnenue (Arrange) da yana uchta buyruq mavjud bo‘lib,
Kom6unuposats (Combine) buyrug‘ining turlaridan iborat. Bu
birlashtirishning qo‘shimcha turlarini oz ichiga oladi. Uchta buyruq
Docker panelining umumiy nomi M3meHeHue dopmbl (Shaping)
qilib birlashtirilgan hamda CgoiictBa (Property Bar) panelidagi
tugmalari ham berilgan.

Property Bar : Multiple Objects x|
% -91.907 m ** 23266mm | 1000 /.~ “J 0.0 o | EH
v 222401m £ 19283mm | 1000 %8 =
Combine | Group Unaroup Ungroup Af l ) [%] ) l Align...
KHOMKa KoMaHAb! + +KH°"K3 KOMaHAbI
O6bepeHeHune (Weld) MepeceveHune

(Intersection)

KHOMKa KOMaHAbI
Orcevenune (Trim)

Buyrugning ayrigcha tomoniga e’tibor berib, berilgan obyekt-
larning guruhidan ham foydalansa bo‘ladi (obyektlar belgilanib meHto
Ynpasnenue (Arrange) menyusidagi CrpynnupoBath (Group)
buyrug‘i bajariladi).

Ob6sedunumov (Weld) buyrug‘i

Ynpasnenue (Arrange) menyusidagi yoki CoiictBa (Property
Bar) panelidagi O6bvenunuts (Weld) buyrug‘i yordamida hamma
obyektlarni umumiy perimetrlari bo‘yicha kontur chiziladi.
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Obyektlarni birlashtirish [ T s O i
uchun bir yoki ikkita obyekt
tanlanib O0beaAMHUTDH C...
(Weld To...) tugmasini . \ =
bosish kerak va ko‘rsatilgan | |
yo‘nalish yordamida oxirgi
obyektdagi obvodka, zalivka-
larni yangi obyektda qo‘llaydi.

Coxpanuth opurnHan (Leave Original) maydonida quyidagi
amallar bajariladi.

%

%

e Koneunnlit 06bekT(b1) (Target Object(s)) bayroqchasi
belgilangan yoki yo‘nalishi ko‘rsatilgan obyektni xotiraga yozishni
ta’minlaydi.

e JIpyrue o6bekThl (Source Object(s)) barcha obyektlarni
xotiraga yozishni ta’minlaydi.

Ilepeceuenue (Intersect) buyrug‘i — ZR
[Tepeceuenue (Intersect) buyrug‘i yoki Sh"’"’“!
CgoiictBa (Property Bar) panelidagi mos ™ G &
tugmalar yordamida obyektlar biriktirilib,  wel
shaklli barcha obyektlarning kesishidan
tashkil topgan yangi obyekt yaratiladi. -
Ishlash va bayroqchalarning vazifasi et
Oovenmuuth (Weld) buyrug‘iga o‘xshash v Source Object(s)

bo‘ladi. v {Taiget Dbject(s]
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Omcevenue (Trim) buyrug‘i

Orceuenue (Trim) buyrug‘i yoki CpoiicrBa (Property Bar)
panelidagi mos tugmalarning vazifasi berilgan obyektlar ishidan
keraksiz bo‘lgan obyektlar birikmasini kesib olib tashlanadi.

Bu buyrugning bajarilishi O6beauuuts (Weld) buyrug‘iga

o‘xshash bo‘ladi.

- X

@] Shaping |

][]

Trim:

Leave Original:
|v Source Object(s)
Iv Target Object(s)

Trim...

Murakkab vektor effektlari

Murakkab turdagi vektorlar bilan ishlash menyuning DddekTsi
(Effects) yordamida bajariladi. Oddekrn (Effects) yettita buyrugdan
tashkil topgan bo‘lib, obyektlar yoki obyektlarning yig‘indisi ustida
har xil effektlarni bajaradi.

Ilepcnexmuea (Add Perspective) buyrug'i

*

& = EP
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g 1

PN N
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[TepcniektuBa (Add Perspective) buyrug‘i Dddekrnr (Effects)
menyusida joylashgan bo‘lib obyektlarni perspektivasini yaratish
uchun obyektlarni har xil deformatsiya giladi. Bu buyrugq ajratilgan
obyektni shtrixlangan burchaklarida to‘rtta markerli ramkaga oladi.
Tog‘ri to‘rtburchak ichida foydalanuvchi tomonidan gorizontal va
vertikal chiziglarga deformatsiya berishga mo‘ljallangan tor
joylashtirilgan.

Markerlarni siljitish orgali obyektni transformatsiya qiladi va
bir yoki ikkita nuqtali perspektivasini olamiz. Perspektiva ko‘rinishini
o‘zgartirish uchun nugqtalarni surish kerak.

Db dektol (Effects) menyusidagi Konuposats (Copy) buyrug'i
har xil effektlar ro‘yxatini chigaradi. Bu buyruq yordamida
perspektiva parametrlarini ikkinchi belgilangan obyektga qo‘llasa
bo‘ladi.

Berilgan buyrugda Ynanuth < effekt nomi > (Clear < effekt
nomi >) bilan effekt, perspektiva parametrlari o‘chiriladi.

Obyektni ajratganda gandaydir effektdan foydalanilsa, dastur
tomonidan uning nomini ko‘rsatishni so‘raydi.

Envelope buyrug‘i

Addextn (Effects) menyudagi O6osouka (Envelope) buyrug'i
vektorli obyektlarni qobig‘ga qo‘yishni bajaradi.

CorelDRAW dasturida bu amal quyidagicha bajariladi:

e Docker turidagi panel;
e CpoiictBa (Property Bar) asboblar satri;
e MNHurepaktuBHas obosouka (Interactive Envelope) asbobi.

w P ' e e AFLHS BT IS TR :
E-m:‘ = 4 Ervelope
A, , st
32 £ e N ()=
B d e w.ig JARY < 3¢
o ﬂ60[ﬂ( = 'L;
o . SR
&, Oﬁ’ $ NV Y
5 et L
i. ;‘. m, | Fiyout £} N S
m| FEDRA O
LRl P coveity Bas - Interactive Envelops Tooler~ NG| I
gl | 2o AV A AalA|
& Add Pressty | Putty RO %
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Dockers turidagi panelni ekranga chagirish uchun:Windows
menyusidan Toolbars tanlanadi va paydo bo‘lgan oynadan chap
tomonda Menus dan Customize menyuchasi tanlanadi. Oynaning
o‘ng tomonidan ikkinchi kolonkadagi &Windows — &Dockers
menyusini ochamiz, birinchi kolonkadan Effects jildi ochiladi va
kerakli asbob tanlanadi (bizlar & Envelope buyrug‘ini tanlaymiz)
va Add, OK tugmalarini bosish kerak. Shunday qilib, bizlar
Windows — Dockers menyusiga Envelope buyrug‘ini qo‘shamiz.
Amal bajarilganda ekranda Dockers turidagi Envelope paneli
ko‘rinadi.

NHutepakTuBHas obonouka (Interactive Envelope) asbobi
ishga tushurilsa, ajratilgan obyekt atrofida to‘rtburchak paydo
bo‘ladi, markerlarni siljitish orqali obyektni xohlagan shaklga
olib kelsa bo‘ladi. Markerlarni siljitish to‘rtta muharrirlash
rejimidan iborat:

1. Ilo npamoit nuuue (Straight Line) rejimi qobigning
segmentlarini to‘g‘ri chiziq ko‘rinishida beradi.

2. Ilo pyre (Single Arc) rejimi segmentlarni duga ko‘rinishida
beradi.

3. Tlo nBo#HoOW ayre (Double Arc) rejimi ikkitalik duga
ko‘rinishida beradi.

4. Cpoboansrii pexum (Unconstrained Mode) rejimi qobiq
konturlarini ®opma (Shape) asbobi bilan muharrirlaganda
o‘zgartirish mumkin. Bu deganimiz tayanch nuqtalar va bosh-
qarish richaglari bilan ishlash imkoni tug‘iladi. Obyektga tayanch
nuqgta qo‘shish yoki uni olib tashlash mumkin bo‘ladi.

Yugoridagi uchta rejimni maxsus tugmalar bilan amalga oshirsa
bo‘ladi:

e <Ctrl> tugmasini bosilgan holda siljitish garama-qarshi
nugtani berilgan yo‘nalish bo‘yicha siljitadi.

e <Shift> tugmasini bosilgan holda siljitish qarama-garshi
nuqtani berilgan yo‘nalishga garshi yo‘nalishga siljitadi.

o (<Ctrl> + <Shift>) tugmalarini bosilgan holda siljitish
tayanch nuqtaning qolgan uchta nuqtalarni bir-biriga teskari
tomonga siljitishni ta’minlaydi.

Hobaputh rorovyro obonouky (Add Preset) tugmasi tayyor
gobiglar ro‘yxatidan bittasini tanlashni bildiradi.

Dasturda qobiqni mubharrirlashdan tashgari qobig‘ni xarita-
lashning to‘rtta usuli mavjud:
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1. Yrnosoit (Putty) rejimi
burchakdagi tayanch nuqtaga
markerlar qo‘yishni bildiradi.

2. OpuruHanbHbiid (Original)
rejimi burchak markerlarning
burchak tayanch nuqtalarda joy-
lashtiriladi, boshqa tayanch
nuqtalar qobig® chizig‘iga bo‘lib
beriladi.

3. T'opusontanbHbiii (Hori-
zontal) rejimi obyektni gori-
: zontal chiziglarini saglagan holda
[ty = joylashtiradi.

v Keeplines 4. Beprukanbubiit (Vertical)
rejimi obyektni vertikal chiziq-
larini saglagan holda joylashtiradi.

Coxpanuth npsimbie (Keep lines) bayroqchasi obyektdagi
to‘g‘ri chizigni saglashni bildiradi.

Har xil o‘zgartirishlarni CgoiictBa (Property Bar) panelidan
yoki Dddektnl (Effects) menyusidan Ormenuts 06BosKy (Clear
Envelope) buyrug‘i bilan orgaga qaytariladi.

Ilowaczoewtii nepexod (Blend) buyrug‘i

Dpdexkrnr (Effects) menyusidagi Blend (ITowarossiit
riepexo) buyrug‘i obyektning bir shaklidan ikkinchisiga o‘tganda
bajarilgan ketma-ketlikni ko‘rsatadi. CorelDRAW dasturida bu
effektlarni quyidagicha boshqaramiz:

TR R R P, AL e R, e [, [
X - |[& Blend
w e ‘
3 '}, = il =
)
'ﬁ. &
3 O N = thatedton
(@] - a .
(O I .c:active Tool Flpoul > £ 3
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¢ Docker turidagi panel;
e CpoiicTtBa (Property Bar) asboblar satri;
o NuaTepaktuBHblli nepexon (Interactive Blend) asbobi.

Bu effektning eng yaxshi berilgani Docker turidagi panelda, u
to‘rtta: [Haru (Steps), Yckopenue (Acceleration), IlpeBpaieHue
uBera (Color Direction) va Pasnoe (Miscellaneous) tugmalaridan
iborat.

Amalni bajarish uchun asbob ishga tushiriladi, kursor yorda-
mida obyekt tanlanadi, sichqonchaning tugmasi bosilib, shtrix
chizig‘ini oxirgi olingan obyektgacha suramiz, natijada bajarilgan
amallar guruhi namoyon bo‘ladi.

Illaeu (Steps) tugmasi

[Nomraroserii nepexon ( Blend) panelidagi birinchi tugma Illaru
(Steps) obyektlarning o‘zgarish soni va ular orasidagi masofa
birinchisidan ikkinchisiga o‘tish sonini bildiradi.

Yucno maros (Number of steps) kerakli bo‘lgan oradagi
obyektlar sonini bildiradi.

dukcuposanubii uHTepBal (Fixed spacing) bir-biriga o‘tish
oralig‘ini bildiradi. Bu amal fagat ketma-ket o‘tish trayektoriya
bo‘yicha bo‘lsa — bajariladi.

Bpamenue (Rotate) maydoni oradagi obyektlarni burishni
bildiradi.

ITetna (Loop) bayroqchasi berilgan obyektlardan bir-biriga
o‘tishda ular orasidagi trayektoriyani burish xizmatini bajaradi.

Ycxopenue (Acceleration) tugmasi

I[Tomaroeeii mepexon (Blend) panelidagi Yckopenue
(Acceleration) tugmasi obyektlarni qaytadan joylashtiradi va
joylashish tartibini o‘zgartiradi.

YckopeHue oObekToB (Accelerate objects) maydoni obyektlar
orasidagi o‘tish oralig‘i teng bo‘lmagan holatlarni yoritadi, agar
chap tomonga surilsa, berilgan obyektdan oxirgi obyektgacha bo‘lgan
vogealarni tezlashtiradi, o‘ng tomonga surilsa, oxirgi obyektdan
boshlanadi.

Yckopenue 3anuBku/ ob6Boaku (Accelerate fills/-outlines)
yuqoridagi amalga o‘xshash bo‘ladi, fagat zalivka, obvodkalar
uchun bajariladi.
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[ Link accelerations

I

[MpumensiTe K pa3mepy (Apply to sizing) oradagi obyektlarni
Yckopenne o0bekToB (Accelerate objects)ga nisbatan o‘lchamlarini

o‘zgartiradi.

Caa3b yckopenmit (Link accelerations) bayroqchasi Yckopenue
00beKkTOB (Accelerate objects) va YckopeHUe 3aTMBKHU/0OBOJIKHU
(Accelerate fills/outlines) maydonlaridagi giymatlarni sinxronlashtiradi.

([ Blend

il G

&

ORI

Ilpeepawenue uyeema (Color Direction)
tugmasi

[Tpespawmenue upera (Color Direc-
tion) tugmasi bir rangdan ikkinchisiga
o‘tishni ta’minlaydi, bu amal I'pagueHTHas
sanuBKa (Fountain Fill) oynasidagi amalga
ekvivalent bo‘ladi.

Berilgan uchta tugma bir rangdan
boshqasiga o‘tish yo‘nalishini ko‘rsatadi.

[Tepexon mo npsmoit auHuM (Straight
Line Blend) tugmasi berilgan ranglar
doirasidan to‘g‘ri chiziq bo‘yicha boshqa

rangga o‘tishni ta’minlaydi.
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Qolgan ikkitasi Ilepexon mo yacoBoii = ax
crpenke (Clockwise Path) va Ilepexon (53l
npoTuB yacopoii crpeaku (Counter- hH% 8o
clockwise) mos yo‘nalishga soat strelkasi
bo‘yicha spiral shakldagi ranglarni o‘zgar- Map Nodes
tirishni bildiradi. Spit
Pasznoe (Miscellaneous) tugmasi ——
PasHoe (Miscellaneous) to‘rtta tugmadan
iborat.
KaptupoBanue y3nos (Map Nodes) LBl M e
tugmasi ishlaganda ekranga maxsus kursor i

chiqariladi. Bu kursor yordamida berilgan
va oxirgi obyektlar uchun tayanch nuqtalari tanlanadi va dastur
obyektning ikkinchi obyektga o‘tishini ko‘rsatadi.
Pa3outh (Split) tugmasi maxsus kursorni ekranga chiqaradi,
uning yordamida oradagi obyektni uzib olish imkoniyati bo‘ladi.
BoccraHoBuTh HavanbHbiii 00bekT (Fuse Start) va Boccra-
HOBUTb KOHeuYHbIit 00beKT (Fuse End) tugmalari KHOMKHM
Pas3outs (Split) tugma xizmatini bekor giladi. Bir-biriga o‘tishdagi
xohlagan bitta obyektni <Ctrl> tugmasini bosgan holda sichqoncha
chertiladi va joriy bo‘lgan tugmalardan bittasini tanlaymiz.

Obyekt va trayektoriyalar tugmalari

New Start \ New Path
Show Start ‘(' W ] ~H ‘ '\?" ‘_’ Show Path

l Detach From Path

New End [
Show End
[Towarossiit nepexos (Blend) panelining pastki gismida uchta
tugma — HauanbHblii 00bekT (Start), KoHeuHblit 00bekT (End)
va Tpaekropus (Path) joylashgan bo‘lib, bu amallarning barchasi
berilgan obyekt va uning trayektoriyasini aniglaydi.
Tugmalardan xohlaganini tanlaganda ikkita buyrugdan iborat
menyucha ochiladi. Birinchi buyruq Hoseslii (New) berilgan obyekt,
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oxirgi obyekt yoki trayektoriya ekanligini ko‘rsatadi. Ikkinchi buyruq
[Tokazatb (Show) ajratilgan guruhdagi bir-biridan o‘tishning boshi
yoki oxirini va trayektoriyasi ekanligini bildiradi.

Koumyp (Contour) buyrug‘i

Effects (Bddexktsi) menyusining Kontyp (Contour) buyrug'‘i
yoki MHTepakTuBHbIii MHCTpYMeHT (Interactive Tool) joylashgan
maxsus tugmasi berilgan obyektdan ichkari yoki tashqari
yo‘naltirilgan kontsentrik shakllarni chizadi.

% 30 20 o 0 10 20 30 4
s 1 =
1 x ]]Contour|
& A [N
q sy :
IR
1 ¢, S
= o center
= ) i
; = L Inside
: |l + Outside
& O
-] A Oifset:[1583 2l mom
: I | iteractive Tool Flyout ! s
& g r Steps: [6 =
1Y | FEDR GO
1B
== A
g': '?A i [
1 8, x|
: % -14106m ¥ 27823 mm | 13 - -
| T R B EE s S
] gisum SN CH 3 v |%®

Contour (KonTyp) panelida ikkita tugma bo‘lib, ulardan bittasi
konturlarning tashqi ko‘rinishini, ikkinchisi esa, konturning rang
parametrlarini bildiradi.

Birinchi tugma bosilganda [llaru (Steps) va Cmewenue (Offset)
joriy bo‘ladi. K uentpy (To center) yordamida Cmewenue (Offset)
maydonida berilgan intervallar kontsentrik shakllar bilan to‘ldiriladi.
Faqgat ko‘chish diametri bo‘yicha bo‘lmaydi, (teng ikkiga
bo‘linmaydi), har bir chizig oldingisidan berilgan masofaga
siljitiladi, shu sababli, ikkita barobar kontur chiqadi (masalan,
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diametri 100 mm doira, ko‘chish —10 mMm bo‘lsa, hisob bo‘yicha
10 ta kontur bo‘lishi kerak, bizda 5 ta chigadi, sababi ko‘chish
ikki tomondan bo‘linganligidan).

Buytpb (Inside) kontsentrik shakllar bilan to‘ldiriladi, uning
soni Illaru (Steps) maydonidan beriladi, Cmemenue (Offset)
dan esa interval aniglanadi.

Hapyxy (Outside) esa obyektning tashqi gismini kontsentrik
shakl bilan to‘ldiradi, shakllar soni I[llar (Steps) da beriladi,
intervallar soni esa Cmenienue (Offset) dan aniglanadi.

-
=
h
(=]
=
=

Rangni aniqlash tugmasi effektning ketma-ket o‘tishidan farq
giladi, obvodkaga rang berish pero tugmasi bilan va zalivkaga rang
berish bo‘yoqli chelak tugmasi bilan amalga oshiriladi. Agarda berilgan
obyekt gradiyent zalivkani zalivka hisobida olgan bo‘lsa, u holda
ikkita tugma chiqariladi: gradiyentning dastlabki va oxirgi rangi.

Extrude buyrug‘i

Ddbdexktor (Effects) menyusidagi DkcTpyaupoBaHue
(Extrude) buyrug‘i eng qiyin bo‘lgan effektlardan, dasturda
ajratilgan obyektlarga o‘ng tomonidan tekislik qo‘shadi va uch
olchovli ko‘rinish tashkil giladi. Bu effektni boshqarish [Toia-
rosblii nepexon (Blend) effektiga o‘xshash. Buning uchun obyekt
tanlanadi (kursor shakli o‘zgaradi) va sichqonchaning tugmasi
bosilgan holda shtrix chizig‘ini bosib turib tortiladi, sichqonchani
go‘yib yuboriladigan nuqta krest bilan belgilanib yig‘ilish nuqtasi
deyiladi.

DkcrpynuposaHue (Extrude) panelida beshta amal bor: Touka
cxona (Vanishing Point) yig‘ilish nuqtasi, Bpamenue (3D
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Rotation) aylanish, Ocseuienue (Lighting) yorug‘lik, LiBer (Color
Wheel) rang va ®acka (Bevels) faska.

Touxa cxoda (Vanishing Point) tugmasi

Okcrpyauposanue (Extrude) pa-
neliga joylashgan bo‘lib, yaratilayotgan [23] Extrude
obyekt hajmining parametrlarini — e ]
aniglaydi. FO QS M

Ko‘rish oynasidagi ro‘yxatda skcTpy- Vanishing Point
qupoBaHms usulini tanlash berilgan:

e YMeHblIeHHe B rayouHy (Small ﬁ
Back) obyektning yig‘ilish nuqtasini e Huck =
obyektning orga qismiga chiqaradi va orga
tomonini kichkina qilib ko‘rsatadi;

e VmeHblieHue B nepén (Small
Front) obyektning yig‘ilish nuqtasini
obyektning oldi gismiga chiqaradi va old
tomonini kichkina qilib ko‘rsatadi; i

e VYBenuueHue B rayouny (Big S
Back) obyektning yig‘ilish nuqtasini < Object center
obyektning old gismiga chigaradi va orqa B | Ay |
tomonini kichkina qilib ko‘rsatadi; '

e VeenuueHue Briepén (Big Front)
obyektning yig‘ilish nuqtasini obyektning orqa gismiga chiqaradi
va orga tomonini kichkina qilib ko‘rsatadi;

e [lapannenbHo B riydouHy (Back Parallel) ichkariga kirgan
tomondagi yon tomonlarining parallelligini ta’minlaydi va old
tomonlarining tengligini saglaydi;

e [lapamnensHo Brepéa (Front Parallel) oldiga chiqgarilgan
tomondagi yon tomonlarning parallelligini ta’minlaydi, old va orqga
tomonlar tengligini saqlaydi.

— A X

| VP Locked To Object ¥

Dept 570 =4

H: 145,959 i mm
v [iisﬁé’éé‘ ==

Quyidagi ro‘yxatda yig‘ilish nugqtalari turlari berilgan: Touka
cxona npuBsizaHa K 00bekTy (VP Locked To Object) yigtilish
nuqtasi obyektga bog‘langan, Touka cxoia npuBsizaHa K CTpaHM1IE
(VP Locked To Page) yig‘ilish nuqtasi sahifaga bog‘langan.
KonupoBats Touky cxoma ot (Copy VP From...) yig‘ilish
nuqgtasidan nusxa ko‘chirish, O6umasi Touka cxoaa (Shared
Vanishing point) umumiy yig‘ilish nugqtasi.
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I'nyouna (Depth) maydonidagi yig‘ilish nuqtasidan yon
tomonlarining uzunligigacha bo‘lgan masofa foiz nisbatida beriladi.
(H va V) maydonlari I'nyouna (Depth) chuqurlik parametr-

larini bildiradi.

Touka cxoma (Measured from) maydonida obyektning
markaziga nisbatan aniq yig‘ilish koordinat nuqtalari beriladi.

[&] Extrude ] Ext:ude B i
o 0o B0 08 m
3D Rotation: 7 3D Rotatio: 7
Rotation values
. [ =
X| B mp——Pp- 3 [ = @
Appy | | Aepb |
Bpawenue (Rotation) Fazoda obyektlarni “x
. P pL.e . [&] Extrude
aylanishlarini ta’minlaydi ‘
Bu amal ikkita variantga ega, birinchisi BCI0
aylanishni qo‘l yordamida bajaradi, ikkinchisi Lighting
esa, aniq sonli ragamlarni kiritish orqgali beril- ol _—
gan son maydonlari 1, 2 va 3 lar mos ravishda o | T
X, Y va Z koordinat o‘qglariga mos keladi. ©
Intensity:

Oceewenue (Lighting)

OcBemenue (Lighting) yordamida
yorug‘likdagi uchta rangdan bittasini olib
tashlash imkoniyati bor.

Yorug‘likni tashkil etuvchi mos ragam-
lariga gqarab qo‘shsa bo‘ladi. Yorug‘lik tushishi

100

J [100

[V Usze tull color range
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kubdan karkas bilan garash yordamida olinadi. Har bir manba
o‘zining intensivligiga ega bo‘lib, MuTeHcuBHOCTh (Intensity)
maydonidan beriladi. Kerak bo‘lgan manba tanlanib va surgichni
kerak tomonga surgandan keyin va Ucriosib30BaTh MOJHOLBETHbI
nuana3oH (Use full color range) bayroqchasini tanlash bilan
soya va yorug‘likning tushishini aniqroq beradi.

Tekislikda fazoviy obyektlarni tasvir-
lashda ranglar katta rol o‘ynaydi. Bkiaaka
LiBer (Color Wheel) bir nechta rangli

WUcnonb3oBaTh 3ajJMBKY 00bEKTA
(Use object fill) amali obyekt o‘zining
rangini zalivka sifatida foydalanishni
bildiradi. KoBpoBasi 3anuBka (Drape fills)
tanlangan bo‘lsa, obyektni to‘la yon
tomonlarga ajratmasdan bo‘yashni

CnnowHas 3anuBka (Solid fill)
fazoviy obyektning ustki qismini bir xil
rang bilan to‘ldiradi, bunda rang palitra-

= e | Ileem (Color Wheel)
BCOS N
Color Wheel:
zalivkani taklif etadi.
» Use object fill
* Solid fill
{ shm
[ Drape fills
bildiradi.
Aoply dan tanlanadi.

] = [TnaBHasi 3asuBka (Shade) yorug-

likni real imi-
tatsiyalashda ravon tarqalishini ta’minlash
magqsadida foydalanadi. Ranglar Ot
(From) va [lo (To) tugmalar yordamida
aniglanib, yorug‘likni hisobga olgan holda
gradiyentni to‘ldirish imkonini beradi.

Dacka (Bevels)

Fazoviy obyektning eng oxirgi shtrixi
obyektning faskasini yaratadi.

®dacka (Bevels) faskani yaratish va
uning paramertlarini o‘zgartirish amal-
larini bajaradi. Faskani yaratish uchun
[Tpumenuts ¢acky (Use Bevel) bay-
roqchasini qo‘yish kerak va uni parametr-
larini berish kerak.
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I'nyouna dacku (Bevel depth) maydoni faskaning o‘lchamini
beradi, Yron ¢dacku (Level angle) maydoni — qiyalik burchagini
ko‘rsatadi.

Jlunza (Lens) buyrug‘i

Effects (Dddekrtni)dagi Jiuuza (Lens) buyrug‘i ajratilgan
obyekt shaklini o‘zgartiradi, masalan, kattalashtiradi, yoki ranglarni
filtrlaydi va hokazo. Agarda linza obyektlar guruhi ustida tursa, u
holda obyektning har birini alohida o‘zgartiradi.

3 320 300 280
_M—Lua.um.lm.uu.duu.ll.“ul --------- Lo |
1 - X
Lens |
‘ Transparency v |

Rate |5 = %
Coor. [ |+

| Frozen

[ Viewpoin:

| Remove Face

Apply

Bu amal bajarilganda Docker turidagi panel paydo bo‘lib,
unda linzalar ro‘yxati va ularni foydalanganda obyekt ko‘rinishlari
beriladi. Tanlangan linzaning turiga bog‘liq effekt parametrlari
o‘zgaradi.

e Linza — IIpo3paunas (Transparency) obyekt va linza ranglarni
aralashtiradi, bu amal LIBer (Color) tugmasi va YpoBeHb (Rate)
maydonidan linza tiniqligi foiz nisbatida tanlanadi, giymat gancha
katta bo‘lsa, linza tinigligi shuncha yuqori bo‘ladi.

e Linza — YBenmuenue (Magnify) KoadduumeHT yBennueHust
(Amount) maydonida berilgan giymatga nisbatan obyektni
kattalashtiradi.

e Linza — fApkocts (Brighten) obyektni ravshanligini YpoBeHb
(Rate) maydonida beriilgan qiymatdan aniglaydi.

e giymatlar diapazoni:
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| Frozen
| Viewpoint
|v Remove Face

L 4w |

— 100% dan +100%. Agar +100% bo‘lsa, hamma ranglar oq
rangga ega bo‘ladi, 0% da linza — obyekt rangiga hech ganday ta’sirini
o‘tkazmaydi, — 100% da bo‘lsa, hamma ranglar qora rangga o‘tadi.

e Linza — WuBeptuposarh (Invert) obyektning ranglarini
invertizatsiya qgiladi: Qora rangni — oq rangga, oq rangni — qoraga
va hokazo. Agarda invertizatsiya fonga ham ta’sir qilsa, u holda
Ynanute poH (Remove Face) bayroqchasini qo‘yish kerak,
shunda fagat obyektgina invertizatsiya gilinadi.

e Linza — LIBetHoit ¢uabTp (Color Limit) buyrug‘i Liser
(Color)da ofrnatilgan linza rangidan boshqa obyektning barcha
ranglarini filtrlaydi. Filtratsiya intensivligi Rate (YpoBeHb)
maydonidan aniqlanadi, agarda u kam bo‘lsa, boshga ranglarning
natijaviy rangga tushishi ko‘proq bo‘ladi. Bu effektga ¥ nanuts oH
(Remove Face)dan foydalansa ham bo‘ladi.

e Linza — Cnoxenue 11BetoB (Color Add) obyektning rangiga
linza rangini RGB modeli bilan aralashtiradi.

e Linza — OkpauenHas cepas wmikana (Tinted Grayscale) Bu
filtr rasmlar bilan ishlashda qo‘l keladi.

e Linza — UHdpakpacHas mikana (Heat Map) obyekt rangini
infra gizil shkala bo‘yicha konvertatsiya giladi.

e Linza — LieroBoit ¢uabtp ¢ pactskkoir (Custom Color
Map) obyekt rangini siljitgich yordamida o‘zgartiradi. Ot (From)
va 1o (To) tugmalari yordamida ranglarni o‘zgartiradi. Siljitgichning
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yo‘nalishi quyidagi ro‘yxatda berilgan: Ilo npsimoii (Direct Palette)
variantida to‘g‘ri chiziq bo‘yicha, [lpsmas panyra (Forward
Rainbow) to‘g‘ri kamalak varianti va OOGpatHasi paayra (Reverse
Rainbow) teskari kamalak shaklidagi soat strelkasiga nisbatan doira
shaklida o‘zgartiriladi.

e Linza — Koutypubiii pexum (Wireframe) Ovbodka va
zalivkalarning rangini o‘zgartiradi. O6Boaka (Outline) va 3asinBka
(Fill) amallari bilan bajariladi.

e Linza — «Pbi6uii rna3» (Fish Eye) obyektlarni kattalashtiradi
yoki kichiklashtiradi. Linzaning o‘zragish diapazoni —1000% dan
+1000% oraligda bo‘lib, bu ¥Yposenb (Rate) panelida joylashgan
bo‘ladi.

Agarda be3 smu3bl (No Lens
Effects) tanlansa linza olib tashlanib,
oddiy obyekt ko‘rinishida beriladi.

3amopo3uth (Frozen) bay-
roqchasi, linza ostidagi obyektni |*
gotib turgan holda boshqa joyga
go‘yishi mumkin.

Touka 3penus (Viewpoint)
linzadan ko‘rilgan obyektni siljitish z{ //
imkoniga ega, bunda obyekt yoki 1
linza siljitilmagan holda bajariladi. Bu .| |\
amalga bayroqcha qo‘yilgandan keyin |
PepaktupoBars (Edit) tugmasi
paydo bo‘ladi, tugma bosilgandan
keyin krest shaklidagi marker chigadi. Markerning siljitilishi
tasvirning siljishiga olib keladi.

e

r,w

Oobmpasounviii kaun (Power Clip) buyrug'i

BDdhdekrnl (Effects) menyusidagi O6tpaBounbii kiun (Power
Clip) buyrug‘i bajarilganda menyuning buyruglari va effektlarini
mubharrirlash chiqariladi.

Klipga kiradigan barcha obyektlar bitta obyekt bo‘lib hisob-
lanadi. Klip ustida amallar bajarganda obyektni butunligicha yoki
uni gismlarga ajratgan holda amalga oshiriladi. PepaktupoBarb
conepxanue (Edit Contents) yordamida muharrirlanadi. Bu amal
Dddexror (Effects) menyusidagi O6rpaBounbiii kaun (Power
Clip) ichiga joylashtirilgan. Agarda ishma-ish ketgan clip bo‘lsa,
mubharrirlash bir necha marta bajariladi.
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Ishni tugatgandan keyin 3akOHYMTb peAaKTUPOBAHMUE JaH-
Horo ypoBHst (Finish Editing This Level) amali bajariladi. Bu
amal muharrirlangan obyektni gaytadan konteynerga solib qo‘-
yishni bajaradi.

Agarda Tlapamerpnl (Options) (Windows menyusi Toolb
asbobi) oynasidagi Penaktuposath (Edit) buyrug‘idagi ABto-
MaTUYEeCKOe LieHTpUMpoBaHue ga bayroqcha qo‘yilgan bo‘lsa, klipni
tashkil etuvchilarni markazdan joylashtirilgan holda ekranga
chigariladi.

Humepaxmuenaa npospaunocme (Interactive Transparency)
asbobi

MurepakTuBHasi npo3payHocth (Interactive Transparency)
asbobi yordamida vektor grafikasi dasturiga rastr grafika dastur-
larining amallaridan biri bajariladi, bu amal asboblar panelidagi
mos tugmalar yordamida bajariladi.

Bu amalning rastrli tasvirlarini ko‘k rangli ko‘rinishdagi
obyektlar yaratadi.

MurepakTuBHasi npo3payHocth (Interactive Transparency)
asbobi CaoiictBa (Property Bar) bilan birgalikda ishlab, hamma
zalivkalardan foydalanish ravshanlik parametrlarini oshiradi.
CaoiictBa (Property Bar) satrining ko‘rinishi tanlangan zalivka
turiga bog'liq.
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Edit (PemakTtupoBaTtb) tugmasi panelning chap tomonida
joylashgan bo‘lib, mos zalivka rangidagi asosiy mulogot oynasini
ekranga chigarishga mo‘ljallangan.

Bu yerda maskalarni biriktirishning rejimlariga e’tibor berish kerak,
bu o‘n sakkizta rangli obyektlar bilan ishlash imkoniyatini beradi.

Ro‘yxatda quyidagilar berilgan: HopmanbHbeiM (Normal) oddiy,
Cnoxenue (Add) qo‘shish, Beruutanue (Substract) ayirish,
Paznuua (Difference) kamaytirish, Ycunenue (Multiply)
ko‘paytirish, Ocnabaenue (Divide) yengillashtirish, Ecau cBetiee
(If Lighter), Ecau temnee (If Darker), Tekctypusauus
(Texturize), Hue (LIBeToBoit ToH), HachieHHocTh (Saturation),
Spkocts (Lightness), Oo6pawenue (Invert), Jlornueckoe «u»
(And), Jlornueckoe «uau» (Or), Jlornueckoe «MCKITIOYAIOLIEe WIN»
(Xor), Kpachniit (Red), 3enenniii (Green), Cunuii (Blue).

Humepaxmuenaa depopmauua (Interactive Distortion) asbobi

{

w0 2o %

Add fEew

8w @

Property Bar : Interactive Distortion - Twister Effect x|

83 @ addlew | P[0T Sx15 3 |EO

P A
e BO00AGHT > E

1o, | B®
ERal - coocive Tool Fraut”
FHDH DB

ol

MutepaktuBHasi pedopmauus (Interactive Distortion)
asbobining tugmasi MHTepakTuBHBIA MHCTpyMeHT (Interactive
Tool) guruhida joylashgan. Buning yordamida obyektlarni avvalgi
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turidan katta farq qiladiganday qilib o‘zgartiradi. Bu asbob
CaoiictBa (Property Bar) bilan birgalikda ishlatiladi. Bu yerda
. I deformatsiyaning uchta turi mavjud:
M (Tanu-Tonkait» (Push and Pull) tortib

chizing, 3ur3ar (Zipper) zigzag shaklda
8- .
: va CkpyuuBanue (Twister) buralgan

"

shaklda bo‘ladi.

Bu asbob bilan ishlashning boshqga
interaktiv asboblardan farqi yo‘q, fagat
oxirida olinadigan natijadan ko‘zlagan
faktorlarga bog‘liq, tasodifiy (masalan,
kursorning holati yoki uning siljitilgan
masofasi va hokazo), vogealarga bog‘liq
kutilgan natijani bermaydi. Shu bilan birga
natijaviy «Mahsulot»ni olishning bir nechta
turli imkoniyatlari bor va ular cheksiz.

Humepaxmuenas menwv (Interactive Drop Shadow) asbobi

MUnTepaktuBHas TeHb (Interactive Drop Shadow) (interaktiv
soya) asbobi tugmasi MHTepakTuBHBII MHCTpyMeHT (Interactive
Tool) da joylashgan bo‘lib, soyaning har xil effektlarini yaratishga
mo‘ljallangan.

e T ) L e S D e T s
N SPgerT

" 32 nadarouw eu TeHU

1%| DONmOEAn s

{ O g

io

Jo| Yoy

1A .

‘ 9‘“ Property Bar : Interactive Drop Shadow x|
o | e sms smE
'i 7!3‘0-59,523 o1 &(s0 +|.v ““®
¥ ‘{;" interoctive Tool Fyautl]

{o|FED R0

107



Bu asbob CsoiictBa (Property Bar) asboblar satridan ham
boshgariladi.

Hampasnenue Tenu (Drop Shadow Direction) Soya yo‘nalishi
ro‘yxatida soyalarning turlari berilgan: BuyTtps (Inside) Ichida,
ITo menTpy koHTypa (Middle) Markazda, Hapyxy (Outside)
Tashqgarisida, Ycpennennast (Average) Markazlashgan. I'panuiier
teHn (Drop Shadow Edges) Soya chegaralari ro‘yxatida —
chegaralar uchun berilgan variantlar keltirilgan: JImHelinas
(Linear) To‘g‘ri chiziqli, Ksagpatnast (Squared) Kvadrat, Un-
BepTupoBaHHas kBaapatHas (Inverse Squared) Inversiyalangan
kvadrat, XKectkast (Flat) Qattiq.

Rang effektlari

CorelDRAW dasturining asosiy maqsadi rangli effektlar
yaratish bo‘lib hisoblanadi. Bu effektlar nafagat nuqtali tasvirlar,
balki vektorli tasvirlar uchun ham ishlatiladi. Bddexrnr (Effects)
menyusidagi IIBetosreie HacTpoiiku (Color Adjustment) buyrug‘i
ro‘yxatni chiqgaradi va bu yerda shulardan oltitasi vektorli
obycktlarga tegishli.

o fApxoctr-KouTpacT-UHTeHCcHBHOCTL (Brightness-
Contrast-Intensity) filtri tasvirlarni rang tonlarini sozlaydi.
Spxocte (Brightness) maydoni yorug‘lik tushishini o‘zgarish
diapazonini ko‘rsatadi, Kourpact (Contrast) maydoni — ochiq
va to‘q rangli tonlarini o‘zgarishini beradi, MHTeHCHUBHOCTH
(Intensity) maydoni bo‘lsa — ochiq tonlar o‘zgarishini beradi
(to‘q ranglar o‘zgarmaydi).

o lIBeroBoit 6amanc (Color Balance) filtri belgilangan obyekt
ranglarini o‘zgarishini bildiradi. Bu effektni giyin tomoni bitta
rangni o‘zgarishi ranglarning balansini bosib, boshga ranglarning
o‘zgarishiga olib keladi.

e 'amma (Gamma) filtri yorng‘lik va kontrast nisbatlarini
o‘rtacha ton diapazonida garab, soyalar va yorug‘lik tushishini
sozlaydi. Agarda hech narsa tanlanmasa 1 soni gabul qilinadi, ya’ni
tasvirga ta’sir gilganda o‘zgarmaydi. Agarda gamma ranglar soni
ortib borsa oqaradi, teskari bo‘lsa gqoralashadi.

e IlBeToBoii ToH/Hacwemenunocts/CBeTnora (Hue/
Saturation/Lightness) filtri rang toni va uning to‘yinganligini
o‘zgartiradi.
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e Heratms (Invert) filtri negativ ranglarni olishga yoki rastrli
tasvirlarni olishga mo‘ljallangan. Oq va gora ranglar bir-biri bilan
almashtiriladi.

o Ilocrepuzanms (Posterize) filtri rangli ottenkalarni kamay-
tirishga, ya’ni tasvirni bir nechta lokal ranglarga ajratadi. Bu usul
grafikada keng foydalaniladi, masalan, plakat turida. Bu buyrug
tasvirlarni trassirovkaga tayyorlashda ham qo‘llaniladi.

2.8. Tasvirlarni import va eksportlash

Tasvirlarni eksport yoki import gilganda quyidagi konvertorlar
bo‘lishi kerak — oldindan saglangan ma’lumotlarni dastur
tushunadigan turiga o‘tkazuvchi modullar bo‘lishi shart. OLE
texnologiyasidan foydalanganda konventorlar hagida o‘ylamasak ham
bo‘ladi. Ikkinchi tomondan bu texnologiya obyektlar bilan
ishlaganda bir gancha cheklashlar qo‘yadi, ya’ni obyektlar kloni
olinmaydigan bo‘ladi va hokazo.

bygpep oomena (Clipboard)

Ma’lumotlarning eng oddiy almashishi bu Clipboard amalga
oshiriladi va uning yordamida quyidagi amallar bajariladi:
CorclDRAW dasturi boshga dasturlarga matnlarni va grafik
elementlarni olib o‘tishni bajaradi, agarda olib o‘tilayotgan das-
turda OLE texnologiyasi bilan ishlash imkonyati bo‘lsa.

PemaxTuponats (Edit) menyusi va asboblar panelida quyidagi
amallar berilgan; Komuposats (Copy), Bripeszats (Cut),
Bcrasuth (Paste).

«drag-and-drop» texnologiyasi

«drag-and-drop» texnologiyasi («olib borib tashlash») bir
dasturdan ikkinchisiga qo‘l yordamida ma’lumotlarni olib o‘tib,
quyidagi holatlarda amalga oshiriladi:

o Agarda vektor obyekti CorelDRAW dasturida bir hujjatdan
ikkinchisiga olib o‘tiladigan bo‘lsa.

o Agarda vektorli obyekt ishchi stolga olib o‘tiladigan bo‘lsa. Bu
yerda ishchi stoldan boshqa dasturga olib o‘tiladi, masalan,
CorelDRAW va Corel PHOTO-PAINT dasturlar orasidan grafik
ma’lumotlar olib o‘tiladi.
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Otkpoite (Open) va Umnopruposats (Import) buyruglari

2/
Do | = KarisesD () -] « @t e

BILEOMAHT SN ? Backup_of_ofwasnerve.cdr | Otmena

1 Warotoenerue nevaru ; pechati.cdr

1 POTOMPAPUN @ TEKSTILCOR
gotovii.bmp - .
i1 daemon311.zip B 1234V ===
@ S5cd ] ~$relBookPan2 doc

= 33|
File name: ofeasnere. cdr | v Preview
Files of type: [ Al File Formats >l FieVersion Version 9
Sort type: Defaut ~ Compression ratio:  32.2%
Last saved by: CorelDRAW 3 [pe)
Keywords: build 337
Notes: O¢nasnessee o pafiote Last saved n: Pycckui

Menyunuing ®aiin (File) va OtkpweiTh (Open...) buyrug‘i
boshga muharrirlar yordamida yaratilgan hujjatlarni ochadi, bu
yerda fayllar vektor formatli ya’ni masalan, EPS standart formatli
bo‘lishi kerak.

Yuqoridagi buyruq bajarilgandan keyin ekranda OTKpbITH
pucyHok (Open Drawing) mulogot oynasi chigadi, bu yerda faylni
gaysi jild va gaysi faylda ekanligini ko‘rsatish kerak. Bu yerda
IMpocmotp (Preview)dagi bayrogchani belgilash natijasida fayllar
ichidagi ma’lumotlar ko‘rsatiladi. Agarda faylni o‘qish mumkin
bo‘Imasa yoki boshqa sabablarga bog‘lab o‘gilmasa, ko‘rish oynasida
krest belgisi chigariladi.

Ko‘rish maydoni tagidan fayl hagida ma’lumotlar chiqariladi:

e Bepcusi nokymenTa (File Version) satrida hujjat xotirasida
saglangan dasturning versiyasi beriladi;

e Crenenb cxatusi (Compression ratio) satri faylning siqgilish
foizini ko‘rsatadi (vektor formati ixcham, o‘lchami kichik bo‘ladi,
shunga garamasdan dastur faylni avtomatik tarzda siqadi);

e CoxpaneH (Last saved by) satri dasturni versiyasi (platformasi)
va uning relesi (masalan, build 337) hagida ma’lumot beradi.

Knwouesbie cioBa (Keywords) va INpumeuanusa (Notes)
foydalanuvchiga kerakli faylni (agarda berilgan ma’lumot faylni
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saglagan paytda kiritilgan bo‘lsa) tez qidirib topib berishda yordam
beradi.

Coxpanutb ciou M ctpanuubl (Maintain layers and pages)
bayroqchasi hujjatdagi gatlamlar, sahifalar hagida konvertatsiya
gilishni ta’minlaydi, CDR dan boshga formatda bo‘ladi.

Menyuning ®aiin (File) va Umnoptuposath (Import...)
buyrug‘i Corel DRAW dasturining ochilgan joriy hujjatdagi hujjatni
import qilishni ta’minlaydi va u ikkita usul bilan bajariladi:

¢ Fayllar orasida bog‘lanish saqlanadi.

e Fayllar orasida bog‘lanish saglanmaydi.

Damka | 3 MWEB M |

Jii] jLi|
File name: 16AJPG ~| v Preview
Fies of lype: | All File Formats ~| [Fullmage ~! Oplions << !
Sothpe: | Bimap <

X E Link bitmap extemally
Image siee: 350X 263 Pixels , 16.7 Milion Colors (24-b%) = s

File format:  JPG - JPEG Bitmaps JPEG Compression AT
Notes: |7 | Egtracl embedded [CGy
~ Check for Watermark
[ Suppress fiter dislog

Umnoptuposare (Import) mulogot oynasining OTKpbITb
pucyHok (Open Drawing) oynasidan farqi qo‘shimcha funksiyalari
va mumkin bo‘lgan fayllar ro‘yxati katta bo‘ladi.

Pasmep u3obOpaxenust (Image size) satrida rastrli tasvirlarni
import gilganda pikseldagi o‘lchov birligi va ranglarning to‘qligi
bitlarda beriladi.

Pastdagi gatorlarda fayl formati va uning o‘zgachaligi, masalan,
sigish texnologiyasidan foydalanish va hokazo. Agarda fayl formati
eskilarini saglaydigan bo‘lsa, uning matnini, [lpumeuyanust (Notes)
maydonidan Kkiritamiz.

Cas3aTh ¢ (haitioM BBICOKOTO pa3pelieHus sl BbIBOAA MO
texHonoruu OPI (Link to high resolution file for output using
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OPI) bayroqchasi dasturning tez ishlashi uchun hujjatdagi fayl
versiyasini past imkoniyatda yozadi, qaytadan o‘qigan paytda
avvalgi holatiga gaytaradi.

[TpoBeputh «BoasiHoi 3Hak» (Check for Watermark)
bayroqchasi modulni ishga tushirishni ta’minlaydi, tasvir haqida
maxfiy ma’lumotlarni gidiradigan modullar ishga tushiriladi.

CBect MHOTroC/0iHbIE TOYeuHble n300paxeHusi (Combine
multi-layer bitmap) bayroqchasi ko‘p gatlamli tasvirlarni
konvertatsiya qiladi, masalan, Adobe Photoshop (PSD) formatidan
yoki Corel PHOTO-PAINT (CPT) formatidan oddiy bir gatlamli
qgiladi, Coxpanuth ciou u crpaHuibl (Maintain layers and pages)
bayroqchasi teskari, vektor obyektlarni gatlamlarga va sahifalarga
ajratib beradi.

[TpumenuTs pasmelieHHbit ipodpuwis [CO (Apply embedded
ICC profile) va U3sneun paszmeleHHbiii npoduab ICC (Extract
embedded ICC profile) bayrogchalari, OtkpsiTh pucyHok (Open
Drawing) mulogot oynasiga tegishli bo‘lib, joriy hujjatga import
gilingan faylga rang profillarini o‘rnatish yoki uni chigarib alohida
Image Color Matching (ICM) formatli faylga yozishni ta’minlaydi.
Dastur quyidagi formatli fayllarda ranglarning profillarini
joylashtiradi: CRT, CDR, JPEG, PICT u EPS.

Tasvirlarni ba’zi bir formatlarda joylashtirish uchun qo‘shim-
cha ma’lumotlar kerak bo‘ladi (masalan, PS, PRN yoki PCD
formatlari). Bu holda ekranda qo‘shimcha oyna paydo bo‘ladi. Agarda
import gilishda He BeiBoauTh auanorosoe okHO (wibTpa (Suppress
filter dialog) ga bayroqcha qo‘yilsa, import qilish ko‘rsatilgan
bo‘yicha bajariladi.

CorelDRAW dasturida import qilingan
= tasvirlarni o‘zgartirish uchun amallar baja-
pmm—— rilgandan keyin ekranga boshqacha kursor
chiqgariladi. Shu kursor yordamida tasvirni
hujjatning xohlagan joyiga joylashtirishgan
bo‘ladi. Bu obyekt ustida masshtablashni ham
bajarsa bo‘ladi. Agarda proporsional
masshtablamoqchi bo‘lsak, u holda kursor

Select area o crop

w5 wmp= = bilan sohani chizip ko‘rsatish kerak. -A.gar
e <Alt> tugmasi bilan masshtablashtirilsa
e s =] sokal proporsional bo‘lmaydi.

Newmage s 060 s Agarda masshtablash aniqlikni talab qilsa,

"™ uholda mulogot oynasidagi Umnoptuposats
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(Import) ro‘yxatidan foydalanishga to‘g‘ri keladi. Ro‘yxatda uchta
variant mavjud:

1. IMonnoe uszod6paxenue (Full Image) tasvir hech ganday
o‘zgarishsiz import qilinadi.

2. 3meHeHnue napameTpoB u3oOpaxeHusi (Resample) —
ekranga mulogot oyna chigariladi, bu oynaning o‘lchamini va import
qgilinayotgan obyekt imkoniyati (oynaning pastki qismi o‘zgartiriladi
va avvalgi fayllar o‘lchamlari baytlarda beriladi).

3. Kagpuposanue uzodpaxenusi (Crop) — ekranga muloqot oyna
chiqariladi, oynada qo‘l yordamida yoki mos bo‘lgan giymatlarni
o‘zgartirish bilan Csepxy (Top), Cnesa (Left), lIupuna (Width),
Bricora (Height) import gilinadigan yuzani chegaralash mumkin.

Umnopruposanue (Import) mulogot oynasidagi Cssi3b ¢
BHelIHUM u3o0paxeHuem (Link bitmap externally) bayroqgcha-
ning qo‘yilishi import qilishning o‘zgacha rejimi bo‘ladi, ya’ni
tasvirlar bir-biri bilan bog‘langan bo‘ladi (linked image).

O‘zaro bog'liq tasvirlar

Import qilinganda tasvirlarni boshga hujjatlarga olib o‘tishda
fayllar o‘lchami kattalashtiriladi, shu sababli tasvirni olib o‘tmay
fagat o‘tish joyini ko‘rsatish (ssilka) orgali ham bajariladi. Ssilkaga
go‘yilgan tasvirlar bog‘langan deyiladi (linked images).

Bu turdagi importdan foydalanishning yaxshi va yomon tomoni
bor.

Yaxshi tomoni: faylning o‘lchami kichik bo‘ladi, CorelDRAW
dasturiga murojaat gilmasdan parallel va mustaqil ishlatiladi, hujjatdagi
hamma tasvirlarga o‘zgartirish kiritish o‘rniga bir marta o‘zgartiriladi.

Yomon tomoni tasvirlarning joylashgan joyi noma’lum va
ssilkalar noto‘g‘ri bo‘lishi mumkin.

Bir-biri bilan bog‘langan tasvirlar bilan ishlash uchun Docker
turidagi panel ishlab chiqgilgan va uni JIucneruep cssizeit (Link
Manager) deb ataydi. Bu panel tasvirning barcha nugqtalari bilan
bog‘lanishni ko‘rsatadi.

ELMMW

Status Link Pags |
DAPOTOrPAPUN\I3E061.JPG Al

bl
J ~
< DAPOTOTPAPUNZIBMP a1
v :. \POTOMPAPUM\115098 JPG 2

£ =
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Har bir satrda tasvirlarning bog‘lanishi hagida ma’lumot bo‘ladi:
kichiklashtirilgan tasviri, fayl manzili va nomi, tasvir joylashgan beti.

Panelning pastki tomonida uchta tugma joylashgan:

1. Birinchi tugma tasvir bilan orasidagi bog‘lanishni uzadi va
bog‘lanish paneli satridan o‘chiriladi.

2. Ikkinchi tugma eskirgan tasvirlarni yangilash uchun ishlatiladi.

3. Uchinchi tugma ajratilgan tasvirni muharrirlash uchun ishlatiladi.

Bu uchinchi tugma yordamida chaqiriladigan kichkina dasturcha
CorelDRAW yordamida ishlatiladi va fayl kengaytmalari mosligiga
e’tibor beriladi. Shuni e’tiborga olgan holda, ekranga grafik dastur
emas, tasvirlarni ko‘rsatadigan dastur (masalan, ACDSee) yoki
brauzer — dasturlar (masalan, MI Explorer) chagqiriladi.

O‘ng tomondagi pastdagi tugma bog‘lanishni qo‘l yordamida
boshqarish uchun ishlatiladi, agarda tasvir ko‘rsatilgan jilddan
tashqarida qolsa, holat satrida gizil belgi bilan ko‘rsatiladi. Alogani
gaytadan bog‘lash uchun ko‘rsatkich holat satriga olib borib
sichqonchaning o‘ng tomoni bosiladi va ochilgan menyudan
BoccraHoBuTh pazopBaHHYIO ¢Bs3b (Fix Broken Link) tanlanadi.
Bu mulogot oynasini chiqarib, Onpeaeautb MeCTONMONOXEHUE
toueyHoro uzodpaxeHusi (Locate External Bitmap)ni tanlash
kerak. Agarda xotiradan o‘chirilmagan bo‘lsa, u holda tasvir
manzilini o‘zgartirib qo‘yish kifoya.

Tasvirlarni eskportlash.

Nanka: | 73 Mou a0KyMeEHTbI v @ |® ekl ER- Export |
Tl Max Payne Savegames . Cancel
I Mou pucyHxu
|
File name: [Graphic1 bmp ZI Compression pe:
Files of type: ';WBMP -Windows Bitmap 1 | |Uncompressed e
Soitlype: | Defaul v B s
M2 [ Embed |EC profile
| [ No white spaces, special characters
| Suppress fiker dialog
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Tasvirlarni boshga formatga eksport qilish uchun quyidagi
amallarni bajarish kerak: Menyuning ®aiin (File)dan Dxcrnop-
TupoBath (Export...) tanlanadi va u ekranga oynani chagqiradi.

Tonbko BbimeneHHbIE 00BbeKThI (Selected only) bayroqchasi
qo‘yilsa, fagat hujjatdagi belgilangan obyektlarni eksport qiladi.

CoprupoBka turnosB ¢aitios (Sort type) ro‘yxati Tunsl ¢aiiion
(Files of type) ro‘yxatini tartibga soladi: [To ymonuanuto (Default),
[To pacummpenuio (Extension), [To onucanuto (Description), B
nopsiike ucnoab3zoBaHusi (Most Resently Used), CHauana
BekTOpHble (Vector), CHauana ToyeuHsle (Bitmap), CHavana
TekcToBble (Text), CHauana aHMMUpOBaHHBIE (Animation).

be3 npobenoB va cnenmanbHbix cMMBO0B (No white spaces,
special characters) bayroqchasi fayl nomidagi bo‘sh joylarni tagi
chizilgan yozuvda beradi, maxsus belgilarni Web sahifa fayllarida
ishlatiladigan belgilarga almashtiradi.

Fayllar formati ro‘yxatidan mumkin bo‘lgan bitta format
tanlanadi va DkcnopruposaTth (Export) tugmasi bosilishi bilan
ekranda mulogot oyna paydo bo‘ladi, bu oynada CDR formatidan
boshga formatga o‘tganda saglanadigan ma’lumotlar beriladi.

2.9. Rastrli tasvirlar bilan ishlash va o‘zgartirish

Corel DRAW dasturi vektor grafikasi dasturlari ichida eng
ko‘zga ko‘ringan bo‘lib, u shu sohadagi barcha imkoniyatlarga ega
muharrirlardan biri hisoblanadi.

Rastrli tasvirlarning parametrlarini o‘zgartirish.

Image size ) i
Width: 34 |34 a; [ 100 = % | pivels |
Height: 99 = {100 =%

Resolution ‘
Horizontal: g 10 %11 dpi [ [dentical values
Vertical: 6 :10 -:-i dpi

Original image size: 936 bytes v R

: : |v Maintai t ratio
New image size: 936 bytes v Main afn as.pfec : :
Maintain original size

[ ok | cocel | Hep Reset
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Rastrli tasvirlarni asosiy parametrlari geometrik o‘lchovlarga
o‘tkazish bo‘lib hisoblanadi. Bu parametrlarni CoreIDRAW muhi-
tida o‘zgartirishda Toueuynbie uzo6paxenus (Bitmaps) menyusidagi
N3meHeHue mapamerpoB uzobOpaxeHusi (Resample...) dan
foydalaniladi.

Pasmep uzobpaxcHust (Image size) maydonidagi (mose
Width)da eni bo‘yicha giymati kiritiladi va (nmose Height) balandligi
bo‘yicha giymatini kiritish kerak.

Pazpemienune (Resolution) maydonida (mone Horizontal)
gorizontal bo‘yicha va (rmose Vertical) vertikal bo‘yicha imkoniyatlar
beriladi. Qo‘shni maydondagi Uaentuunsie 3naueHust (Identical
values) ga bayrogcha go‘yilsa, u holda bir xil bo‘ladi, aks holda,
har xil giymatlar bo‘ladi.

Oynani pastki gismida fayllar o‘lchamlari beriladi (cTpoka
Original image size) o‘zgartirilmagan holda va (ctpoka New image
size) parametrlari o‘zgartirilgandan keyingi Criaaxusanue (Anti-
alias) bayroqgchasi chegaralardagi har xil notekisliklarni yo‘qotadi.

Vektorli tasvirlarni rastrli tasvirlarga konvertatsiya gqilish

Corel DRAW dasturi vektor tasvirlarni rastrli tasvirlarga o‘tkazish
imkoniyatiga ega.

Convert to Bitmap B x|

L o s cale (B-bi —
Resolution: |2[]U dpi R =S

v Anti-aliazing arice

[ Dithered Help

| Transparent Background

v Apply ICC Profile
Projected uncompressed file size: 311 354 bytes

Buning uchun obyekt tanlanib, ToueuHbic HM300paxeHUsI
(Bitmaps) menyusidan KoHBepTupoBaTth B TOUCYHOEC M300paKCHUEC
(Convert to Bitmap...) buyrug‘i bajariladi. Ekranga chiqgarilgan
mulogot oynasiga rastrli tasvir parametrlarining, ya’ni imkoniyatini
va rang to‘qligini berishi kerak.
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Paspemecnue (Resolution) maydonidagi ro‘yxatdan xohlagan
bittasini tanlash kerak (72, 96, 150, 200 u 300 dpi) yoki o‘zi-
mizning parametrlarni 60 dan 1000 dpi gacha diapazondan
berishimiz kerak.

Lset (Color) da oltita rang va rejim modellari berilgan: YepHo-
ocabnii wrpux (1-bit) (Black and White), 16 useros (4-bit)
(Colors 16), I'pagaumu ceporo (8-bit) (Grayscale), Uumekcu-
poBaHHBINM 1BeT (8-bit) (Paletted), Llser momeu RGB (24-bit)
(RGB Color), et momenu CMYK (32-bit) (CMYK Color).

Wwmvmramus (Dithered) bayrogchasini o‘rnatish katta hajmdagi
ranglar gammasidan kamroq gammani konvertizatsiya gilganda
yetishmaganini mavjud ranglardan olib qo‘yiladi.

IIpozpaunsiii ¢or (Transparent Background) bayrogchasi
obyekt joylashmagan sohalarni markirovkalaydi.

HUcnonw3oBats nsetooit mpodunsb (Use Color Profile)
bayroqchasi joriy bo‘lgan tashqi qurilmalardagi ranglar profilini
hisobga oladi, masalan, rangli printer.

CrnaxmBaHme (Anti-aliasing) bayroqchasida tasvirning
chegaralarini, rangini yumshatish uchun ishlatiladi.

Rastrli tasvirlarni boshqa ranglar modellariga o‘tkazish

Rastrli tasvirlar quyida berilgan boshqga rangli modellarga yoki
rejimlarga o‘tkazilishi mumkin:

e Og-qgora shtrixli tasvirlarga;

o Kulrang gradatsiyadagi tasvirda;

e Duplcks tasvirda;

e RGB, CMYK vyoki LABning to‘liq turlariga:

¢ Indeksirlangan tasvirlarga (paletted).

Boshqa turga o‘tkazganga (konvertizatsiya gilganda) tasvirlarning
ba’zi bir gismlarini yo‘qolishiga olib keladi, bu esa, ranglari ko‘p
bo‘lgan tasvirlarni kamroq bo‘lganlarga o‘tkazganda seziladi,
masalan, RGB dan CMYK ga o‘tkazilganda. Qaytadan o‘tkazilganda
yo‘qotilganlari tiklanmaydi.

Oq-qora shtrixlangan tasvirlarga konvertizatsiya qilish
Toueunnie uzobpaxenmsi / Konseptuposars B (Bitmaps /
Convert To) menyusidagi Yepuo-06enrrit mtpux (Black and
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Convert to 1 Bit i x|

Conversion Line &t ¥
Thieshold: | ™ | v N RE
| Preview Reset | 0K | Cancel | Hep |

White) (1-bit) buyrug‘i ekranga quyidagilarni chigaradi. Konep-
TUpoBaTh B 1-6uToBOoe M300paxeHue (Convert to 1 Bit).

Tun kousepTupoBanusi (Conversion) tanlanganda paramertlar
maydoni o‘zgaradi.

o [lITpuxoBoe mn3obpaxenue (Line Art) varianti tasvirning qaysi
giymatlari oq rangga, qaysilari qora rangga o‘tishini ta’minlaydi.

e Umuranusi co cayuyaitHbiM pa3zopocom (Error Diffusion)
varianti. UMutaumsi ¢ nomoiubio obpasuon (Ordered), Jarvis,
Stucki, Floyd-Steinberg, Cardinality-Distribution ton bosqich-
larini har xil usullarini taklif qiladi. Parametr hisobida UHTeH-
cuBHOCTh (Intensity) maydonidan kiritilgan quymatlar ehtimoliy
darajasini beradi.

¢ Halftone (PactpoBoe m300paxkeHue) varianti qora ranglar
uchun poligrafik rastrlarni eslatadigan tasvirlarni olishni ta’minlaydi.

Kulrang gradatsiyadagi tasvirga konversiyalash

Xohlagan nugqtali tasvirlarni kulrang gradatsiya ko‘rinishida
tasvirlasa bo‘ladi, buning uchun tasvirni ajratish kerak va quyidagilar
bajariladi: menyuning ToueuHble nzoopaxeHusi/ KoHBepTUPOBAThH
B (Bitmaps/Convert To) va I'panaumu ceporo (8-bit) (Grayscale)
amallari bajariladi.

Bu jarayon hech ganaga qo‘shimchalarni talab gilmaydi. Natijada
rastrli tasvirlar paydo bo‘ladi, har bir piksel sakkizta bit bilan
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beriladi, buni 256 talik qilib olsa ham bo‘ladi: bunda 0 gora,
255 — bo‘lsa, oq rangni beradi.

Dupleks tasvirlarni konversiyalash

JymaekcHoe n3obpakeHue (duotone) — bu monoxrom tonli
tasvirni ikkita (uchta, to‘rtta) bosmaga chigarishning turi bo‘lib
hisoblanadi. Bunda asosiy rang qora bo‘yoq bo‘ladi, golgan bo‘yoglar
esa — och (kul, och-malla, havo yoki yashil). Bosmaga
chigarishning bu turi ton diapazonini kengaytirish uchun va bitta
rang ishlatilganda yetishmagan tonlarni konversiya qiladi.

Tasvirni yaratish uchun menyuning ToyeuHble n300paxkeHHs1/
Kougeptuposars B (Bitmaps/Convert To) va Hyruiekc (8-bit)
(Duotone) buyrug‘i bilan amalga oshiriladi. Ekranda mulogot oynasi
ko‘rinadi.

RGB, CMYK u Lab rang modellarini konversiyalash

Rastrli tasvirlar RGB, Lab va CMYK modellariga konvertizatsiya
gilinadi. Bu turlar kompyuter texnologiyasida, ekranning grafika
bilan bog‘liq bo‘lgan joylarida ishlatiladi.

Belgilangan obyektni konvertizatsiya qilish uchun quyidagilarni
bajarish kerak: IIBeT momenu buyrug'i RGB (24-bit), (RGB Color)
(24-bit), Ieer momenu Lab (Lab Color) yoki IlBeT mMoaenu
CMYK (32-bit) (CMYK Color) buyrug‘lari menyuning
Toueunsle nso6paxkenus/KouseptupoBath B (Bitmaps/Convert
To)da joylashgan.

CMYK turini konvertirlash katta ahamiyatga ega, sababi u
qurilmalarga bog‘liq bo‘ladi. Bir xil tasvirni har xil qurilmalarga
konvertirlaganda dastur har xil natija ko‘rsatadi.

Intensiv rangli tasvirlarni konversiyalash

Indekslangan rangli tasvirlar bir kanalli 8-bitli tasvirlardan
256 ta ranglardan tashkil topadi. Bunday tasvirlar fayllarni kichkina
o‘lchamlari bo‘lgan tasvirlarda ishlatiladi. Avvallari bu tasvirlar
imkoniyatlari cheklangan videoadapterlardan foydalanilgan edi,
endilikda Internetlarda kengroq foydalanilmoqgda.

Menyuning TodeuHoe wu3o0Opaxenue/Pexxnm (Bitmap/Mode)
sidan MupgexcupoBanHsbiii (8-bit) (Paletted)da buyrug‘i tanlansa,
mulogot oynasidagi KoHBepTupoBaTh B MHACKCUPOBAHHBIC 1IBETA
(Convert to Paletted)ni bajarishi kerak.
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2.10. Ko‘p sahifali hujjatlar bilan ishlash

CorelDRAW dasturi verstkali dasturlarga tegishli emas, verstkali
dasturlarda ko‘p sahifali hujjatlar bilan ishlash imkoniyatlari mavjud.
Coreldraw dasturida ko‘p sahifali hujjatlar bilan ishlanadi va unda
999 sahifali hujjatlar bilan ishlash imkoniyati bor. Qoplagan
funksiyalarining yetishmasligi verskachining ishini yengillashtiradi,
katta hajmdagi hujjatlarni bir nechta sahifaga joylashtiradi, bunday
hujjatlarga — reklama bukletlari, kichkina hajmli hujjat, prays-listlar,
kichkina broshuralar va hokazolar tayyorlanadi.

Sahifa parametrlarini qo‘yish

Sahifalarni qo‘yishning asosiy buyruglari Komnonoska (Layout)
menyusi va IlapameTtpbl ctpanuubl (Page Setup...) buyrug‘i
yordamida amalga oshiriladi, natijada ekranga mulogot oynasi
ITapamerpbr (Options)ning @opmar (Size) chigariladi.

options x|
> Worapace Bws
=I-Document
General ¢ Normal Paper Labels
-1-Page
Size * Portrait Landscape
wava P A4 v
Label FE
Background Width 2100 e | millmeters ¥
+ Guidelines 3 =
Grid Height: [?37,0 3: millrmeters
Rulers
Styles Resize current page only
Save ,
1 Publish To The Web
+ Global Bleed: 40«0 5‘ millmeters
Set From Printer
Add Page Frame |
Cocsl |t

Mulogot oynasining yuqori gismida sahifa turini aniglovchi
o‘tkazgichlari berilgan. Tpaguumonnsie (popmatsl (Normal Paper)
va Otuketku (Labels). Paper (Popmat 6ymaru) ro‘yxatida jahonda
ishlatiladigan formatlar yig‘indisi berilgan. Agarda hech bir format
to‘g‘ri kelmasa, u holda Wupuna (Width) va BeicoTa
(Height)lardan foydalanib kerakli parametrlarni kiritsa bo‘ladi.
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Ro‘yxatning yonida o‘lchov birligi berilgan CoxpaHuTth
napameTpbl opmara ctpaHuibl (Save Custom Page) tugmasi
tayyor bo‘lgan formatli sahifani xotirada saglaydi.

PaspewieHue (Resolution) maydonida ro‘yxatdan bitta variant
tanlanadi yoki xohlagan mumkin bo‘lgan son qiymati Kiritiladi.

WUcnonb3zoBath mapaMeTpbl npuHTepa (Set From Printer)
tugmasi sahifada berilgan parametrlarni joriy printerga o‘rnatadi.

[TapameTpsl (Options) mulogot oynasini chap tomonidagi
satrdan chagqiriladigan KomnonoBka (Layout) bo‘limi sahifalarni
joylashtirishini bir nechta variantlarini beradi, o‘z navbatida bu
hujjatning markeriga ta’sir qiladi.

KommnonoBka (Layout) ro‘yxatida markerlarni oltita varianti
berilgan (variantlar ko‘rish oynasidan ko‘rsatib turiladi):

PasBopor (Facing pages) bayroqchasi ekranga ikkita go‘shni
sahifalarni joylashtiradi.

Havyarp c¢ (Start on) punkti Pa3zsopor (Facing pages)ga
bayrogcha qo‘yganda joriy bo‘ladi va qaysi betdan aylantirishni
boshlashni bildiradi (sieBoii (Left Side) chapdan yoki (Right Side)
o‘ngdan).

®on (Background) hamma sahifalar uchun umumiy fonni
aniglaydi. Bu fon zalivka yoki nugqtali tasvir bo‘lishi ham mumkin.
Ulardan bittasini tanlash imkoniyati bor, buning uchun o‘tkaz-
gichning bittasini — CrutowrHas 3anuBka (Solid) yoki ToueuHoe
u3zobpaxenue (Bitmap)ni tanlash kerak.

Sahifa qo‘shish

Hujjat boshida o‘zi bitta sahifa bo‘ladi.Yangi sahifalar qo‘shish
uchun berilgan ikkita «+» tugmalardan bittasi tanlanadi, birinchisi
bosilishi bilan joriy sahifa oldiga yangi sahifa qo‘yiladi, ikkinchisi
bosilsa, joriy sahifadan keyin yangi sahifa qo‘yiladi.

Shu bilan birga bir nechta sahifalarni qo‘shsa ham bo‘ladi, buning
uchun menyuning KomnonoBka (Layout) va JIo0aBUTb CTpaHULLY
(Insert Page...)ni bosish kerak va

ekranga mulogot oynasi chigariladi. s x|
J106aBuTh ... crpanu (Insert ... '™t ° = e

pages) maydonida ldan 998 gacha .Z‘f” Page: [1 =
giymat beriladi. Ishchi oynani pastki °
gismida sahifalar raqamlari bilan
beriladi va xohlagan sahifaga tegishli tal
ragamni bosish orqali o‘tiladi.
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Jlo (Before) va IMocie (After) lar joriy sahifadan oldin yoki
keyin qo‘yiladigan sahifalar ragamlari Crtpanuna (Page) da beriladi.
Bitta sahifadan ikkinchisiga o‘tish sahifalarni boshgarish bloki
yordamida yoki Kommonoska (Layout) menyusidagi Ilepeiitu K
crpanune (Go to Page...) buyrug‘i yordamida o‘tiladi. Bunda
paydo bo‘lgan oynaga o‘tishi kerak bo‘lgan sahifa ragami kiritiladi.

Sahifalarni o‘chirish

Keraksiz sahifalarni albatta o‘chirib tashlash kerak. Buning
uchun menyuning Kommnonoska (Layout) dan, Yapanaurte
crpanuny (Delete Page...) buyrug‘i tanlanadi va namoyon bo‘lgan
oynada quyidagi amallar bajariladi.

Yianurs crpanuny (Delete page) maydoni o‘chirilishi
kerak bo‘lgan sahifa raqamini kiritish kerak. ITo crpanuny ...
BkJrounteabHo (Through to page ... Inclusive) maydonidagi
bayroqcha belgilangan bo‘lsa, o‘chirilishi kerak bo‘lgan sahifalarning
oxirgi ragami kiritiladi.

Sahifaga nom berish

CorelDRAW dasturining sahifalariga nom berish o‘zgacha
xarakterga cga bo‘ladi. Bu protsedura matn muharrirlari va verstka
dasturlaridagi sahifalarga nom berishdan farq giladi. Sahifalarga nom
berish hujjat bilan ishlashni osonlashtiradi.

Kommonoska (Layout) menyuning IlepenmeHOBaTh CTpaHULLy
(Rename Page...) buyrug‘i yordamida sahifalarni nomlasa bo‘ladi.

Mulogot oynasidan kiritilgan nom mos sahifaning vkladkasiga
chiqgariladi.

Property Bar panelidagi sahifalar paramertlari

Agarda hech ganaga obyekt tanlanmagan bo‘lsa, CsoiicTBa
(Property Bar) asboblar panecliga quyidagi parametrlar chigariladi
va ularni o‘zgartirish imkoniyati bo‘ladi.

T S — o
T 2100m> = anm | 65 it 59 19 -
e ¥ 1@ 2570 mva || B B[S | Unke|mlimeters v | 254 mm S igl2 2| 4 X0 Hd|on) R B

Birinchi ro‘yxatdan sahifa formati tanlanadi, keyingi satrdan
sahifa o‘lchamlari beriladi, ikkita tugma, sahifa oriyentatsiyasini
beradi va ikkita birning ustida ikkinchisi joylashgan, yuqorisi hamma
sahifa parametrlarini, pastkisi fagat joriy sahifa parametrlarini
o‘zgartiradi.
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Bu xossadan shuni ko‘rish mumkinki CorelDRAW dasturida
sahifalar o‘lchamlari, oriyentatsiyalari har xil bo‘lishini ko‘rsatadi.

III. PHOTOSHOPDA ISHLASHNING ASOSLARI

3.1. Asosiy tushunchalar

Photoshop dasturi — grafik muharriri bo‘lib, rastr (nugqtali)
tasvirlar bilan ishlashga mo‘ljallangan (rastr formatli grafik fayllar,
fotografiya, tasvirlar va hokazo).

Ekrandagi piktogramma asboblarini faollashtirish uchun
sichqoncha bilan chertish kifoya. Piktogrammalarni yon tomonida
kichkina yo‘nalish joylashgan bo‘ladi. Agarda yo‘nalishga chertilsa,
palitra ochiladi va bizlar shu guruhga kiruvchi asboblarni tanlash
imkoniyatiga ega bo‘lamiz.

Asboblar bilan ishlashning yana bir qulay to-

m monlaridan biri klaviatura yordamida ekranga chagirish
. (har bir asbobga mos keluvchi harfni yodda saglab
. et qoling). Agarda siz tugmalar kombinatsiyasini yoddan
B chigargan bo‘lsangiz, u holda kerakli bo‘lgan asbob
&S, 20 . S d .

2 5 ustida bir necha soniya sichqoncha yordamida ko‘rsatib
fjg tursangiz, sizga tugmalar kombinatsiyasi haqida
AT ma’lumot beradi (3.1-rasm). Guruhdagi asboblarni
2\ ketma-ket joylashganiday qilib chagirish uchun Shift
,;_ : va mos tugma bosiladi. Yoki Alt tugmasi bosilgan holda

mos asbobni sichqoncha bilan ko‘rsatish orgali amalga
oshiriladi.

Opsia panelida har bir asbobga mos holda o‘zining
parametrlari beriladi (masalan, aralashtirish rejimi,
tiniglilik giymati). Opsiya paneli ekranning yugori gismida
3.1-rasm. joylashgan bo‘ladi. (Bu hagda «Opsiya paneli» gismida
Asboblar  kengroq berilgan.) — 3.2-rasmga qarang. Opsiya

paneli.  panelidagi parametrlar ganday asbob tanlanishiga garab
o‘zgaradi.

-
| m
1 El

=l

— |

i.;. - ' [~ Auto Select Layer I Show Bounding Box -k do |2 2

| Automatically select a layer by clicking on a visible pixel |

3.2-rasm . Opsiya paneli.
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Photoshop dasturining panellari
Asboblar paneli

Opsiyalar panelini o‘'ng tomonida joriy asbobning piktogram-
masi joylashgan. Agarda piktogramma yonidagi yo‘nalishga chertilsa,
menyucha paydo bo‘ladi, bu yerdan boshqa asbobni tanlash
imkoniyatiga ega bo‘lamiz. Bu yerdagi menyucha ro‘yxatini
muharrirlasa bo‘ladi, ya’ni kam foydalaniladigan asboblarni olib
tashlasa va ko‘p foydalanadiganlarini joylashtirsa bo‘ladi. Har bir

asbobni opsiyasi o‘zgarmay

= saglanib, u o‘zgartirilmagan va
=] gaytadan tiklanmagan bo‘ladi.

jg New oo Prese Yuklash, qo‘shish va saqglash
amallari maxsus tugmalar yor-

/" Hasing EBrush 21 pbais
W Maatic Lasso 24 picels

LA Fit ith Ecbbles Pattern

T Herizontal Type Myriad Roensn 24 ot

I~ Corrant Toel Orly

v Scd By Tool
v Show All Tocl Presats
Show Cutent Tool Prasets

|
T Crep S inch x d inch 300 45 i |
|
|
|
|

damida yoki panel menyuchasi
yordamida bajariladi (3.3-rasm).

v%aog Hamma asboblar uchun ixti-

=T yoriy opsiya tanlanishi uchun

:::’:‘: | Reset All Tools (hamma asbob-

Reset ToolPessts larni avvalgi holiga qaytarish)

o ot buyrug‘i yoki Edit >

e Preferences > General

S s (ITpaBka > YcTaHOBKU >

= O6ume) oynasidagi Reset All

3.3-rasm. Asbobni tanlash paneli. Tools ni sichqoncha bilan

bosing.

Edit > Preferences > Display& Cursors (I1paBka > YcraHoBku >
OrobpaxkeHue&kypcopnl) oynasidan kursorning asboblar paneli
piktogrammasi ganday ko‘rinishda bo‘lishini tanlash mumkin.

Agarda asbobdan noto‘g‘ri foydalanilsa, «0» taqiqlash
piktogrammasi chiqariladi. Sichqoncha yordamida joriy oynaga
chertish orgali nima uchun joriy asbobdan foydalanib bo‘Imasligi
hagida ma’lumot olasiz.

3.4-rasmda Photoshop dasturining asboblar paneli berilgan.
Guruhga kiradigan asboblar yonida asboblarni tugmalar yordamida
chagqirish tugmalari («ropsiyasi kyiaBuina») berilgan.

Bu amal quyidagicha bajariladi, Shift tugmasi bilan birgalikda
mos ko‘rsatilgan tugma bosiladi, bu holda asboblar panelida
joylashgan tartib bo‘yicha ketma-ket chagiriladi (3.5—3.21-rasmlar).
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3.6-rasm. Xohlagan

3.4-rasm. 3.5-rasm. B S
Asboblar Geometrik shaklga Shaxliga ;_Sasg g;ll
paneli. ega sohani ajratuvchi ajratuvchi asboblar

asboblar palitrasi. palitrasi.

3.7-rasm. 3.8-rasm. 3.9-rasm. O‘chirish
Tasvirning Klonlashtirish asboblar palitrasi.
defektlarini asboblar palitrasi.
o‘chiruvchi

asboblar

paneli.
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3.10-rasm. Tasvir 3.11-rasm. To'g'ri chiziq bo‘yicha

chegaralari anigligini ajratish asboblar palitrasi.
nazorat qiluvchi

asboblar palitrasi.

3.12.-rasm. 3.13-rasm. 3. 14-rasm.
Konturlar bilan Eslatmalarni Bo‘laklar bilan ishlovchi
ishlovchi asboblar  yaratuvchi asboblar asboblarning palitrasi.
palitrasi. palitrasi.
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3.15-rasm. 3.16-rasm. Tasvirni 3.17-rasm. Zalivkali
Rasm yaratishdagi ketma-ketlik asboblar palitrasi.
chizuvchi (tarixi) bilan ishlovchi
asboblarning asboblarning palitrasi.
palitrasi.

3.18-rasm. Tasvirlarni 3.19-rasm. Matnlar
oqartiruvchi va bilan ishlovchi
goraytiruvchi asboblarning paneli.

asboblarning paneli.
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3.20-rasm. Obyektni 3.21-rasm. Ranglar, burchaklar
vektorli asboblar bilan va masofalar bilan ishlovchi
chizish paneli. asboblarning paneli.

%) 6031.tif @ 100% (RGBif)

it B B B0 T

3.22-rasm. Notes asbobi yordamida yaratilgan eslatma.
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£ Adobe Photoshop - [File Browser] N [=] E3

) File Edit Image Layer Select Fiter View Window Help =8| x|
J J o IE— ‘ Feather: [0 px [ Anti slaced l Style: [Normal =l wid

x) I Moit komneioreph (E:)\Photos\Lo_res ll @

-

Filename 6001.TIF
Date Created 121095 10:23:23
Date Modified 12.10.95 10:23:22
Image Format TIFF
Width 450

Q

3.23-rasm. Palitrani saglash uchun opsiya panelidagi maydon (oblast).

| [EdN

‘Mode [Normal  [¥]  Opacity: [100% [¥] ‘ Flow: [503%_[* ] \/{\ |

3.24-rasm. Brush asbobi uchun opsiya paneli.

Style: INormaI EI

I 03 I jﬁc.l e } Feather: |0 px I” Anti-aliasad

3.25-rasm. Rectangular Marquee asbobi uchun opsiya paneli.

Notes (IIpumeuanusi) asbobi yordamida (3.13-rasmda
ko‘satilgan), Acrobat dasturiga mos keladigan formatga ega bo‘lgan
matnli eslatmalar yoritiladi. Bu eslatmalar bosmadan chiqarilmaydi.
Ular fagat mijozga, bosmaxonaga va hokazo kerakli bo‘lgan
ma’lumotlarni yetkazish uchun xizmat qiladi. Eslatma belgisiga
chertish orqali paydo bo‘lgan oynada (3.22-rasm) berilgan eslatma
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matnini olasiz (bu matnni gayta muharrirlash mumkin). Audio
eslatmalar Audio Annotation (ovozli eslatmalar) yordamida
yoritiladi (3.13-rasmda berilgan).

Opsiya paneli

Opsiya paneli har bir asbob uchun parametrlar giymatini
tanlash uchun ishlatiladi (masalan, tiniglilik ko‘rsatgichi, so‘nish
nugtasining boshlanishi, aralashtirish rejimi) — 3.24-rasmga garang.
Opsiya panelining o‘ng tomonidagi soha palitralari saglash xizmatini
bajaradi (3.23-rasm). Tanlangan asboblar turiga garab panelga
chigadigan parametrlari o‘zgarib turadi (3.24—3.29-rasmlar). Siz
kiritgan, tanlagan giymatlarni o‘zgartirmaguningizcha saglanadi.
Palitrani, opsiya panelini ekranning xohlagan joyiga qo‘yishimiz
mumkin.

‘I | ’ 1% ]+ ‘ Mode: [Normal T=] opacity: [loos [»] ‘

3.26-rasm. Gradient asbobining panel opsiyasi.

I auto Add/Delets || ]

IEEE T Fae e oNGE

3.27-rasm. Pen asbobining panel opsiyasi.

JEMcmold $coooNG-|

3.28-rasm. Rectangle asbobining panel opsiyasi.

I ¥ X IHeretica ZI lMediurn ;I :rl|2 pt ;] ay lSharp E

3.29-rasm. Type asbobining panel opsiyasi.

Uchib chiquvchi yordamlar (BcmibiBaomye moacKasku)

Kursorni asboblar piktogrammasidagi xohlagan asbobga olib
borib asbobning nomini bilsak bo‘ladi va uni joriy giladigan
tugmalarni ham ko‘rish mumkin (3.1-rasmda berilgan). Mos
ravishda palitra funksiyalari hagida ham yoki opsiya qiymatlari hagida
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ma’lumot olishingiz mumkin (3.2-rasmga qarang).Uchib chiquvchi
ma’lumotni ko‘rsatishni ishga tushirish uchun Edit > Preferences
> General (IlpaBka > YcraHoBku > OO6mue) oynasidagi Show
Tool Tips (IToka3seBaTh BCIUIBIBAIONIME TOACKa3kM)ni belgilash
kerak.

Asbob (T'opsumne) tugmalari

3.1-jadvalda eng ko‘p foydalaniladigan buyruqlar va ularga mos
keladigan tugmalar berilgan.

3. 1-jadval
Buyruq Tugmalari
Joriy bo‘lgan barcha palitralarni Tab
va asboblar panelini ko‘rsatish / yo‘qotish
Uchib chiquvchi menyuning bog‘langan Shift + asbobini joriy qgilish
asboblarini ketma-ket chagqirish tugmasi yoki Alt tugmasi

bosilgan holda asbobning
piktogrammasiga sichqoncha
yordamida chertish

Joriy gatlam yoki asbobning Shift+«plus» yoki
aralashtirish rejimiga o‘tish Shift+«minus»

Photoshop dasturida ishchi oynaning ko‘rinishi

Photoshop dasturining ishchi oynasi 3.30-rasmda berilgan.

Shichgoncha yordamida chertilsa qo‘llanmalar bilan ishlovchi
menyu chaqiriladi. Bu menyu quyidagi buyruglardan iborat:
Restore (BoccranoButhb) Qayta tiklash, Move (IlepemecTUTh)
Siljitish, Size (Pazmep) O‘lcham, Minimize (CsepHyTtbh) Kichkina
qilish, Maximize (Pa3pepnytb) Katta qilish va Close (3akpbITh)
Yopish. Agarda Edit tugmasi bosilsa, hujjatlar bilan ishlovchi menyu
chagiriladi. Hujjatlar menyusi quyidagi asosiy buyruglardan iborat:
Restore (Boccranosuthb) Qayta tiklash, Move (IlepemecTUTh)
Siljitish, Size (Pasmep) O‘lcham, Minimize (CsepHyTb) Kichkina
qilish, Maximize (Pa3epnyrb) Katta qilish, Close (3akphITh)
Yopish va Next (Caenyronmii) Kelasi.

Nomer panelining xohlagan asbobi sichqoncha bilan chertilsa,
mulogot oynasiga, kichkina menyuchaga va buyruglarga ruxsat
olinadi.
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Tanlangan asbobning parametrlarini aniglash uchun opsiya
panelidan foydalanamiz.

Qo‘llanma oynasini yig‘ish uchun Minimize bosiladi va natijada
piktogramma masalalar paneliga joylashtiriladi. Oynaning avvalgi
holiga qaytarish uchun shu belgiga sichqoncha bilan chertish kifoya.

Maximize (Pa3BepHyTtb) yoki hujjatdagi tugmalarni bosish
esa oyna o‘lchamlarini imkoniyat boricha kattalashtiradi. Agarda
oynani avvalgi holatiga gaytarmoqchi bo‘lsangiz, Restore tugmasidan
foydalaning. Oyna avvalgi holiga gaytgandan keyin Restore tugmasi
Maximize tugmasiga aylanib qoladi.

Yopish tugmasi qo‘llanmani yopish uchun xizmat qiladi.

Sarlavha tugmasi tasvirning nomi, masshtabi, joriy gatlam nomi
yoki Background (®Pon) identifikatori va tasvirlanish rejimi hagida
ma’lumot beradi.

Hujjatni yig‘ishtirib qo‘yishsa bo‘ladi, buning uchun Minimize
tugmasidan foydalaniladi, natijada hujjat piktogrammasi qo‘llanma
oynasini chap tomonning pastki gismiga joylashtiradi. Agarda Restore
(BoccranoButs) tugmasi sichqoncha bilan chertilsa oynani avvalgi
holiga qaytariladi.

Agarda tasvirni yoki palitrani yopmoqchi bo‘lsangiz piktogram-
maga cherting.

Oynadagi chizigni na-
ﬁﬁ' i‘ _M' Lo 5660 e Yoo seam b o) moyon qilish uchun View
: > Show Rulers (Buag >
[Toka3zarb JMHeiku) buy-
ruglaridan foydalaniladi.
Kursor holati marker
yordamida mos chizigcha-
larni ko‘rsatadi. Chizigcha
uchun o‘lchov birliklari
Edit > Preferences >
Units&Rulers ([TpaBka >
YcraHoBku > EAMHULIBI W3-
MepeHus&InHeiku) buy-
ruglari yordamida tanlanadi.

Dastur 13 ta palitraga
ega, ularni ekran bo‘yicha
siljitish guruhlanishni
3.30-rasm. Photoshop o‘zgartirishi yoki sukut (1o
ekranining ko‘rinishi. yMmoauanuio) saqlagan

SUBSsE
A2ORN NAY

et PP v 10 P TVt PP OO

S

%
FNi/A

T e s P O

00% |[[ Dac 47IM/4TIK P Draw selection from center or aubtri
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holda qgabul qilishi mumkin. Palitra guruhidagi palitra nomiga
(vkladkaga) chertilsa, u berilgan stekning eng yuqorisiga
joylashtiriladi.

Asboblar panelini yoki joriy bo‘lgan palitralarini ko‘rsatish/
yo‘qotish uchun Tab tugmasini bosing.

Holat satrida quyidagi paramertlarning qiymatlari ko‘rsatiladi:
Document Size (Pa3mep nokymenrta) Hujjat o‘lchami, Document
Profile (ITpoduab nokymenta) Hujjat profili, Scratch Sizes
(O6beM mamsTH) — operativ xotira hajmi, bu holda Photoshop
dasturiga tegishli Efficiency (D¢ dexrnBHocTb) Samaradorlik —
foydalangan operativ xotira, Timing (Bpemsi) Vaqt va Current
Tool (Tekyuwumii nHcTpymMeHT) — joriy asbob nomi. Holat satrini
kursor yordamida, tasvirni sahifada qanday ko‘rinishga ega
bo‘lishini ko‘rish uchun sichqonchaning tugmasini bosib ushlab
turiladi. Agarda bu amalni Alt tugmasi bilan birgalikda bajarsak,
u holda ekranda tasvirning hajmi, kanallar soni, rejimi va
ajrataolish (paspewteHue) haqidagi ma’lumot beriladi. Vaqtni
noldan boshlab hisoblash uchun Timing (Bpemsi) dan foy-
dalaning.

Eile
New... CueN Photoshop dasturining Menyusi
Dpen... Cub0
Browse... Shit+Ctrl+0
OpenAs. Alt+Ctikb0
O Hovet s File menyusi
i et File (®aitn) menyusining buyruglari
A quyidagi amallarni bajarishda foydalaniladi:

i yangi fayl yaratish, mavjud faylni ekranga

Place... chigarish, joylashtirish, yopish, xotirada
‘Em 4 saqlash, skayner qilish, import yoki
Wh'g” = eksport qilish, tasvirni bosmaga chigarish,
Fa 5 faylni set yordamida uzatish, operatsiya-

 Fielnio., larni avtomatlashtirish va nihoyat,
PageSenp.  SHAWCUP Photoshop (3.31-rasm) dasturidan chigib
;’:mmw Wil ketish. Agarda qo‘shimcha qo‘llanmalardan
Pt Copy | ARsahib O (ImageReady yoki GolLive)dan foyda-
i‘f"’“ m' lanmogqchi bo‘lsangiz File > Jump to
s c_" (®aiin > [epeittu B) menyuchasi orqgali

3.31-rasm. .Flle o‘tasiz.
menyust.
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Edit (I1paska) Tuzatish (3.32-
rasm) menyusi yordamida quyidagi
amallar bajariladi: fasvirlarni muhar-
rirlash buyruglari: nusxalash, transfor-
matsiya qilish (ko‘rinishini o‘zgartirish),
qo‘yish va tasvir ranglarini qaytadan
aniqglash, berilgan shakldagi va o‘lcham-
dagi kistlarni yaratish, har xil shakllar
va figuralar yaratish. Fade (Ocaabumv)
menyuchasi buyruglari ko‘zlangan amal-
lar effektini kamaytirish (masalan, eng
oxirgi ishlatilgan filtrdan tuzatish (kor-
rektirovka) yoki chizishni boshga amal-
lar bilan almashtiradi). Purge (Ouuc-
T™ATh) menyuchasi buyruqlari xotirani
tozalaydi. Yanada Edit menyuchasi
yordamida Color Settings (Xapak-
TepUCTUKU LiBeTa) mulogot oynasini
ochib, Preset Manager (MeHemxep

[E Edit menyusi
Undo Rectangular Marques  Clil+Z
Step Backward ARCHlZ
Cut Cil+X
Copy CukC
Paste CulsY
Paste Into Shit+Cilsy/
Clear
Fill...

Stroke...
Free Transform CulsT
Transform
Define Brush...
Define Pattem...
Purge
Calor Settings... Shit+Ctrl+K
Preset Manager...
L Preferences;
3.32-rasm. Edit
menyusi.

Image menyusi

HacTpoeK)dan va Preferences (YcraHoB-
ku)dan foydalanib ranglarni o‘zgartiradi.

| Image
Mode >

Image (M3o06paxenue) Tasvir menyusi-
ning Mode (Pexum) menyuchasi yordamida
(3.33-rasm), tasvirlar sakkizta imkoniyatning
biriga o‘tkazilishi mumkin. Adjustments (Kop-
pekTUpOBKM) menyuchasi tasvir ta’sirchanligi
(toni), to‘yinganligi, ravshanligini o‘zgartiradi.
Image Size (Pa3mep uzoOpaxenus) Tasvir
hajmining menyuchasi yordamida fayl hajmini,
tasvirni ajrata olishni, o‘lchamlarini o‘zgartira
olish imkoniyatiga ega. Canvas Size (Pa3mep
xosicta) mulogot oynasi tasvir joylashgan
ishchi maydon o‘lchamini o‘zgartirganda
ishlatiladi.
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Adjustments 3

Duplicate...

Apply Image...
LCalculations...

Image Size...
Canvas Size...
Rotate Canvas ¥
Crop

Trim...

Heves Al

Histogram...

rat
=)

3.33-rasm.
Image menyusi.




Layer Layer menyusi

New ¥ Layer (Cunoit) Qatlam menyusida
Duplicate Layer... ~

Dolcts . joylashgan buyruqglar (3.34-rasm) qat-
7 ; lamlarni qo‘shish, nusxalash, o‘chirish,
ayer Properties... A .

Layer Style 8 o‘zgartirish, guruhlash, stekda joylashgan
New Fil Laes R tartibni o‘zgartirish, o‘zaro bog‘langan

qatlamlarni boshqgarish, qatlamlarni
biriktirish, maskani qo‘shish va tasvirni
bitta qatlamga aylantirish amallarini
bajaradi. Buyruglarni bajarish tezligini

New Adjustment Layer »

[LauerEontentiction
ppe y

Hasiene y

New Layer Based Slice

oshirish uchun Layers (Cnou) palit-
Add Layer Mask » rasidan foydalansa magsadga muvofiq
| ErEdelaEdese bo‘ladi.

Add Vector Mask >
Select menyusi

Select (Bbioenutsb) ajratish (3.35-
y rasm) menyusidagi All (Bce) buyrug‘i
yordamida hamma qatlamlar ajratiladi.
Deselect (CHsiTh BbiaesneHue) Ajratishni
bekor qilish buyrug‘i esa teskari amalni

Group with Previous Clil+G

Merge Down Chl+E

Merge Visible  Shit+CieE tfaJaflb, a}ra:
Flatten Image tishni bekor qi- | Select
Matting » ladi. Reselect Al Chish
3.34-rasm. (BocctaHOBUTH Deselect Ctil+D
Layer menyusi. BbIACTIEHHUE) HEseleet GhttAEH D
Inverse  Shit+Crl+l

Ajratishni tik-
lash buyrug‘i esa Deselect buyrug‘i
bilan ajratishni bekor gilishni orqaga
qaytarib avvalgi holini tiklaydi. Color
Range (/luanma3zoH usetoB) buyrug‘i

Color Range...

Feather... Al+Ctr+D
Modify

»

ranglarni hisobga olgan holda ajratadi. Srow

g ; Similar
Menyuning boshqa buyruqlari esa
ajratilgan soha chegarasini kengaytiradi, Transform Selection
sigadi, tekislaydi yoki rastushevkalaydi TG
va ajratilgan sohalarni kanallarda Save Selsction.
saqlaydi yoki kanallardagi sohalarni

3.35-rasm.

yuklaydi.
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Filtr  menyusi

Filtr (OunbTp) menyusi tasvirlarni va
guruhlangan tasvirlarni muharrirlashda
ishlatiladigan filtrlarning keng diapazonini
o‘z ichiga oladi. Digimarc (/Inmxxumak) filtri
inson ko‘ziga ko‘rinmaydigan mualliflik
belgisini tasvirlarga qo‘yib beradi (3.36-
rasm).

Oldingi versiyalaridan farqi shuki, bu
versiyada menyuga Image menyusining
ikkita buyrug‘i joylashtirilgan. Extract
(M3Bneub) buyrug‘i murakkab sohani
ajratish uchun ishlatiladi. Liquify (Mcka-
3uThb) buyrug‘i esa, tasvirning nugqtalarini
berilgan yo‘nalishda siljitadi.

View menyusi

View (Bua) menyu buyruqlari (3.37-
rasm), ekranda nima tasvirlangan, nima
tasvirlanmagan, shularni nazorat qiladi.
Gamut Warning (IIpeaynpexaeHue o
ramme) buyrug‘i to‘rtta rangli bosmada
chigmaydigan ranglarni ajratib beradi. Proof
Setup (YcraHoOBKM MpoOHOro OTnevyarka)
menyucha buyruqglari tasvir bosmaga ganday
holda chiqgarilayotganini ekranda ko‘rsatib
beradi. View menyucha buyruglari tasvir
masshtabini boshqaradi, shu bilan birga
ekranga chizg‘ichni, koordinatorni, yordam-
chi chiziglar va sohalarni chigaradi.

Window menyusi

Window (OkxHo) menyu buyrugqglari
(3.38-rasm) har xil palitralarni ko‘rinmas/
ko‘rinadigan holga keltiradi. Bu menyuda

Filter

Extract... AR+Ciriex
Liquity... ShitsCirleX
Patten Maker... Al+Shit+CtrleX

Atistic
Bl
Brush Stiokes
Distort
Noise
Pizelate
Render
Sharpen
Sketch
Styhze
Texture
Video
Other

Y Y Y VY YYVYTYVYYYYTVYTY

Digmarc

3.36-rasm. Filtr
menyusi.

| View
Proof Setup >
Proof Colors Cirl+Y
Gamut Warning Shit+Cirl+Y

Zoom [n Clrl++
Zoom Qut Ctrl+
Fit on Screen Ctil+0
Actual Pixels Al+Cul+0
Print Size

v Extras Ctri+H
Show »

Rulers Curl+R

v Snap Shit+Ctrl+;
SnapTo >
Lock Guides Al+Clrl+;

New Guide...
Lock Slices
1 SlcEy

3.37-rasm. View
menyusi.

ochilgan tasvirlar ro‘yxati ham joylashgan bo‘lib, xohlaganini joriy

gilishi mumkin.

Windows operatsion sistemasida ishlaganda bu menyu yordamida
oynani (holat satrini) olib qo‘yish (o‘rniga go‘yish) amallarini

bajarish mumkin.
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[gndow inix
Documents  » 7 w:mcmap ¥ EmertSupport W More Resources a
Workspace » SRR R TR - KSR T Erm— (|

v TNS ’f‘:;_‘,;m .

v Om :'m&ml*ptm
er P Leow reteces

v Nawgator "

Info ) ooivomicin e cie
leaming resources on Adobe com.

M i To use?:rod.m Help, you must have an Adobe product installed

Swatches that inchudes Adobe Help Conter,

Styles

it 3.39-rasm. Help Window menyusi.

Actiong

Tool Presets

v Layers
i Help menyusi
O Help (ITomowms) menyusining buyruglari

Photoshop dasturining qo‘llanmasini interaktiv
Character s S ko :
Paragraph ko‘rinishda ko‘rish, Adobe kompaniyasi haqida

v Status Bar oxirgi yangiliklarni olish, Adobe Online yoki

338 -rasm.  €krandagi amalni (3.39-rasm) bajarish hagida
Window yorignomani olish uchun internet tizimiga ula-
menyusi. nishni bajaradi.

[ Swatches NI

3.40-rasm. Guruhdan
palitrani ajratish.

3.41-rasm. Yangi palitra
yaratish.

Agarda avvalgi Photoshop versiyasi ustiga yangisi yozilsa,
palitralar joylashishi avvalgi versiyanikiga mos keladigan bo‘ladi.
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PALITRALAR

Palitralardan qanday foydalansa bo‘ladi

Photoshop dasturidagi ko‘zlangan amallar siljitiladigan
palitralar yordamida bajariladi. Ekranda palitralar ko‘p joy
egallamasligi uchun palitralar sukut saglagan holda quyidagi
guruhlarga biriktirilgan: Navigator/Info (Hasuraimsi/Undopmaiius)
Navigatsiya/Ma’lumot, Color/Swatches/ Styles (Ilset/O6pa3iibl/
Cmun) Rang/Ko‘rsatmalar/Stillar, History/Actions/Tool Presets
(Uctopus/detictBusi/Ha6op uHctpymeHnToB) Tarix/Amal/
Asboblar majmuasi, Layers/Channels/Paths (Cnou/Kanansi/
Koutypsr)Qatlamlar/Kanallar/Konturlar va Character/Paragraph
(IIpudpr/A63a11)Shrift/Abzas.

Xohlagan palitrani ochish uchun Window (OxHo) buyruq-
laridan foydalanamiz. Ko‘rsatilgan palitra shu guruhga kiradigan
boshqa palitralar ustiga joylashtiriladi.

Bir xil palitralar opsiya panelidagi Type tugmasiga chertish
yordamida ham ochiladi, masalan, Type (Texct) asbobining
Character/Paragraph palitrasi. Tab tugmasini bosish orqali barcha
ochiq palitralarni, asboblar panelini ko‘rinadigan/ko‘rinmas
hollarga keltiradi. Agarda Shift+Tab tugmalar kombinatsiyasi bosilsa,
asboblar panelidan tashqari ochiq turgan palitralarni ko‘rinadigan /
ko‘rinmas hollarga keltiradi.

Agarda shu guruhdagi qandaydir palitrani boshqgalari ustiga
joylashtirmoqchi bo‘lsangiz o‘sha palitra nomiga sichqoncha
yordamida chertish kifoya. Palitrani guruhdan ajratib olish
imkoniyati ham bor, shuning uchun vkladka (palitra nomi)dan
ushlab olib chigish kerak, agarda guruhga palitra qo‘shmoqchi
bo‘lsangiz vkladkadan ushlab turib tashlash kerak (3.40—3.41-
rasmlar), shu bilan birga guruhga boshga guruhni ham go‘shsa bo‘ladi
va vkladkadan ushlab guruh ustiga tashlash kerak. Manipulyator
yordamida palitra o‘lchamlarini o‘zgartirish, (o‘ng tomondagi
burchakdan tortish kerak) kattalashtirish yoki kichiklashtirish
mumkin.

Agarda palitrani yig‘moqchi/kattalashtirmoqchi bo‘lsangiz, palitra
nomiga ikki marta sichqoncha bilan cherting yoki oynaning o‘ng
yugori gismidagi mos tugmasiga bir marta bosish kerak. Agarda
palitra o‘lchami sukut saglagan holdagidan boshgacha bo‘lsa, avval
Minimize tugmasiga sichqoncha bilan cherting, bunda palitra o‘lchami
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sukut saqlagan holda gayta tiklanadi, keyin kattalashtirish uchun
yana bir marta bosish kerak.

Agarda Edit > Preferences > General (IIpaska > YcraHoBku >
Oo6mue) mulogot oynasidagi Save Palette Locations (CoxpaHsiTh
pacrniosioxeHue naaurpa) ga bayrogcha qo‘yilgan bo‘lsa, Photoshop
dasturidan chiqib ketgan paytdagi palitralar ganday joylashgan
bo‘lsa qaytadan dasturga kiradi va shu holda ekranga chiqariladi.

Xohlagan paytda sukut saglagan palitra guruhini gayta tiklash
mumkin, shuning uchun Window > Workspace > Reset Palette
Locations (OxHo > PaGouee nojie > BoccTaHOBUTB pacrosiokeHue
nanutp) buyruglaridan foydalanish lozim.

Palitra maydonlari yoki muloqot oynasi giymatlarini gisqa vaqt
ichida o‘zgartirish uchun avval palitraga cherting, keyin yo‘nalish
tugmalari yordamida kamaytirmoqchi yoki ko‘paytirmoqchi
bo‘lsangiz yuqoridagi tugmalarni bosish kerak.

Uchib chiqadigan siljitishdan ikki xil usulda foydalaniladi
(3.42-rasm): sichqonchani bosgan holda yo*nalishli tugmani bosing
va siljigichni torting yoki siljishi kerak bo‘lgan shkalaga sichqoncha
bilan cherting va u avtomatik ravishda siljiydi. Siljitgich panelini
yopish uchun paneldan tashqgaridagi sichqoncha bilan cherting
yoki Enter tugmasini bosing. Agarda siz yo‘nalishli tugmani
chertgan bo‘lsangiz, siljitgich panelini ochish uchun Esc tug-
masini bosing, shunda siljitgichning oxirgi berilgan ko‘rinishi paydo
bo‘ladi.

’ l Tolerance: |32 I Anti-sliased [¥ Contiguous  I™ Lice Al Loy ‘ Opacity: IBQ% |b Il_i
- - 3

3.42-rasm. Uchib chigadigan siljitgich.

Color palitrasi

Color (LIBer) palitrasi (3.43-rasm) ranglarni tanlash yoki
aralashtirish uchun ishlatiladi. Ranglarni tasvirlarga har xil chizish
asboblari yoki tuzatish-kiritish buyruqglarini masalan, Fill (3anuThb)
yoki Canvas Size (Pa3mep xoscra) yordamida berish mumkin.
Palitraning menyusidan rang modelini tanlang. Ranglarni aralash-
tirish uchun siljitgichni surish orgali amalga oshiriladi. Rangni tez
tanlash uchun tayyor holda foydalanish kerak, buning uchun
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tayyor bo‘lgan ranglar paneli
chertiladi, bu panel Color
palitrasining past gismida joy-
lashgan.

Color Picker (BniGop
usera) rang tanlash panelini
ochish uchun asosiy yoki fon
rangini tanlab kvadratga bir
marta chertish kerak, agarda
joriy bo‘lmasa ikki marta
chertish kerak.

Swatches palitrasi

Swatches (O6pasubi)
palitrasi — 3.44-rasmda berilgan
bo‘lib, tayyor ranglardan foy-
dalanmoqchi bo‘lsangiz, ishla-
tiladi. Ranglar palitrasiga alohida
Swatchesni qo‘shish yoki olib
tashlash mumkin. Palitra
menyusining buyruglarini yuk-
lash, bog‘lash, xotirada saglash
mumKkin.

Styles palitrasi

Styles (Crtunu) palitrasi
(3.45-rasm) avvalgi yaratilgan
effektlar va ularning birikmala-
rini xotirada saqlashdan foyda-
laniladi. Bu amal avval faqat
ImageReady dasturida mavjud
edi, hozir esa, Photoshop
dasturida ham ishlatiladi.

Navigator palitrasi

s
QR =E s elle
G AEso “_, Je Shder
v FGB Shders
HSB Shders

B=AW

CMYK Shders

Lab Skders
Web Color Siders

Copy Color a3 HTML

v RGB Spactum
CMYK Spectrum
Grapscala Ramp
Curtent Colors

Make Ramp Web Safe

3.43-rasm. Color palitrasi
va menyusi.

B

ANPA Calors

DIC Color Guade
FOCOLTONE Colors
HKSE

HES K

HESN

HKSZ

Mac 05

PANTONE metalic coated
PANTONE pastel coated
PANTONE pastel uncoated
PANTONE process coated
PANTONE zobd costed
PANTONE sobd malte
PANTONE sobd to process
PANTONE sobd uncoated
TOY0 Colots

3.44-rasm. Swatchesning
palitrasi va menyusi.

Navigator (HaBurauwus) (3.46-rasm) palitrasi yordamida
tasvirning bitta parchasini oynada ko‘rsatadi yoki shu parchaning

masshtabini o‘zgartiradi.
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Test Orly
OEIEIEICV RS s

s T
Senall Lict

T T—=—1

Laxge List
Preset Manager...

Resat Stgles.
Load Styles
Save Stes...
Replacs Styles

Abshact Styles
Bustons

Glass Button Rollovers
Glass Buttons

Image Effects
Photographic Effects
Rollover Buttons

Ten Effects 2

Test Effects

Testuras

3.45-rasm. Stylesning
palitrasi va menyusi.

3.46-rasm. Navigatorning
palitrasi va menyusi.

=] x|

| _Mavigator Y Info "\ )
R : €
G: M
)'!B: ""Y:
K :
Ry W
+ T 'L_-' H

Info palitrasi

3.47-rasm. Info palitrasi.

Info (Mudopmauus) palitrasida kursor ko‘satgan pikselning
rang komponentalari ko‘rsatiladi (3.47-a rasm ). Shu bilan birga tasvir
uchun tanlangan ranglar hagida ma’lumotlar uchun tayyor
ranglarning kamida to‘rttasi joylashtirilgan bo‘ladi (3.48-rasm). Agarda

ranglarni tuzatish uchun muloqot
oynasi ochilgan bo‘lsa, ranglar
palitrasini o‘zgartirilmasdan avvalgi
va keyingi ranglari haqida
ma’lumotlar beriladi. Shu bilan
birga tasvirda kursor joylashgani
hagida x vay o‘glarini koordinatalari

ham beriladi (3.49-b rasm).
Palitrada boshga ma’lumotlar
ham bo‘lishi mumkin va u ganday
asbob joriy holda turganligiga
bog‘liq bo‘ladi: masalan, ajratilgan
gismni siljitganda nuqtalar
orasidagi masofa, figuralarni
qurganda yoki Measure (M3me-
putenb) asbobidan foydalan-
ganda; tasvirdan qirqib olinadigan
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3.49-rasm. Info palitrasi.



sohani, ramkaning o‘lchami (3.47 b-rasm); yoki transformatsiya
gilinayotgan obyektning eni (W), balandligi (H), burchagi (A),
vertikal (V) va gorizontal (H) qiya chiziglari (3.49 b-rasm).
chizg‘ichning o‘lcham birliklarini o‘zgartirishi uchun 3.47 b-rasmda
ko‘rsatilgan yo‘nalishga sichqoncha bilan chertish kerak.

3.49 a-rasmda ko‘rsatilgan yo‘nalishga sichqoncha bilan chertish
kerak va uni qo‘yib yubormay turib, chigadigan ma’lumotlarning
rejimini tanlash kerak: Actual Color (texymwuii pexum
n3o00paxenusi)tasvirni joriy rejimi, Proof Color, Grayscale, RGB,
Web, HSB, CMYK, Lab Color, Total Ink yoki joriy gatlamni
Opacity (HenpospaunocTts) parametr giymatlarini bering. Rang
hagida ma’lumot beruvchi rejim joriy tasvirning rejimidan farq
qilishi mumkin.

Eslatma

Agarda ranglar haqidagi ma’lumotda belgisi turgan bo‘lsa,
rang CMYK palitrasidan tashqgariga chiqib ketganligini bildiradi,
bosmaga chigarishda tasvir o‘zining ko‘rinishini o‘zgartiradi.

Ranglar hagida yoki o‘lcham birliklari hagida ma’lumot olish
uchun Info Options (Ommmu manutpel Info) oynasidan foyda-
lanamiz. Bu oynaga ruxsatni palitra menyusidagi Palette Options
(Ommumu mamaTper) buyrug‘i  beradi.

CC‘”

Layers palitrasi

Yangi tasvir yaratganda tasvir foni tiniq rangda bo‘lmaydi. Layers
(Cnom) palitrasi gatlamlarni qo‘shish, o‘chirish, ko‘rinadigan/
ko‘rinmas holga olib kelish, nusxalash, guruhlash, bog‘lash va
fonning yuqgori gismida joylashgan gatlamlarni joylashish tartibini
o‘zgartirishi kerak (3.50-rasm). Har bir gatlamga o‘zining
aralashtirish rejimi va tiniqglilik rejimlari mos kelib va har bir
gatlamni boshga gatlamlarga to‘ligsiz turda muharrirlash imko-
niyatiga ega bo‘lamiz. Shu bilan birga gatlamlarni maskaga (mask)
bog‘lasa ham bo‘ladi. Standart turdagi gatlamlardan tashqari,
Photoshop dasturida ikki xil turdagi gqatlamlarni ham yaratsa bo‘ladi:
korrektirovkalanadigan gatlam (adjustment layer), bu vaqtincha
ranglardan foydalanishda yoki gatlamdagi rangni korrektirov-
kalaganda ishlatiladi; va muharrirlanadigan matn qatlami (editable
type layer), bu Type (Tekcr) yoki Vertical Type (BepTuxkaibHblii
TeKcT) asboblarini ishga tushirganda avtomatik ravishda paydo bo‘ladi.
Agarda gatlamga gandaydir effekt ishlatilsa (masalan, Inner Glow
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(Buyrpennee ceuenue), Drop Shadow (OtGpocuth TeHb)), gatlam
nomi enida effekt piktogrammasi va uchib chiquvchi menyudan
chaqirish tugmasi chigadi.

Faqat joriy gatlamnigina muharrirlasa bo‘ladi (tanlangan yoki
joriy). Qatlamni tanlash uchun Layers palitrasidan gatlam nomiga
sichgoncha yordamida chertish kerak.

Yangi gatlamdagi eng pastki gatlam foni tiniq bo‘lmagan
holatidan tiniq holatiga o‘tkazish uchun Contents (Conepxanuc)
guruhidagi muloqot oynasidan, Transparent (IIpo3paunbiii) ga
bayroqcha qo‘yish kerak. Bu menyuning File > New (®aitn >
Hoserit) buyrug‘i yordamida chagiriladi.

[Hormal x| Opacity: Weck o Ealete el

Lock: | »+ @ Fill: [1003%6 [» | New Layer...

Duplicate Layer...
Delete Layer
yelete linked Lavers

[Velete Hidderliavers

| @l| @l @

l——| 4] I’@ Levels 1

New Layer Set...
]r— w. i &Cﬁww a fdew Set Fromlinked)

LocksliiaversimSets

Cl

| Layer Properties...

. Ol 4 ®. a3l 3|,  Blending Options...
fergeliauers
Merge Visible

Flatten Image

Palette Options...

3.50-rasm. Layers palitrasi.

3.2. Photoshop dasturidagi ranglar

Bu dasturda ranglar bilan bog‘liq bo‘lgan asosiy tushunchalar
ko‘rib chigiladi (rang modeli, tasvirlash rejimlari va aralashtirish
rejimlari), shu bilan birga Photoshop dasturidagi ranglarni
boshgarish hagida ma’lumotlar beriladi.
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3.51-rasm. Rasmni Kkattalashtirilganda piksellarning ko‘rinishi.
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Rang hagida asosiy tuchuncha
Piksellar

Photoshop dasturidagi tasvirlar ekranda rastr ko‘rinishida
beriladi, ya’ni to‘g‘rito‘rtburchak torning tugunlarida joylashgan har
xil rangdagi nuqtalarning yig‘indisi. Piksel deb nomlanadigan
nugtalar gandaydir bir rangni yoki soyani beradi. Tasvirning bitta
gismini kattalashtirib piksellarni muharrirlash mumkin (3.51-rasm).

Photoshop dasturidagi har ganday rastr ko‘rinishidagi tasvir
bo‘lib hisoblanadi; u skaner yordamida olindimi, boshga
mubharrirdan eksport qilindimi yoki Photoshop dasturida chizish
yoki muharrirlash yordamida yaratilganidan qat’i nazar. Rastr
tasvirlar bilan ishlovchi dasturlar jivopisli, fotografiya yoki fotoreal
(ranglar farqi juda kam tasvirlar) tasvirlar bilan ishlaydi. Agarda
chizish asboblaridan bittasini tanlagan holda gatlam ustidan kursorni
olib o‘tilsa, kursordan o‘tgan piksellar bo‘yalgan bo‘ladi.

RGB va CMYK ranglari

Monitor ekranidan rangli tasvirni olish uchun qizil, yashil va
ko‘k (Red, Green, Blue — RGB) nurlari ishlatiladi. Agarda bu
uch rangni bir-biriga toza holda aralashtirsak u holda oq rangni
olamiz (3.52-rasm).

To‘rtta rangli bosmada uchta asosiy bo‘yoglar ishlatiladi: ko‘k
(C, cyan), purpur (M, magenta) va sariq (Y, yellow) — 3.53-
rasmda berilgan.

Bu ranglarni aralashtirganimizda goraroq tiniq bo‘lmagan rang
paydo bo‘ladi. To‘q gora rangni olish uchun printerlarda qora siyoh
(K, black) bilan kam migdordagi ko‘k, purpur yoki sariq siyohlar
bilan aralashtiriladi.

Monitor ekranidagi ranglarning tasvirlanishi yorug‘lik tushi-
shiga, monitor haroratiga va aylanamizdagi predmetlarning rangiga
bog‘lig bo‘ladi. Shu bilan birga, real hayotdagi ranglar bosmadan
chigarilmaydi, ekranda tasvirlangan hamma rang bosmadan
chigarilmaydi, ba’zi bir ranglar bo‘lsa, monitor ekranida tasvir-
lanmaydi. Hamma monitorlar RGB modeliga asosan tasvirlanadi,
CMYK — rangi esa simulyatsiya gilinadi. Fagat CMYK modelini
bosmaga chigarishda ahamiyati katta. Agarda siz berilgan tasvirni
set yordamida uzatmoqchi bo‘lsangiz yoki kinoplenka qurilmasiga
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bermoqchi bo‘lsangiz, u tasvirlarning RGB rejimidan CMYK
rejimiga o‘tishi uchun bosh gotirmasa ham bo‘ladi.

Red
S .,

— e e - )
Green — #8414

3.52-rasm. Kompyuter monitoriga ranglarni qo‘shish.

Blue

Cyan Magenta Yellow Black

3.53-rasm. Bosmaxona bo‘yog‘ining asosiy ranglari.
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3.54-rasm. Color 3.55-rasm. Info palitrasidagi
palitrasidagi undov belgisi. undov belgisi.
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Agarda siz bosmaga chigadigan (gammaga kirmaydigan) rangni
tanlasangiz, Color (LIBer) palitrasidagi undov belgisi chigariladi
(3.54-rasm). Shu belgi Info (Mudpopmanus) palitrasida ham
chigariladi, agarda kursor ko‘rsatayotgan piksel rangi gammaga
kirmasa (3.55-rasm).

Photoshop dasturidagi Gamut Warning (ITpenynpexneHve o
ramme) buyrug‘i yordamida bosmaga chiqarilmaydigan ranglarni
boshqa rang bilan berish mumkin va keyin Sponge (I'yoka) asbob
yordamida rangning gammasiga o‘tkazib olsa bo‘ladi.

Photoshop dasturidagi ranglarni tanlash panelida yoki Color
panelidan quyidagi ranglar modelini tanlash mumkin: Grayscale
(ITonyroHoBoe uzobpaxeHue), RGB (red-green-blue — kpacHBI-
zeneHblli-cunuit), CMYK (cyan-magenta-yellow-black —
roJiyooi-nmyprnypHbI-XKenAThlii-uepHblid) yoki Lab (lightness-a
axis-b axis — ApKOCTh U 1IBET Ha OCSIX a U b).

Kanallar

Photoshop dasturidagi rasmlar bir yoki bir nechta yarim
tiniq holdagi ranglardan tashkil topgan bo‘lib, bular kanallar
deb ataladi. Masalan, RGB rejimidagi tasvirlar qizil, yashil,
ko‘k kanallardan tashkil topgan bo‘ladi. Bu hagda kengroq
ma’lumot olmogchi bo‘lsangiz rangli tasvirni ochib, Channels
palitrasini sichqoncha bilan Red, Green, Blue elementlarining
har biriga alohida chertib ko‘rsangiz bo‘ladi, bunda fagat chertilgan
kanal namoyon bo‘ladi. Keyin RGB (Ctrl+~ tugmalar majmuasi)
elementiga chertsak, avvalgi holini tiklaymiz. Agarda kanallar har
xil ranglarda berilmagan bo‘lsa, u holda Edit > Preferences >
Display&Cursors oynasidan Color Channels in Color (Kananb B
11BeTe) ga bayroqcha belgisini o‘rnatish kerak.

Ranglarni korrektirovkalaganda bitta kanalga tegishli bo‘ladi,
fagat o‘zgartirish ko‘p kanallarda ko‘rsatiladi va olib boriladi,
kompozit tasvirlashda (Channels palitrasining eng yuqoridagi
elementi) tasvirning hamma kanallariga bir vaqtda ta’sir qiladi.
Maxsus yarim ta’sirchanlik kanallari tasvirning ajratilgan sohasini
maska sifatida saglaydigan alfa kanallar deyiladi va ularni tasvirga
go‘shsa bo‘ladi (3.56 a-rasm). Shu bilan birga giyachizigli rangli
kanalni ham qo‘shsa bo‘ladi (3.56 b-rasm). Muharrirlash ishlari
fagat joriy bo‘lgan kanallar bilan olib boriladi.

Kanallar soni qancha ko‘p bo‘lsa, tasvirning hajmi shuncha
katta bo‘ladi (xotiradan katta joy egallaydi). RGB rejimining uchta
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kanali bilan (qizil, yashil va ko‘k) yarimta’sirchanli rejimning bitta
kanaliga nisbatan uch barobar katta hajmga ega bo‘ladi. Bu tasvir
CMYK rejimida esa to‘rt barobar katta diskdan joy egallaydi.

Web-grafika

Agarda siz web sayt uchun tasvir yaratayotgan bo‘lsangiz, RGB
rang modelidan foydalaning. Faqat shuni esda saglang, RGB rang
yoki boshqa model ranglari Web-brauzerning ranglar modeli bilan
mos tushmasligi mumkin. Sifatli bo‘lgan tasvir natijasini olish
uchun Web yoki Visibone palitrasini Swatches palitrasiga yuklang,
Web Color Sliders (ITon3ynku Web-11BetoB) va Color palitrasidagi
Make Ramp Web Safe (Web uchun ranglarni kiradigan qilib
bering) opsiyalardan foydalaning.

| Channels

Ctri+i

Cirl+3
P PANTONEZTOCY Ctrl+d
[ .Anpha1 | I CHrl+S
b
a ©
SIS NN

3.56-rasm. Tasvir kanallari.
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Har bir tasvir rejimida sukut saglaydigan kanallar soni

3.1-jadvalda ranglarning sukut saglaydigan kanallar sonining
nechta bo‘lishi berilgan.

3. 1-jadval
Bitta Uchta To‘rtta
Bitmap RGB CMYK
Grayscale Lab
Duotone Multichannel
Indexed Color
Image
Binse.. o
e Proct Colors Culey’
) Grayscale o v Working CMYK
Adjustments > = a"f , O Gat W arriog . S O i Chon Fioia
= g Zoom In Clrles Working Magenta Plate
QUD‘CB.B !ndeued Color... Zoom Qut Ctil+ Working Yeliow Plate
Apply Image... v RGB Color Fion Screen Cirls0 Waorking Black Plata
Calculations... CMYK Color Actual Poels Al+Crds0 Working CMY Plates
- Lab Color Swt s Macintosh RGE
Image Size... Multichannel v Extias ChileH Windows AGB
Canvas Size... == Show > Monitor RGB
Rotate Canvas » v 8Bits/Channel Rulers iR e
r '.if: 16 Bits/Channel e SHACile:
Trim... el T Snep To >
i ) Lock Gudes  ARsCi:
Hist Assign Profile... naes
Hmogeme Conyert to Profile... New Guidg.
lizp Lock Skces
3.57-rasm. Mode 3.58-rasm. Bosmaga chiqgarishdan
menyuchasi. oldin nusxa uchun parametrlarni

kiritish menyuchasi.

3.3. Ishning boshlanishi

Bu dasturda ishni ganday boshlash o‘rganiladi: Photoshop
dasturini ishga tushirish, tasvirlarni skaner qilish, yangisini yaratish,
oldin mavjud bo‘lgan faylni ochish va Photoshop dasturiga xohlagan
tasvirni qo‘yish. Shular bilan bir gatorda, tasvirning o‘lchamlarini
ajrataolish va fayl hajmini o‘zgartirish; tasvir joylashgan canvas
o‘lchamini o‘zgartirish; qanday qilib kesish, aylantirish, saglash,
nusxa olish va dasturni yopish garab o‘tiladi. Shu bilan birga ko‘rish
masshtablarini o‘zgartirish, oynadagi tasvirlarni siljitish va tasvirlarni
ekranda ko‘rsatishlarni garab o‘tamiz.
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Dasturni ishga tushirish

Windows 95, 98, ME, 2000, XP yoki NT operatsion dasturida
Start (ITyck) tugmasiga sichqoncha bilan cherting, bu masalalar
panelda joylashgan bo‘ladi, Programs ([Iporpammbi) ni tanlang,
keyin Adobe, Photoshopni tanlang va Adobe Photoshop ga sichqoncha
bilan cherting (3.59-rasm).

(Agarda Sizning ishchi stolingizda Photoshop dasturi uchun
piktogramma bo‘lmasa, Adobe Photoshop papkasini oching va
ishchi stolga uni olib o‘ting.)

£
% Windows Update

E?% AKTHB3UMA Windows

= )
\ﬂ/ KaTtanor Windows

rﬂ T e 1j PCI Audio Applications >
M) AsTozarpyska »

4 AoxyrenTsl ) Mrpe »

_ ) CraHaapTHbIE >

- Dr’ HacTporika @

o S Adobe ImageReady 7.0

§ /J Ha#iTh Y14 Adobe Photoshop 7.0

- & Internet Explorer

o Q) CrpaBKa W NoAASPHKa W MSN Explorer

& 7 Bononrems (%3 Outlook Express

; J Windows Messenger

.g ] 3aBEpWeHHE CEaHCa AAMUHUCTPATOP, .. @ Mponrpuisatens Windows Media

= ¢ YA3NEHHBIR NOMOLLHKK

Ed | 0] BoiknounTs KomnbroTEp. .

' nyck

3.59-rasm. Photoshop dasturining ishga tushirilishi.

Ikkinchi uslub: My Computer (Moii komnbiotep) katalogidagi
Adobe Photoshop papkasini oching va ikki marta Photoshop
dasturining papkasiga cherting (3.60-rasm).

Uchinchi uslub: Photoshop dasturiga tegishli xohlagan fayllarni
ikki marta cherting ( 3.61-rasm).
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3.60-rasm. Photoshop dasturining papkasi.
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3.61-rasm. Photoshop dasturining fayllari.
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Tasvirlar manbai

Xohlagan tasvirni yaratish,
ochish, muharrirlash va ularni
12 ta Photoshop formatli tur-
larini xotirada saglash mumkin
(3.62-rasm). Shunga garamas-
dan faqgat bir nechta formatlar
ishlatiladi: TIFF, GIF, JPEG,
EPS va Photoshop dasturining
formati.

Photoshop dasturi har xil
formatlarda ishlay olish imko-
niyatini hisobga olib, tasvirlarni
xohlagan manbaidan olish
imkoniyati bor: skaner yorda-

BMP [*.BMP;* RLE .DIE]
CompuServe GIF [* GIF]
Photoshop EPS [*EPS)
Phatoshop DCS 1.0 [XEPS)
Photoshop DCS 2.0 [*EPS]

EPS TIFF Preview [*EPS)
Filmstrip [*.FLM)

JPEG [*JPG*JPEG*JPE)
Generic PDF [*.PDF;*PDP;*.4l)
Acrobat TouchUp Image [* PDF;*.A1% PDP)
Photo CD (*.PCD)

PICT File (*PCT;*PICT)

Pixar [*.FXR]

PNG (% PNG)

Raw [* Raw)

Scitex CT [*SCT)

Targa [* TGA“ VDA ICB*VST)
TIFF [*TIF*TIFF)

Wireless Bitmap [*WEBMP* WEBM)

3.62-rasm. Photoshop
dasturidagi tasvirlarning

mida grafik muharrirlaridan, fayllari.
kompakt diskdan, fotorasm-
dan, vediotasvirlardan va boshqa operatsion dasturdan olinadi.

Tasvirni Photoshop dasturi yordamida ham yaratsa bo‘ladi.

Skanerlash

Skaner yoki ragamli kamera yordamida olingan tasvirlar,
slaydlar, fotografiyalar, tasvirlar ragamli shaklga o‘tkazilib,
kompyuter bularni gabul gila oladigan shaklga keltirgandan keyin
mubharrirlash va boshmaga chigarish mumkin. Photoshop dasturidan
foydalanib yoki boshga maxsus dasturlar yordamida skaner gilish
mumkin va olingan natijani Photoshop dasturi qabul giladigan
formatda xotiraga yozish mumkin.

Skaner yordamida sifatli tasvirni olish uchun dastlab skaner
gilinadigan tasvirni yaxshilab tekshirib, tanlab oling. Ba’zi bir
skanerlar tasvirning ottenoklarini kamaytiradi, natijada tasvir
kontrastligi ortadi, shu sabablarga bog‘liq tanlangan fotorasmning
ranglar balansi yaxshi bo‘lishi kerak. Agarda tasvirni o‘zingiz skaner
gilmoqgchi bo‘lsangiz skanerlash parametrlarini tanlashda
adashmang.

Skaner gilingan tasvir sifati skaner turiga ham bog‘liq bo‘ladi.
Agarda Siz tasvirni Photoshop dasturi yordamida o‘zgartirmoqchi
bo‘lsangiz (masalan, filtrlarni qo‘llash yoki kist yordamida
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ko‘zlangan sondagi shtrixlarni solish), u holda gimmat bo‘l-
magan RGB—tasvir giladigan planshet skaner qilinadi. Agarda
ranglarni va tasvirning detallarini aniq berish kerak bo‘lsa,
slaydlar bilan ishlaydigan pristavkali skaner yoki slayd-skaner
kerak bo‘ladi.

Agarda sizga yuqori sifatli professional tasvirlar kerak bo‘lsa, u
holda servis markazlarida CCDO skanerlarida yuqori tan olishlikda
skanerlash kerak(Scitex Smart-Scanner) yoki barabanli skanerlarda
gilgan ma’qul bo‘ladi.Oxirgi model skanerlari ranglarning har xil
turlarini va soyalarni va h skaner qila olish imkoniyatiga ega. Bu
skanerlar CMYK — formatli tasvirlarni yaratadi, hajmi katta
bo‘ladi.

Skanerlash uchun dasturiy ta’minot hagida
asosiy ma’lumotlar

Skaner qilish uchun mo‘ljallangan dasturiy ta’minotlar
ko‘zlangan opsiyalarni beradi. Hamma dasturlar uchun eng ko‘p
ishlatiladigan ma’lumotlar quyida berilgan. Skaner gilingan tasvir
faylining hajmi va sifatini berilgan rejimdan ajrataolish masshtabi
tasvir kesilishiga bog‘liq bo‘ladi.

Fotorasmni yoki tasvirni skanerga qo‘yib, Preview (Ilpen-
BapuTeabHbIH npocmoTp) yoki PreScan (IIpeasaputenbHast
uHbopmaums o ckaHupoBanum)ga sichqoncha bilan cherting.

3.63-rasm. Ajrataolish 72 ppi ga 3.64-rasm. Ajrataolish 150 ppi ga
teng. teng.
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Skaner qilishdan oldin Scan
mode (PcxuM CKaHMPOBAHUS)
parametr giymatini bering.
Black-and-White Line Art
(YepHo-06ensbiii)ni tanlang, hech
ganday ottenok bermaydi, agarda
tasvirda ko‘zlagan ranglar bor
bo‘lsa, Grayscale (IToayroHo-
Boii) yoki Color (LlseTHoii)lar
million rang turlarini beradi. Har
xil ranglarga ega bo‘lgan Color
3.65-rasm. Ajrataolish 300 ppi ga  rejimidagi fayl hajmi Grayscale

teng. rejimiga nisbatan uch barobar
katta hajmga ega bo‘ladi.

Skanerni ajrataolish (ppi)dyuymdagi piksellar bilan o‘lchanadi
va Resolution (Pa3peinenne) parametri bilan 3.63—3.65-rasmlarda
berilgan.Tasvirni ajrataolish gancha yuqori bo‘lsa, shuncha ko‘p
nugqtalar bo‘ladi, demak, tasvirni detallari hagida ko‘p ma’lumot
berilgan bo‘ladi. Shu bilan birga faylning hajmi ham katta bo‘ladi.

Kompyuter resurslarini tejash uchun eng kam ajrataolishni
tanlang. Ajrataolishni o‘zingizga kerakli bo‘lganidan yuqori
gilmang: kerak bo‘lgan tasvir faylining hajmi katta bo‘ladi, bu
tasvirni ckranda, setda yoki bosmadan chigarishda ancha vaqt
ketadi, shu bilan birga tasvir sifatli emas. Ikkinchi tomondan,
past ajrataolishda bosmaga chiqarilgan tasvir aniq va ravshan
bo‘lmaydi. [Ko‘pchilik holda fotorasmlarni ajrataolishni skaner
gilganda 200—300 ppi, poligrafik tasvirlar uchun — 600 ppi da
tanlagan ma’qul bo‘ladi. |

Tasvirni bosmaga chigarmasdan avval bosmaga chigadigan
tasvirni ajratib olib tanlash kerak. Buning uchun avval bosmaga
chigaruvchi qurilmani yoki fotoqurilmani ajrataolish imkoniyatini
bilish kerak, yana rastr liniaturasini ganday bo‘lishini ham bilish
kerak (skanerdagi ajrataolish bosmaga chiqaruvchi qurilmadagi
ajrataolishdan farq qgiladi).

Yarimta’sirchanlilik tasvirlar uchun ajrataolishni rastr liniaturasiga
nisbatan bir yarim marta katta qilib (I dyuym yuzadagi chiziglar
soni) yoki rangli tasvirlar uchun ikki marta katta qilib berish
kerak. Yuqoridagi ajrataolish imkoni skanerlari (600 ppi va undan
katta) shtrixlangan tasvirlar uchun kerak bo‘ladi. Masalan, agarda
tipografiyada oq-qora tasvirni 133 ta chizigli ekranda bosmaga
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chigarmoghi bo‘lsak, u holda skaner ajrataolishini 200 ppi qilib
berish kerak bo‘ladi. Agarda mahsulotni fotoqurilmalar yordamida
tayyorlamoqchi bo‘lsa (bunda yarim ta’sirchanlik texnologiyasi yo‘q),
u holda, skanerni ajrataolishini ko‘rsatishni so‘rang. Faylga mos
keladigan hajmni tanlashda 3.2-jadvaldan foydalansa bo‘ladi.

Agarda tasvirning bir gismini skaner gilmoqchi bo‘lsangiz, u
holda kadrirovaniye qilish kerak. Kerakli bo‘lgan tasvir parchasini
olish uchun avvaldan ko‘rib olish oynasidan siljiydigan chega-
ralarni o‘zgartiring. Tasvir kesishga tayyor bo‘lgan faylning hajmini
birmuncha kichiklashtiradi.

Ba’zi bir holatlarda masshtablashga to‘g‘ri kelib qoladi. Agarda
tasvirning o‘lchamini kattalashtirmoqchi bo‘lsangiz, u holda 100%
katta bo‘lgan masshtab tanlang. Tasvirlarni kattalashtirganda yoki
ajrataolishni orttirganda Photoshop dasturida yoki boshqa
go‘shimchalarda tasvir yuvilgan holda bo‘ladi, sababi qo‘shimcha
ma’lumotlarni kiritish uchun dastur matematik interpolyatsiya
usulini go‘llaydi. Tasvir hagidagi aniqg ma’lumot fagat skaner qilish
paytidagina yozilgan bo‘ladi.

3. 1-jadval

Kanaldagi 16 bitli rejim uchun muharrirlash asboblari va buyruglari

Asboblar Adjustments menyuchasining Boshgalar
buyruglari
Marquee Levels Canvas Size
Lasso Auto Levels Histogram
Measure Auto Contrast Duplicate
Zoom Curves Image Size
Hand Color Balance Rotate Canvas
Eyedropper Brightness/Contrast filtrlar
Slice Hue/Saturation
Color Sample Channel Mixer
Crop Gradient Map
Clone Stamp Invert
History Brush Equalize
Pen guruhining
asboblari
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Hamma parametrlarni o‘rnatib bo‘lgandan keyin skaner qgilishni
boshlash kerak. Buning uchun Scan (Ckanmposarh) tugmasini
chertib, fayl saglanadigan papkani ko‘rsatish kerak.

16 bitli kanal rejimi

O‘rtacha sifatli skanerlar bilan ishlaganda ragamli tasvirlarning
har bir kanaliga 12—14 ta bitli ma’lumotlar mos keladi.

Oxirgi moduldagi skanerlar ragamli ko‘rinishdagi tasvirlarni
bitta kanalga 16 ta bitli ma’lumot mos keladigan qilib beradi.Agarda
16 bitli skanerda ranglar daipazoni katta bo‘lsa va optik zichligi bo‘lsa
(kamida 3,3 bo‘lsa), u holda qo‘shimcha piksellarning ranglarini,
soyalarini hatto qora joylarini ham ko‘rsatadi. Photoshop dasturidagi
kanaldan 16 ta bitli bo‘lgan CMYK—faylni ochish imkoniyati bor
(umuman olganda 4 ta kanalda 64 bit). Tasvir hagidagi hamma
ma’lumotlar saglanadi va tasvirlarni muharrirlash va tuzatish
kiritish imkoniyati bor. Fagat 16 ta bitli tasvirni 8 ta bitli ko‘rinishiga
o‘tkazish kerak, shuning uchun Image > Mode $ 8 Bits/Channel
(M3o0paxenmne > Pexmm > 8 OUT Ha KaHam) buyrug‘ini bajarish
kerak. Bu turdagi tasvirlarga ikkita turdagi cheklamalar qo‘yiladi.
Birinchidan, 16 ta bitli tasvirlar fagat bitta gatlamga ega bo‘ladi.
Ikkinchidan, Photoshop dasturida xohlagan asbob go‘llanilmaydi.
Kanaldagi 16 ta bitli tasvirlar uchun asboblar va buyruglar 3.1-
jadvalda berilgan.

Photoshop dasturidan foydalanib skaner gilish uchun skaner
moduli yoki Twain moduli Adobe Photoshop\Plug-Ins dagi Import-
Export papkasi ichida joylashgan bo‘lishi kerak.

Skaner qiluvchi modulni chagirish

Birinchi marta skaner moduli chagirilganda File > Import (®aiir >
Hmmopt) menyuchasidan Twain_32 Source varianti tanlanadi,
Twain da skaner qurilmasini tipi ko‘rsatiladi (3.66-rasm) va keyin
Twain_32 yoki WIA buyruglaridan bittasi tanlanadi. Endi skaner
qilish dasturiga ruxsat olish uchun File menyusidan Import >
Twain_32 yoki Import > WIA lardan bittasini tanlash kerak. WIA
protokoli bo‘yicha import gilish fagat Windows ME/2000/XP da,
skaner yoki ragamli kamera drayverlari WIA (Windows Image
Acquirisation) texnologiyasining o‘zida saqglash sharti bilan ishlaydi.
WIA (Windows Image Acquirisation) esa TWAIN texnologiyasi
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rivojlangan bo‘lim va Microsoft tomonidan ishlab chigilgan. WIA
TWAIN ga nisbatan umumiy bo‘lib hisoblanadi. Bu esa, 0z
navbatida interfeysga ham ta’sir giladi: WIA drayverlari hamma
qurilmalar uchun bir xil ko‘rinishga ega bo‘ladi. Shu bilan birga,
WIA drayver birmuncha tezlik tomonidan ham yuqori. Fagat WIA
drayverlar asosan rangli kameralarga mo‘ljallangan, skaner
drayverlari firma tomonidan ishlab chiqilgan dasturlarga nisbatan
esa, birmuncha kamroq imkoniyatga ega (3.67 va 3.68-rasmlar).
Shularga qo‘shimcha WIA negativ va slaydlarni ragamli gila olmaydi.

= MUSTEK 1200 CU PLUS l

Main | Enhance  Fillors 3 About

Scan Mode | Color [24bit) -~/
Scan Saurce _ Reflective =
Scan Size | Custom v,J
Rasekiion
Descieen [ Nome =
Y B W g
| ngput
] o &
Suding [1111 % ¢ Y
v--n ot Wldlh IR aM
( Inches \j
N i Height |n 60
Image Siza 26622 00 KB

@BWOOO

3.66-rasm. Skaner qilish parametrlarini TWAIN—drayveri uchun
nastroykalash oynasi.

Agarda sizning skaneringizda Photoshop dasturi yordamida skaner
qilish drayveri bo‘lmasa, u holda tasvirni boshga qo‘shimchalar
yordamida skaner giling va TIFF formatida xotirada saglang, keyin esa,
Photoshop dasturidan gayta ochib, xohlagan formatda saglash mumkin.
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New... Ctrl+N
Open... Ctr+0
Browse... ShitsCirl+D
Openés... AlteLtrl+0
(iper Hezent »
(Giose

Save

Savels.

SaveTor et Rl SHiT

Heven

Elace.,

Exoort »
Workgroup [
Auytomate »
Fiafeies

Eate Settip Shiterai e
Eintiith Brevieo) Bl

AT

£ Al
i B e

Jump To »
Exit Cul+Q

3.67-rasm. Skaner qilish
parametrlarini WIA-drayveri uchun
nastroykalash oynasi.

" MUSTEK 1200 CU PLUS cover sensor

Scan

Paper Size : A4(0.20x11.66) :j
Senis - |
Resnlitian - SupcrfFine :_I

%@

Scan
Scans the image o 1he computer.

Kodaking.exe m

Skanerni ajrataolishni to‘g‘ri
tanlash uchun quyidagi ko‘r-
satmadan foydalaning.

Photoshop dasturi yordamida
skaner qilish

1. Skaner gilish modulini
tanlang yoki File > Import >
Twain_32 (®aiin > WUmnopr >
Twain_32) yoki File > Import
> WIA buyruglaridan bittasini
tanlab bajaring.

2. Prescan (IMpenBa-
putesbHasgs MHopmauus o
CKaHMpPOBaHMM) tugmasiga
cherting. Tasvir saglangan fayl
hajmini ajrataolishda va
masshtablarini o‘zgartirganda
o‘zgarishiga e’tibor bering (3.66—
3.67-rasmlar).

3.68-rasm. Ragamli fotokameradan tasvirlarni gabul gilish oynasi.
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3. Yuqgoridagi yo‘llanmada Kko‘rsatilganlarni skaner qilish
rejimini va ajrataolishini tanlang.

4. O‘z xohishingizga bog‘liq. Skaner qgilishda boshga masshtabni
tanlang.

5. Scan (CkanupoBaTb) tugmasiga cherting. Skaner qilingan
tasvir yangi oynada nomsiz chiqariladi.

6. Tasvirni xotiraga yozing («Fayllarni saglash»ni garang). Agarda
rangni to‘g‘rilamoqchi bo‘lsangiz «Ranglarning berilishi»ga murojaat
qiling. Agarda tasvirni burmoqchi bo‘lsangiz, «Tasvirni ba’zi bir
burchakka burish»ni o‘qing.

Skaner qilganda yoki mavjud bo‘lgan tasvir uchun
ajrataolishni aniglash

Photoshop dasturidagi ajrataolish, boshga xohlagan rastr
dasturlardagiday monitorning ajrataolishi bilan bog‘liq bo‘lmaydi,
demak, tasvirni chigarish qurilmalaridan fayl hajmlarini o‘zgar-
tirib yoki uni hisobga olmagan holda berish mumkin.

Agarda Photoshop dasturidagi masshtabni ko‘rganda 100% ga
teng bo‘lsa, monitoring ajrataolishdan katta ajrataolishga ega bo‘lsa,
ekranda bosmadan chigqaniga garaganda Kkatta ko‘rinadi.

Hammavaqt bosmaga chiqarish qurilmasi uchun qilingan
o‘lchamlarni ajrataolishga bergan ma’qul bo‘ladi.

1. Yangi RGB — hujjatni File > New (®aiin > HoBswiit)
yordamida yarating, uning enini, uzunligini bering, 72 ppi qilib
ajrataolishni tanlang, oxirida OK tugmasini bosing (5 gadamda
tasvirdagi ajrataolishga tuzatish kiritiladi).

2. Image > Image Size (M3o6paxenue > Pasmep
H300paxeHUsI) oynasini oching.

3. Oynaning o‘ng tomonidagi Auto (ABTO) tugmasini bosing.

4. Descreen (Screen, bu drayverlar turiga bog‘liq bo‘ladi)
maydonidan dyuymdagi chiziglar soniga o‘lchanadigan chiqgarish
qurilmasining rastr lianiturasini kiriting (Ipi — lines per inch),
ya'ni tipografiyada ishlatiladigan giymat (3.69-rasm). Umumiy qilib
olganda Descreen filtri o‘zining nastroykasiga ega emas, uni fagat
o‘chirish yoki go‘shish mumkin. Ba’zi bir paytlarda skaner
giladigan dasturlarda muarni yoki poligrafik rastrni pasaytirish
uchun yuvish filtrlari ishlatiladi. Shularni e’tiborga olib skaner
gilishda bularni ko‘zda tutish kerak.
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5. Quality (KauectBo) da Draft (O6braHOE)ga qo‘ying, bu rastr
lianiturasi 1 tengligini bildiradi, Good (Xopoiuee) — rastr lianiturasi
1,5 ga teng Best (JIyuiuee) — rastr lianiturasi 2 ga teng.

6. OK tugmasiga cherting.

7. Resolution (PaszpeweHue) maydon giymatini yozing, u
Image Size oynasida Document Size (Pazmep HOKyMcHTA)
guruhida joylashgan. Skaner gilish paytida ana shu giymatni kiritishni
esdan chigarmaslik kerak bo‘ladi.

Auto Resolution m
Screen: [linesicm =] |___OK
Quality — Cancel I

(" Draft
& Good
" Best

3.69-rasm. Tasvir o‘lchamining o‘zgarishi.

Agarda keyinchalik masshtabni kattalashtirmoqchi/kichik-
lashtirmoqchi bo‘lsangiz, arjataolishni shu masshtabga ko‘pay-
tirish kerak, shundagina skanerning ajrataolishi to‘g‘ri berilgan
bo‘ladi. Agarda tasvirni masshtablashni skaner gilish paytida amalga
oshirsangiz u holda bu amalni bajarish shart emas.

8. OK tugmasiga cherting. Endi tasvirga ajrataolish to‘g‘ri qo‘yildi.

3.2—3.3-jadvallarda ma’lumotlar keltirilgan, bular yordamida
skaner gilingan fayl hajmini va har xil ajrataolish bo‘lganida
chigarish qurilmalari va rastr lianiturasi qanday bo‘lishi berilgan.

3.2-jadval
Skaner qilingan fayllarning hajmlari
O‘lcham PPI Og-qora |Yarim ta’sirchanlik | SMYK rangli
(dyuymida) | (ajrataolish) (1 bit) (8 bit) (24 bita)
2x3 150 17 K 132 K 528 K
300 67 K 528 K 2.06 MB
4x5 150 56 K 440 K 1.72 MB
300 221 K 1.72 MB 6.87 MB
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8x10 150 220 K 1.72 MB 6.87 MB
300 879 K 6.87 MB 27.50 MB

Hajmlar fagat bitta kanal uchun berilgan (TIFF fayli uchun)
hech ganaqga alfa-kanal yo‘q.

3.3-jadval
Chigarish qurilmasi va rastr lianiturasi uchun
ko‘k rangning ta’siri
Rastr lianiturasini ajrataolish (LPI)
Chigarish 60 85 100 133 150
(DPI)

Lazerli printerlar| 300600 |26 101 | 1351 37 21
Fotoqurilmalar 1270 2540 256* 1224 256%| 162 256%| 92 72
256* |256*

Bosmaxonada tasvir faylini yaratganda ganday rastr lianiturasini
o‘rnatish kerakligini biling. Fotoqurilmalar uchun ganday
ajrataolish bo‘lishini biling. Bir xil fotoqurilmalar 2540 dpi yuqori
bo‘lgan ajrataolishga ega bo‘ladi.

Web-grafika uchun ajrataolish

Setlar uchun tasvirlar yaratganda avval foydalanuvchi brauzer
oynasi o‘lchamini bilishi, keyin shu tasvir yordamida oynani qaysi
tomonini yopmoqchi ekanligini ko‘rsatishi kerak. Setda o‘tirgan
foydalanuvchi monitoringni ajrataolish gancha bo‘lishini ham
bilishingiz kerak. Web-saytda websnapshot. com bergan ma’lumotiga
garaganda, foydalanuvchilar monitorlarning yarmidan ko‘pi
800x600 pikselda ekan. Agarda pancllarni va surgich yo‘lakchasini
hisobga olsak, ish maydoni 740x460 pikselda goladi. Ko‘pchilik
setdan foydalanuvchilarda monitoring brauzer oynasi bilan
to‘ldirilmaydi, shularni hisobga olib, 660x420 dan katta bo‘Imasligi
kerak.

Bosh hujjat yarating, ajrataolish 660x420 pikselli, har bir
dyuymga 72 pikselda to‘g‘ri kelar ekan, buni shablon qilib oling.
Ish paytida hujjatni fon tarzida bering, sababi Web-sahifa uchun
tasvir yaratganda ekranning gaysi tomonida ekanligini bilish kerak.
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Holt satridan foydalanish

Windows sistemasida ishlaganimizda Window > Show Status
Bar (Oxno > IToka3zaTh CTpOKy cocTosiHusI)ni tanlang, bu holat
satri yordamida chigariladi yoki Hide Status Bar (Cnpsitats cTpoky
cocTosiHUs)Nni tanlang, bu esa, holat satrini ko‘rinmas holga olib
keladi.

Agarda uchib chiquvchi menyuda holat satr tasviridagi
go‘shimchaning pastida joylashgan bo‘lsa, Document Sizes
(Pazmepnr mokymeHTa) belgilangan bo‘ladi. Holat satrida tasvirning
saglanadigan qatlamlari biriktirilgan (birinchi ragami) fayl hajmi
va ko‘p qatlamli tasvirlar uchun fayl hajmi beriladi (ikkinchi
raqami) — 3.70-rasmda berilgan.

v Document Sizes
Document Profile
Document Dimensions

. Scratch Sizes
- i‘h Efficiency
= Timing
| 100% | L Doc: 471K/471K ) Cunent Taol

3.70-rasm. Holat satridan kerakli bo‘lgan ma’lumotni olish uchun menyu.

Agarda Document profile (ITpodwis nokymenra) aktivliash-
tirilgan bo‘lsa, u holda holat satrida hujjatning rang profillari berilgan
bo‘ladi, agarda hujjat hech qanday profilga ega bo‘lmasa u holda
«Untagged» so‘zi chiqariladi.

Scratch Sizes (O6bem mamsaTu) punktini tanlashda holat
satrining chap tomonida ochiq bo‘lgan hujjatlarning hajmi, o‘ng
tomonida esa, Photoshop dasturi uchun operativ xotiradan
egallagan hajmi beriladi. Agarda birinchi son ikkinchisidan katta
bo‘lsa, u holda dastur vertual xotiradan foydalanayotgan bo‘ladi.
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Efficiency (DddekTuBHocTh) opsiyasini tanlab, dasturni
gancha vaqt operativ xotirada ishlaganini ko‘rsatadi. Agarda 100%
dan kam bo‘lsa, u holda diskdagi vaqtincha joydan foydalangan.

Current Tool (Texkywuit macTpymeHT) punktini tanlash
natijasida joriy vaqgtda ishlayotgan asbob hagida ma’lumot beriladi.

Bulardan tashgari, holat satri ustida sichqonchani ushlab turib,
sahifani berilgan qog‘oz o‘lchamlarga mos kelishini tekshirib
ko‘rasiz (markerlarni ham hisobga olgan holda).

Fayl hajmi

Windowsda ishlaganda, tasvir faylining haqigiy hajmini
ko‘rmoqchi bo‘lsangiz, Windows Explorer yordamida bizlarga
kerakli bo‘lgan fayl joylashgan papkadan Size (Pa3mep)
kolonkasini ko‘ramiz (3.71-rasm). Yanada aniq sonlarda ko‘rmoqchi
bo‘lsangiz fayl piktogrammasini sichqonchaning o‘ng tomoni
bosiladi va paydo bo‘lgan menyudan Properties (CsoiicTBa) ni
tanlaymiz.

Holat satrining uchib chigadigan menyusining qaysi opsiyasi
tanlanganidan qat’i nazar, Alt tugmasini holat satri ustiga olib
borib bosib turib, tasvirni fayldagi hajmini, kanallar sonini, ganday
rejimda ekanini va ajrataolishni ko‘rsa bo‘ladi.

__JDroplets MNanka ¢ darnamm 26.06.2002 13:55
1 ImageReady Animations Nanka ¢ hannamu 28.06,2002 13:55
'&Banner 2669KE Adobe Photoshop 1., 12.03.2002 12:28
:JDucky 287 KB  PucyHok TIF 06.04.2002 15:57
ﬂ Dune 1068 KE PucyHok TIF 06.04.2002 15:57
'gEagle 1614KE Adobe Photoshop I...  12.12.2001 12:03
'Q Flower 3941 K6 Adobe Photoshop ... 16.01.2002 11:53
ﬁjHarvast 43106 Adobe PhotoshopI... 02.04.2002 21:11
'Q Morning Glass 5586 K6 Adobe PhotoshopI... 02.04.2002 21:11
£ 0ld Image 174 KE Pucyrok JPEG 02.04.2002 21:11
:] Palm Tree {CMYK) 789KE  Pucynor TIF 06.04.2002 15:57
E} Pasts 1323 K6  PucyHor JPEG 02.04.2002 21:11
5] Peppers ZI1GKE Pucysox JPEG 0z2.0¢4.2002 21:11
'_g‘.Piccolo site 2299K6 Adobe PhotoshopI...  02.04.2002 21:11

3.71-rasm. Fayllar hagida ma’lumot beruvchi oyna.
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Yangi tasvirni yaratish

1.File > New (®aiin > Hosblif) ni tanlang yoki Ctrl+N
tugmalar majmuasidan foydalaning.

2. Name (Mms) maydonida ganday nomga ega bo‘lishini ko‘ring —
3.72-rasm.

3. Menyudan Width (Illupuna) va Height (Bbicota) may-
donining enidan o‘lcham birliklarini kiriting.

4. Width va Height giymatlarini bering.

5. Resolution (PaspeiueHue) parametrining ajrataolish giymatini
bering.

6. Mode (Pexum)ning uchib chigadigan menyusidan tasvirning
rejimini tanlang. Keyinchalik tasvirni boshqa rejimga o‘tkazsa ham
bo‘ladi (rejimlar hagida 2-bo‘limda kengroq berilgan, «Tasvir
rejimlari»).

7. Contents (Conepxumoe) o‘tkazishni White (bebrit) ga yoki
Background Color (®oHoBbIN 11BeT)ga qo‘ying. Fon rangini ganday
tanlashga 10-bo‘limda to‘xtab o‘tiladi. Yoki Transparent
(I'Mpo3paunblii) opsiyasini belgilang, agarda fonni tasvir gatlamiga
aylantirmoqchi bo‘lsangiz.

New
Marme: | OK |

— Image Size: 1.37M Reset |
Preset Sizes: | 800 x 600

Width: 500 | pixels

Height: |6DD Ipixels

Lel Le] Le] Lo

Resolution: |28,346 | pixels/crm

Mode: [RGB Color ¥

— Contents
" White
" Background Color
* Transparent

3.72-rasm. Yangi tasvirning parametrlar oynasi.
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“\&i Untitled-1 @& 100% (RGB) =] B3

3.73-rasm. Yangi — nomlanmagan tasvirning oynasi.

Bir yoki bir nechta gatlamga ega Photoshop formatlarning biri
PDF yoki Advanced TIFF kengaytmali fayllarda saglanadi. Agarda
siz faylni boshqa qo‘shimchaga eksport gilmoqchi bo‘lsangiz,
tasvirning gatlamlarini biriktirib, nusxasini boshqa formatda saglash
kerak, sababi bir xil qo‘shimchalar tiniq bo‘lgan qatlamlarni gabul
qiladi. (Qatlamlar haqgida keyingi 7 va 14-bo‘limlarda kengroq to‘xtab
o‘tamiz.)

8. OK tugmasiga cherting (yoki Enter tugmasi). Tasvirlash
oynasi chiqariladi (3.73-rasm).

Photoshop dasturidagi tasvirlarni ochish

Adobe lllyustrator faylini ochish uchun quyidagi ko‘rsatmadan
foydalaning: «EPS, PDF formatli fayllarni ochish yoki
Illyustratorda ganday qilib yangi tasvirni yaratish»; «fayllarni EPS,
PDF formatlariga joylashtirish; Photoshop dasturidagi Illyustrator
yordamida fayllarni yaratish».

1. Menyuning File > Open (®aiin > OtkpbeiTh), File >
Browse (®aiin > IIpocmotp) buyruglarini tanlang yoki Ctrl+O
tugmalar majmuasidan foydalaning.
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2. Ochish kerak bo‘lgan faylni tanlang (3.74-rasm). Agarda tasvir
kichiklashtirilgan nusxada saglangan bo‘lsa, tasvirni ko‘rish uchun
Show Preview (IlpensapurenbHblii mpocMmoTp)ga sichqoncha bilan
cherting. Agarda File > Browse yordamida ochgan bo‘lsangiz, hamma
tasvirlar kichiklashtirilgan formatda berilgan bo‘ladi, xohlaganini
sichqoncha yordamida tanlab ko‘rsa bo‘ladi (3.75-rasm).

Open ﬁ E
Denca: [y Lo_te: = B & o = w8 &l
1= 6001, {4 6007 il 1 60130 1 60" 9.

60025 [ so0atif 3 60144t 2] B020.tif
(@] 6003 8¢ (2] 6003t (3] 6015.1i [ 6021.tf
{2] 6004.5¢ [ 60101t 3 6016.1i [# 6022.if
26011 i (@ so17.xt 6023 tf
B eo12u [# so10.u [ e024.f
|
Mo weitina. [6017 i
Tungaume: [al Fomats =l Otiera |
Fie Size: 47°K. 2

3.74-rasm. Faylni ochish.

3 Tilo Diowsar

Filesanve 6001 T
Date Created 283602 04:46:34
Date Modified 12109510 23:249
tmage Format TIFF

Width 430

L]

a lezphe Vs K

3.75-rasm. Browse yordamida
fayllarni ochish.
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Miniatyurani yaratish bir
gancha vaqtni olishi mumkin,
agarda katalogda tasvirlar soni
ko‘p bo‘lsa, u holda qgiyinchilik
tug‘diradi.

Hamma formatli fayllarni
ckranga chigarish uchun Files
of type (Tumbr aitios) uchib
chigadigan menyusidan All
Formats (Bce ¢dopmaTtnn)
variantini tanlash kerak.

Tasvir ochilgandan keyin
uni Photoshop dasturidagi
mavjud formatlarda saglash
mumkin.

Agarda siz ochmoqchi bo‘l-
gan fayl nomi, fayllar ro‘y-



xatidan chigmasa, bu format uchun Photoshop dasturida modul
mavjud emasligini bildiradi. Uni o‘rnatish kerak bo‘ladi.

3. Fayl nomini ajrating va Open (OTKpbITh) tugmasiga cherting
yoki fayl nomini ikki marta sichqoncha bilan cherting.

CETT S .o

.Qéﬁn [paexa Bua  VeBpanmoe Copenc  Cnpaska I I,’ J

= P a ( s
Q Hazaa ~ \‘) - j.l l 7 ) Nowmce ’;_/ Narkia ' l
Aapec: IL_) Ci\Pragram Files\AdabelPhotoshop 7.015zmplzs ;] MNedzexoa |
i Manku X —_— -
@ () 120C CUPLUS N ) | e REEUTRD
| ™ iQ Accessories /, [
| [ ) Adaptec ‘ =
| B [ Adobe \ iﬁ_z’
‘ =l (=) Photoshop 7.0 Rl

® () Help
[ 1) lelgers

I Legal =
[ 12 Plug-Ins = » ‘9
[ () Presets R ‘
¥ 1) Required
‘ [ 1) Samples
# 1) cheed
= u_] CHAT Garnier Cucky
[ 1) Cunmn Files

) ComPlus Applicctiors
| @ 3 DIRECTS

1) v -
Ky I ;l—l

3.76-rasm. Windows Explorer dasturidagi Photoshop formatining
fayl belgisi.

Draplets TmageReaty animatinns

Profillar mos kelmagan holda 2-bo‘limda berilgan yo‘rig-
nomadan foydalansa bo‘ladi.

Yana bir formatlar uchun yana bir mulogot oyna chigariladi.
Masalan, agarda EPS, Adobe lllyustrator yoki PDF-fayllarni
ochganda, tasvir hali vektor ko‘rinishidan rastr ko‘rinishiga o‘tka-
zilmagan bo‘lsa, u holda Rasterize Generic Format (Pactepusanus
(opmara) oynasi chigariladi. Bu hagda «EPS, PDF formatli yoki
Illyustrator dastur fayllarini ochish» bo‘limida kengroq berilgan.

Bir xil formatlarni ochish uchun maxsus modullar kerak bo‘ladi,
masalan, Scitex Ctrl yoki PICT Resource. Bularga o‘tish File > Import
(®aitn > Mmmopr) menyudagi buyrugni tanlash orgali bo‘ladi.
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Fayl ochilganda aniq formatni ko‘rsatish uchun menyuning
File > Open As (®aiin > OTkphITh Kak) buyruqlarini bajaring va
ochilgan menyudan kerakli format tanlanilib, keyin Open
(OTkpBITH) tugmasini bosing.

Joriy oynalar orasidan bir-biriga tez of‘tish uchun «gaynogq»
tugmalardan Ctrl+Tab foydalaning.

Yaqinda yopilgan faylni ochish uchun menyuning File > Open
Recent (Paitn > HepnasHo otkpriThie) buyruglaridan foydalaning.

Miniatyuralar

Windows sistemasida ans Toro, IlpoBoaHuk (Windows
Explorer) dasturi uchun tasvirlarni miniatyura nusxalarini
yaratishga tog‘ri keladi, bu menyuning Views (Buag) da Large
Icon (KpymHble 3HauKM) opsiyasi tanlanganda ekranga chiqariladi.
Miniatyurani yaratish uchun faylni xotirada saqlaganda Save
Thumbnail (Coxpanuts obpaseir)ga bayroqcha qo‘yish kerak. Agarda
Open (OtkpbiTh) oynasiga chigariladigan hamma fayllar ketma-
ketligi uchun miniatyuralar gilish kerak bo‘lsa, Edit > Preferences >
Saving Files (TIpaBka > VYcraHoBku > CoxpaHeHHe ¢DailioB)
oynasini oching, Image Previews (IIpeaBaputenbHbIi MpocMoTp
n3zobpaxenuin)maydonini tanlang va Always Save (Bcerpa
COXpaHATb) variantini tanlang (3.77-rasmga garang). Miniatyuralarga
ega bo‘lish uchun tasvir fayli quyidagi kengaytmalarning biridan
iborat bo‘lishi shart: PSD, JPG, PDF yoki TTF. Fayllarni saglagan
paytda miniatyuralarni paydo qilish uchun, Image Previews
(ITpenBapuTeabHBINA IPOCMOTP U300paxeHMit) maydonidan Ask
When Saving (CnpaluuBaTh NpU COXpaHeHUHU)ni tanlang.
Tasvirning ba’zi bir o‘lchamga ega bo‘lgan miniatyurasi xotirada
saglangandan keyin faylning hajmi ham Xkatta bo‘ladi. Keyingi
ketma-ket saglanadigan tasvirlar uchun Open (OTkpbiTh) faylining
ochilish oynasida ko‘rinishi uchun Windows Thumbnail
(Mwunuariopa Windows) ga bayroqcha qo‘yish kerak.

Kodak Photo CD faylini ochish

Photoshop dasturida Kodak Photo CD formatli fayllar Kodak
PCD Format (®opmar Kodak PCD) mulogot oynasi yordamida
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ochiladi. Photo CD formatli tasvir RGB yoki Lab Color formatli
ko‘rinishlarga o‘tkaziladi.

1. Menyuning File > Open (®aiin > OtkpwiTh) buyruglarini
tanlang yoki Ctrl+O tugmalar majmuasidan foydalaning.

2. Photo CD formatli faylni toping va uning nomiga ikki marta
cherting yoki Photo CD formatli fayl nomini ajrating va Open
(O1kpbITH) tugmasini bosing.

Preferences

| General ~|
Color Picker: | Adobe ~]
interpolation: | Bicubic (Better) ~|

Reda Key: | Ctrl+Z (Toggles Undo/Redo)  »|  Histary States: |20

Print Keys: | Ctrl+P: Print with Preview / Ctrl+Alt+P: Print _v_]

3.77-rasm. Windows sistemasida fayllarni saglash
rejimlarini o‘rnatish.

3. Source Image (McxonHoe uszoOpaxenue) guruhi 3.78-
rasmda berilgan parametrlariga o‘tish uchun Resolution
(Paspenrenne) giymatini tanlang. Tasvir o‘lchami 768x512 pikselli
bo‘lsa, 10,5x7 dyuymli joyni egallaydi. Tasvirning eni, uzunligi
Resolution (Paspemenue) uchib chiquvchi menyuda beriladi.
Ma’lumot Kkiritish profilini uchib chiquvchi menyu Profile
(TTpounsw) tanlaydi. Image Info (Mudopmauuss o6 uzobpa-
xeHun) maydonida skaner va plyonkaning turi hagida ma’lumot
bo‘ladi.

4. Destination Image (LlesieBoe uzoOpaxeHue) parametrlar
guruhida ochiq bo‘lgan tasvirlar qo‘llaniladi. Bu giymat tasvir
o‘lchamlari bilan birgalikda tasvirning ekrandagi hajmini beradi.
Ochiq turgan tasvirga ranglar sohasini tanlang (RGB yoki Lab).
Kerakli yo‘nalishga Orientation (Opuenrtaiusi) bayrogchasini
go‘ying.

5. OK tugmasiga cherting. Photoshop dasturining ekranida tasvir
ochiladi.
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Kodak faylining profillari

Kodak kompaniyasi 4045 va 4050 modellarini plyonkadan o‘qish
uchun va yana boshga 3.4 versiyali profillarini PhotoCDda almashtirish
uchun ishlatiladi (3.4-jadval).

3.4-jadval
Kodak faylining profillari
Profil Qo‘llanishi
Photo CD 4050E-6 V3.4 Ektachromeda 4050 modelga skanerlash
Photo CD 4050K-14 V3.4 Kodachromeda 4050 modelga skanerlash
Photo CD Color Rangli negativlardan kichik modellarga
Negative V3.0 skanerlanadi yoki hech ganaga modeli
ko‘rsatilmaydi

Photo CD Universal E-6 V3.2 Universal Ektachromedan kichik modellarga
skanerlanadi yoki hech ganaga
modeli ko‘rsatilmaydi

Photo CD Universal K-14 V3.2 | Universal Kodachromedan kichik modellarga
skanerlanadi yoki hech ganaga modeli
ko‘rsatilmaydi

DCS 2.0 Format | X

K

Preview: |SLZRaRe =]

Ji

DCS: | Single File DCS. No Composite

Lef Lo

Encoding: | Binary

™ Include Halftone Screen
[ Include Transfer Function
15 clde s Erterbata

[ Image Interpolation

3.78-rasm. Windows sistemasidagi DCP formatning mulogot oynasi.

EPS, PDF formatli fayllarni yoki Illyustrator dasturining
fayllarini yangi tasvir sifatida ochish

Fayllar EPS yoki Adobe lllyustrator formatlarida bo‘lsa, ularni
Photoshop dasturida ochish va joylashtirish uchun ularni berilgan
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obyektga mo‘ljallangan formatdan Photoshop formati rastrli
ko‘rinishga o‘tkaziladi. Quyida berilgan EPS yoki Adobe Illyustrator
formatli fayllarni ochish uchun yo‘rignoma bo‘yicha ishlang. Yoki
bo‘lmasa «EPS, PDF yoki Adobe Illyustrator dasturidagi fayllarni
Photoshop dasturida ochish» bo‘limiga qarang, bunda EPS—fayli
Photoshop dasturini mavjud formatda ochadi.

Bitta betli PDF-faylini ochish uchun Open (OTKpbITb)
buyrug‘idan yoki Place (Pa3mectuth)dan foydalaning. Agarda
ko‘p sahifali PDF—faylni ochmoqchi bo‘lsangiz, File > Automate
> MultiPage PDF to PSD (®aiin > ABromatusauus >
Muoroctpaununbiit PDF B PSD) buyruglarini tanlang. Bu hagda
keyingi bo‘limlarda kengroq, «PDF formatli fayllarni Photoshop
dasturli formatiga o‘tkazish»da berilgan.

Photoshop dasturida Illyustrator 9 va 10 fayllari uchun maxsus
format ishlatiladi.Generic PDF (ue EPS).

1. Menyudan File > Open (®aiin > OtkpbiTh) buyruglarini
tanlang yoki Ctrl+0O tugmalar majmuasidan foydalaning.

2. Agarda Files of type (Tun ¢aitioB) menyusida fayl nomi
yo‘q bo‘lsa, u holda All Formats (Bce ¢opmarbi)ni tanlang.

3. Ochish lozim bo‘lgan faylni toping va ajrating, keyin Open
(OTkpeiTh) tugmasiga cherting yoki ikki marta faylni nomiga
cherting.

Bir sahifadan ko‘p
Select the Page to Open: — e bo‘lgan PDF—fayli ochil-
o U . o ganda, boshgacha mulogot

: :, oynasi ochiladi (3.79-rasm).
[ x| Bu yerda «oldiga» yoki

«orgaga» yo‘nalishlarini
bosish orqali, o‘zingizga

i kerakli bo‘lgan sahifani

3.79-rasm. Ko‘p sahifali topamiz va OK tugmasini
PDF—faylni yuklash. bosamiz. Yoki bo‘lmasa, Go

bo: page: (Msholn &
cTpaHule...) tugmasini

o toPage: [l Lo« | bosamiz, kerakli bo‘lgan

Cancel | sahifa ragami kiritiladi va
OK tugmasiga ikki marta

bosamiz (3.80-rasm).

3.80-rasm. Sahifalar
nomerini kiritish oynasi.
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4.0zingizning ix-
tiyoringizda. Rasterize = imegesie 20¢ ok |
Generic EPS (w11 PDF) o N D :I]c cancel_|
format (Pactepusauus gtz Sa  |fcm |
¢dopmarta Generic EPS Resoluton: I pisets/nch ¥
(unn PDF)) mulogot Mode: | CMYK Color =
oynasidagi Constrain I antialiased ¥ Constrain Propartions

Proportions (CoxpaHsiTh
nporopimu)ga bayrogcha 3.81-rasm. Rasterize Generi_c EPS
o‘rnating, bu tasvirning ormat ymlogot oynas
bo‘yi va eni saqlanishi

uchun shunday qilinadi

(3.81—3.82-rasmlar). Image Size: 1.IM [ ok |
5.0¢‘zingizning ix- wanfes den  Z7g| Lo |

tiyoringizda. Menyudan g2 | om |

Width (Llupuna) va Besohtion: [ [oets/ncn =]

Height (Bwicora) may- Mode: | CMYK Color 2|

donida shunday o‘lcham P ittoiieel  GanvonBYmectos

birliklarini tanlang va tas-
vir o‘lchamini bering.

6. Resolution (Pa3-
pewieHue) maydonidan
sizning tasviringiz uchun ajrataolish giymatini kiriting. Bu yerda
tasvirni almashtirmasdan avval giymatlarning tog‘ri berilishi sizning
tayyor tasviringiz sifatini yaxshilaydi.

7. Mode (Pexum) uchib chiquvchi menyudan tasvir rejimini
tanlang (2-bo‘limdagi «Tasvir rejimlari»ga gqarang).

8. Anti-aliased (CriaxwuBanue)ga bayroqcha qo‘ying, bu
o‘tish notekisliklarni yo‘qotadi va o‘tish chegarasini yumshatadi.

9. OK tugmasini cherting.

Agarda PDF—faylida xavfsizliklar qo‘yilgan bo‘lsa, ularni
Acrobat Exchange yordamida olib tashlash kerak, keyin faylni
ochish mumkin bo‘ladi.

PDF va EPS—fayllar tiniq (npo3paunbiit) fonda beriladi. Oq
fonni olish uchun yangi gatlam yarating, fon rangini oq qiling
(yoki o‘zingiz xohlagan rangni tanlang), keyin quyidagi
buyruglarni bajaring Layer > New > Background from Layer
(Cnoir > Hoseiit > ®oH U3 ciios).

3.82-rasm. Rasterize Generic PDF
format mulogot oynasi.
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EPS, PDF yoki Adobe Illyustrator dasturining fayllarini
Photoshop dasturida mavjud bo‘lgan faylda ochish

Sizlar obyektga mo‘ljallangan

(vektorli) tasvirlarni Photoshop

dasturida ochmoqchi bo‘lsangiz, Paste As: R

u holda rastr ko‘rinishiga aylanadi  Pixels it :

va Photoshop dasturidagi fayllar " Path

formatlariga tushadi. Ajrataolinish " Shape Layer

gancha yuqori bo‘lsa, rendring =

natijasi shuncha yuqori bo‘ladi. 3.83-rasm. Paste mulogot
Shu bilan birga Illyustrator oynasi.

dasturi oynasidagi konturni
Photoshop dasturiga olib o‘tish ham mumkin, bu holda kontur
yangi gatlamda paydo bo‘ladi.

1. Photoshop dasturidagi tasvirni oching.

2. File > Place (®ai1 >
PazmecTtutp) menyusidan e [ = &l @l &= sl
buyrugni tanlang.

3. Ochilishi kerak bo‘lgan
faylni toping va ajrating
(3.84-rasm). Agarda ko‘p
sahifali PDF—faylini och- Cae
moqchi bo‘lsangiz, u holda oo D |
kerakli sahifa tanlanib, OK Fie Size
tugmasi bosiladi.

4. Place (Pa3smectutnb)
tugmasini bosing. Tasvirning
yuqgori gismida ramka hosil bo‘ladi. Agarda kerak bo‘lsa, bu
yangi rasm shu oyna ichidan chiqishi uchun pastga bosing
(3.85-rasm).

5. O‘z ixtiyoringizda. Quyidagi berilgan buyruglar ketma-
ketligini bajaring (Undo buyrug‘i yordamida xohlagancha orgaga
gaytarsa bo‘ladi).

Rasmning o‘lchamini o‘zgartirish uchun ramkalarning chega-
ralovchi manipulyatorini torting. Shift tugmasini bosib, tasvirni
o‘zgartirilgan holda xotirada saglasa bo‘ladi.

Tavsirni bir joydan ikkinchi joyga surish uchun sichqoncha
yordamida ramka ichkarisiga cherting va sichqoncha tugmasi bosil-
gan holda tasvirni boshqga joyga olib o‘ting.
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3.84-rasm. Place mulogot
oynasi.



\, Camny eps @ 100% [CMYK)

3.85-rasm. Adobe illyustrator dasturida yaratilgan «Delphi» so‘zini,
Photoshop dasturidagi faylga joylashtirish.

3.86-rasm. Photoshop
dasturiga Illyustrator dasturida
yaratilgan notalarni o‘tkazish.

Agarda tasvirni aylantir-
moqchi bo‘lsangiz, kursorni
ramka tashqarisiga joylashti-
ring va sichqoncha tugmasini
bosilgan holda aylantiring.
O‘glarga nisbatan aylanitirish
uchun markaziy nuqgtasini ham
boshqa joyga o‘zgartirsa bo‘ladi.

6. Tasvirni turgan holatini
saglab qolish uchun Enter
tugmasini bosing yoki che-
garalovchi ramka ichiga ikki
marta cherting (3.86-rasm).

Tasvirni o‘chirmogchi bo‘l-

sangiz Esc tugmasini rastr ko‘rinishidagiga almashtirish paytida
yoki oldin bosish kerak. Agarda bu amal bajarilgan bo‘lsa, u
holda Layers (Cnou) palitrasidagi bu gatlamni Trash (Yaaautb)

tugmasiga olib borib tashlang.



Fayllarni xotiraga saqglash

Yangi yaratilgan tasvirlarni xotiraga saqlash

1. File > Save (®aitn > Coxpanutb) buyrug‘ini tanlang yoki
Ctrl+S tugmalar majmuasidan foydalaning.

2. File name (Ums ¢aiina) maydonidan fayl nomini kiriting.

3. Faylni diskdagi joylashadigan joyini aniglab bering. Agarda
joriy papkadan yoki diskdan boshqga joylarga joylashtirmoqchi
bo‘lsangiz, muloqot oynasining yuqori qismida joylashgan
menyudan kirib ko‘rsating.

4. Save As (Coxpanutb Kak) uchib chiquvchi menyusidan
fayl formatini tanlang (3.87-rasm). Agarda tasvir ko‘p qatlamli
bo‘lsa, ular Photoshop dasturining formatlari Advanced TIFF va
Photoshop PDF larda saglanadi.

5. Save (Coxpanutb) guruhiga kerakli bo‘lgan bayroqchalarni
go‘ying; shu bilan birga ranglar uchun ham bayroqcha qo‘ysa bo‘ladi,
agarda fayldagi profillar mavjud bo‘lsa bu Color: Embed Color
Profile (LIBeT: BcTpoeHHbIit LBeTOBOM mpoduib) yordamida
bajariladi.

Save As 2] x| |
foma [S e EEEEET
i 1) 6007.1if 8] 6013t Il 6019,
8 s008.f ) s014.1i [ s020.1t
=) o096 [ s015.6f [ 6021.tt
6010t ) 6016.tif 8 s022.1i
8 6011 4 ) 6m 7.1t ) 6023 it
[l so12.f [ s018.tf (8l 6024t
|
s paiina:  [60251
Format: | TIFF (=TI TIFF) =~ Orrena |

Photoshop [PSD* POD
Photoshop EPS [*EPS)
Save: Photoshop DCS 1.0 (~EPS)
Photoshop DCS 2.0 (*EPS)
JPEG [“JPG;*JPEG;" JPE)
Photoshop PDF (= PDF;* PDF)
Raw (*RAW)

| Tt [V Use Lower Case Extension

3.87-rasm. Save As muloqot oynasi.
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6. Save (Coxpanutp) tugmasini bosing.

Qatlamga ega tasvirlarning nusxalari gatlamlarsiz avtomatik
tarzda saqlanishi uchun Maximize backwards compatibility in
Photoshop formats (MakcumanbHasi COBMECTUMOCTb (DOPMATOB
Photoshop) ga bayroqcha qo‘yilishi kerak. Bu amal tasvirni boshqga
go‘shimchalarga export gilinishda qo‘l keladi.

Qatlamlar, vektorlar va effektlarni saglash

Faqat Photoshop formatlarining ichida, Advanced TIFF —
Photoshop PDF yordamida quyidagi elementlar saglanadi:

¢ Bir nechta gatlamlar va qatlam tinigligi;

¢ Tuzatish mumkin bo‘lgan gatlamlar;

e Mubharrirlashning matn gatlamlari;

e Qatlam effektlari;

e To‘rlar (setka) va yo‘naltirilgan chiziglar;

e [CC—ranglarni boshqarish profili (PICT, JPEG, DCS va
EPS formatlarida), shu bilan birga profillar ham saqlanadi;

e Lab tasviriy rejimlari (EPS va DCS formatlarida rejimning
o‘zini ham saqglaydi).

Duotone rejimidagi tasvir Advanced TIFF formatida saglana
olmaydi.

Qatlamlarni tasvirlarning nusxasi tarzida birlashtiring, bu
original tasvirda bo‘lmasin, keyinchalik ko‘p qatlamli tasvirlar bilan
ishlash mumkin bo‘ladi.

Save (Coxpanutb) buyrug‘i bajarilganda oldingi tasvirning
nusxasini yangisi bilan almashtiriladi.

Mavjud bo‘lgan tasvirlarni saqlash

Tasvirni saglash uchun File> Save (®aiin > CoxpaHurtb)
buyruglarini tanlang yoki Ctrl+S tugmalar majmuasidan foydalaning.

Oxirgi saglangan nusxasini qaytarish

File > Revert (®aiin > OOpartuthk) buyrug‘ini bajarish
natijasida, hujjatning saglangan oxirgi versiyasini orqaga gaytaradi.
History (Mcropus) palitrasi bo‘lsa, bir nechta amallarni orqaga
gaytarish imkoniyati bor. Uning sherigi — History Brush (Boc-
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craHaBJiMBawoLasi KMCTh) asbobi bo‘lib, bu — tasvirning ba’zi bir
joylarini qayta tiklash amalini bajaradi. Revert buyrug‘i History
panelida alohida vogeaga bo‘lib beriladi, demak, bu amalni xohlagan
paytda oldin bajarilgan vogealarni bosib orgaga qaytarish mumkin.

Tasvirning yangi versiyasini saqlash

Save As (Coxpanutsb Kak) buyrug‘idan foydalanib, tasvirni boshga
rejimda saqlash mumkin yoki dizayn variatsiyasi uchun nusxadan
foydalansa bo‘ladi. Masalan, tasvirni CMYK versiyasida saqlash
mumkin, berilgan tasvirning o‘zini RGB rejimida qgoldiramiz.

1. File > Save As (®aii1 > Coxpanuth Kak) buyrug‘ini tanlang
yoki Ctrl-H Shift+S tugmalar majmuasidan foydalaning.

2. Faylga yangi nom bering yoki oldin berilgan fayl nomini
o‘zgartiring. Bu amal File name (Mwmsa ¢aiina) (3.88-rasm)
maydonidan Kkiritiladi. Use Lower Case Extension (Pacuivpenue
cTpouyHbiMM OykBamMm) ga bayroqcha go‘ysangiz, u holda fayl
kengaytmasi kichkina harflar bilan yoziladi.

Save As 2] x|
s[5 R
[3 Droplets E Morning Glass.psd
|1 ImageReady Animations E Piccolo site.psd
'@ Banner.psd ﬂ Postcard.psd
'ﬁ] Eagle psd E Ranch House.psd
ﬁ Flower. psd ﬁ Tomato.psd
'@ Harvest.psd

[AEEESERTER P anch House. ps
_Omena |

Eormat: | Photoshop (PSD;* PDD) =l
SaveOptions - — -
Save: I Asa IF PErrotation
I= [ 210ba Shanrels Bl e Pele
I~ aye
V' ICC Profile: Grayscale - Gamma 2.2
I | Thumbre [V Use Lower Case Extension

3.88-rasm. Save As mulogot oynasi.
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3. Tasvirni yangi versiyasi saqlanadigan papkani tanlang.

4. Save As (Coxpanurtb Kak) uchib chiquvchi menyudan
faylning boshga formatini tanlang. Bunda faqat tasvirning joriy
rejimiga tegishli formatlar bilan ishlash mumkin.

Agarda tanlangan format ko‘p qatlamli bo‘Imasa, u holda Layers
(Cnou) opsiyasi bilan avtomatik tarzda ishlash mumkin bo‘lmay
goladi, saglangan tasvir bitta gatlamli bo‘ladi.

5. Save (Coxpanutb) va Embed Color Profile (Bctpouts
1BeToBOM mpoduiab) guruhlariga o‘zingiz xohlasangiz bayroqlar
qo‘ying, agarda bu opsiyalar bilan ishlash mumkin bo‘lsa.

Save As a Copy (Coxpanuth B Buie Kommm)ga bayroqcha
qo‘ying, bu fayl nusxasini olib qo‘yadi va original tasvir bilan
ishlashni davom ettiradi.

6. Save (CoxpaHuThb) ga sichqoncha bilan cherting. Agarda siz
boshqga formatlar bilan ishlamoqchi bo‘lsangiz Adobe Photoshop-
dan ma’lumotnoma olishingiz mumkin. Yangi fayl versiyasi ochiq
ko‘rinishda qoladi, joriy tasvir yopiladi.

Agarda siz fayl nomini o‘zgartirmoqchi bo‘lsangiz, fagat Save
(Coxpanutp) tugmasi chertilgan bo‘lsa, u holda eslatma oynasi
paydo bo‘ladi. O‘zgartirmoqchi bo‘lsangiz Replace (3ameHuTb)ni
cherting yoki Cancel (Otmena)ni cherting, bu amal oldingi
muloqot oynasini Save As (CoxpaunTb Kak)ga olib keladi.

3.4. Rastrli tasvirlar haqida tushunchalar

Bu dasturda esa tasvirning o‘lchamini, ajrataolishni qanday
o‘zgartirish, tasvirni kesib olish, tasvirlarni qanday aylantirishga
to‘xtalib o‘tamiz.

Photoshop dasturidagi o‘lchamlarni o‘zgartirganda joriy bo‘lgan
tasvirni ham saqlab qolish mumkin (Resample Image
(OtcaexuBaTh U3MeHeHMs) ga bayroqcha qo‘yilishi kerak), bunda
o‘lchamlari o‘zgartirilgan tasvirning aniqligi yo‘qoladi. Mana shuning
uchun tasvirlarni bir xil o‘lchamdagi tasvirlar bilan ishlashda
skaner qilish kerak yoki o‘sha o‘lchamdagi tasvirlar bilan ishlash
kerak. Agarda interpolyatsiyadan qochib bo‘lmasa, u holda ishning
oxirida tasvir aniq bo‘lishi uchun Unsharp Mask (Macka
HepeskocTH) filtridan foydalaning («Unsharp Mask filtrini
go‘llanishi»ni garang).
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Image Size | X

Pixel Dimensions: 628K (was 628K)
width:  [450 [ pixels j]@ Reset |
Height: 328 [ pixels ] avto_|

- Document Size:
wigth:  [17.28 [ cm |4
Height: [11.57 [ cm :j]m

Resolution:  [72 [ pixelssinch =]

[V Constrain Proportions

E

3.89-rasm. Image Size oynasi.

Bosmaga chigarish oldidan tasvirlar
o‘lchamlarini o‘zgartirish

I.Image > Image Size (M3o6paxenue > Pasmep
u3o0paxeHust) menyusining buyruqlarini tanlang.

2. Constrain Proportions (Coxpansith nporopuuu)ga bayrogcha
gqo‘ying, agarda tasvir eni uzunligini nisbatlarini saqlash kerak
bo‘lsa (3.89-rasm). Agarda enini uzunligiga bog‘ligsiz turda
o‘zgartirmoqchi bo‘lsangiz bayroqchani olib tashlang.

3.0z ixtiyoringizda. Tasvirni ajrataolishni saqlash uchun
Resample Image (OtciexuBaTth u3MeHeHMs1)ga bayroqcha qo‘ying.
3.90-rasmda berilgan interpolyatsiya usullaridan bittasini tanlang:
Nearest Neighbour (bauxaitmuit cocen), Bilinear
(bunuueitubiit) yoki Bicubic (bukybuueckwuit). Bikibik
interpolyatsiya tasvirining sifatiga kamroq ta’sir qiladiganlar turiga
kiradi.

4. Uchib chiquvchi menyudan Width (LLlupuna) va Height
(BoicoTa)dagi qiymatlarni tanlang, Document Size (Pa3mep
nokymeHTa) guruhida joylashgan bo‘ladi va bu giymatlar o‘lcham
birliklari turini bildiradi.
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Image Size B3 I
Pixel Dimensions: 628K
Width: 100 [percent =] ] i Reset |
‘ Height: [100 [ percent Ao |
— Documnent Size:

Width:  [430 | points

Height: [27.33 [ picas 3]3
Resolution: |28,346

IV Constrain Proportions
IV Resample jmage: | Bicubic ~|

pixels/cm

3.90-rasm. Image Size oynasidagi bayroqchalarni o‘rnating.

5. Berilgan Width (Llupuna) va Height (Beicota)ga yangi
tasvirning eni va uzunlik giymatlar sonini kiriting. Agarda Resample
Image (OtcnexuBath n3MeHeHMs1)ga bayrogcha qo‘yilmagan bo‘lsa,
ajrataolish o‘zgaradi.

6. OK tugmasini bosing.

Agarda avvalgi parametrlarni gayta tiklamoqchi bo‘lsangiz, Image
Size (Pasmep uzobpaxkeHus), Alt tugmasini va bir paytda Reset
(BoccranoButh) tugmasini bosing.

Shu bilan birga tasvirni bosmaga chiqgarishdan oldin o‘lcham
birliklarini o‘zgartirish uchun quyidagi oynadan foydalansa bo‘ladi,
bu oyna File > Print with Preview (®aiin > Ileuath ¢
NpeaBapyUTeSIbHBIM TTPOcMOTpoM) buyruglari yordamida chagqiriladi,
fagat tasvir ajrataolishi o‘zgaradi.

Bosmaga tasvirni chigarishdan oldin ko‘rish

Bosmaga chiqariladigan tasvirning o‘lchamlari qog‘oz o‘lcham-
lari bilan mos kelishi uchun sichqonchani oynaning pastki gismida
joylashgan holat satriga olib borib bosib turing yoki menyudan
File > Print with Preview (®aiin > Ileyats ¢ npeaBapuTeIbHBIM
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Ele npocMoTpom) buyruglarini tanlang. Agarda

e o | ekranda bosmaga ganday holda chiqarilishi
Browse... ShiteCti+0 kerak bo‘lganini chigarmoqchi bo‘lsangiz,
9 View > Print Size (Bun > Pasmep npu
Close P nevyatu) buyruglaridan foydalaning.
Semds,  shucis

S Yugqori ajrataolish

:3" - Skaner gilingandan keyin tasvir piksel-
Einat »| lar to‘plamidan iborat bo‘lib, uni bosmaga
Workgroup »| chigarishda o‘lchami va ajrataolishi bilan
Automate »| bog‘lig bo‘ladi. Agarda ajrataolishda yoki
Fie Info... tasvir o‘lchamlari o‘zgarganda piksellar soni
5“" saglanadigan bo‘lishi uchun Image >
Bii.. At Dl P Image Size (M3o006paxenue > Paszmep
Firitneopy ASHEORE | pagGpaxkenus)dan Resample Image
—’é:i““—w (OrcnexuBarh U3MeHeHUsT) bayroqchasi

olib tashlangan bo‘lsa. Agarda bu bayroqcha
3.91-rasm. Bosmaga qo‘yilgan bo‘lsa, tasvirni bosmaga
chiqarmasdan oldin  .1; 0 rishda ajrataolishning ko‘payib ketishiga
tasvirni ko‘rish. i A \ .. ;
va tasvir o‘lchamining kamayib ketishiga olib
keladi (1-dyuymdagi piksellar soni) yoki teskari holat bo‘lishi
mumkin.

Agarda faylda ajrataolish keragidan katta bo‘lsa, u holda (rastr
lianiturasidan ikki marta katta bo‘lsa), qo‘shimcha piksellarni
Document Sizeda, Resample Image (Teriepb mmpuHa, BbICOTa U
paspelieHue B3auMo3aBUCUMBI) bayroqchasini olib tashlab
joylashtirsa bo‘ladi va oxirida ikki karra katta bo‘lgan ajrataolishni
kamaytirsa bo‘ladi. Tasvirning eni, bo‘yi avtomatik tarzda
kattalashadi, fagat piksellar soni va fayl o‘lchami o‘zgarmaydi,
tasvirdan bitta ham piksel qo‘shilmaydi yoki olib tashlanmaydi.
Agarda tasvir o‘lchamlarini kattalashtirmoqchi bo‘lsangiz, Resample
Image (OtcnexuBaTh u3MeHeHUsT) bayroqchasini qo‘ying va Width
(LLImpuna) dan giymatlarni kiriting. Balandlik giymati proporsional
ko‘rinishda o‘zgaradi, fayl o‘lchami va piksellar soni ortadi, fagat
buning uchun interpolyatsiya kerak bo‘ladi, shuning uchun OK
tugmasini bosgandan keyin tasvirning ravshanligini orttirish kerak,
Unsharp Mask (Macka Hepeskoctn) filtridan foydalaning.
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Tasvirda ajrataolishni o‘zgartirish

Agarda ajrataolishni ko‘paytirsak, ya’ni Resample Image
(OrcnexuBath M3MeHeHus1) bayrogchani qo‘yib interpolyatsiya
qgilinsa, yangi piksellar qo‘shiladi, tasvirning fayl o‘lchami katta-
lashadi, fagat sifati pasayadi. Agarda ajrataolishni kamaytirsak, u
holda fayldan ma’lumotlar yo‘qoladi, fagat uni qayta tiklash uchun
History palitrasidan faylni yopishga qadar tiklash mumkin.
Tasvirdagi interpolyatsiyadan keyin yuvilgani fagat bosmaga
chiqarilganda bilinadi, ekranda uning fargi bilinmaydi. Mana shularni
e’tiborga olib tasvirlarni skaner qilish yoki mos o‘lchamda olish
tavsiya etiladi.

l.Image > Image Size (M3o06paxenue > Paszmep
u300paxeHus) menyusining buyruqglarini bajaring.

2. Tasvirning eni, uzunligi hagidagi ma’lumotlarni saqlash
uchun (eni va bo‘yi), Resample Image (OrciexuBarb
u3MeHeHusi)ga bayroqcha qo‘ying (3.92-rasm). Agarda tasvirdagi
piksellar sonini saglamoqchi bo‘lsangiz bayrogchani olib tashlang.
Balandligi va eni o‘zgaradi, fagat piksellarning umumiy soni
saglanadi.

3. Resolution (Paspewienue) maydoniga qandaydir giymat
bering.

4. OK tugmasini bosing.

Image Size X
~ Pixel Dimensions: 628K - [ox ]
Width: [ pixels :J]:Q Reset |
wegnt. [z [ooes o] |
— Documnent Size:
Width: [17.23 [ cm e
Height: [11.57 [ em ﬂ]g
Besolution:  [72 [ pixelszinch =]
v Ztrain Proportions
¥ Resample Image: | Bicubic =l

3.92-rasm. Resample Imageda bayroqchasi tasvir
interpolyatsiyasini boshqaradi.
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History Brush (BoccranasauBaiowasi Kuctb) asbobi
interpolyatsiya qilingandan keyin ishlamaydi. Joriy holdagi tasvir
bu asbob uchun avvaldan berilgan giymat bo‘lib hisoblanadi.

Berilgan o‘lchamga tasvir o‘lchamini olib kirish

Fit Image (IToporHate m3o0OpaxeHue) buyrug‘i tasvirning
ajrataolishga hech ganday ta’siri bo‘lmaydi, fagat uning
o‘lchamlariga ta’siri bor.

Tasvir o‘lchamlarini

Kichikkimrmodel: bo'l-
Constrain Within sangiz mana shu buyrug-
o]

dan foydalaning.
_ Cancel | I. File > Automate >

Fit Image (®aiin >
ABTroMmatuuecku > [lo-

width: [l pixels
Height: [323 pixels

3.93-rasm. Fit Image oynasining JOTHATh M300paxeHue)
buyrugqlari. buyruglarini tanlang
(3.93-rasm).

2. Tasvirning eni va balandligini piksellarda bering. Boshqga
maydonlarga avtomatik tarzda tuzatish kiritiladi, bular fagat OK
tugmasini bosgandan keyin bajariladi, shunday qilib, balandligi va
eni saqlanib golinadi.

3. OK tugmasiga cherting.

Tasvirning o‘lchamlarini avtomatik tarzda o‘zgartirish

Resize Image (M3meHuTh pasmepbl M300paxeHus) buyrug‘i
tasvirning nusxasini avtomatik tarzda nusxalaydi va nusxani
o‘lchamlarini avtomatik tarzda o‘zgartiradi. Siz fagat ketma-ket
berilgan giymatlarni kiritishingiz kerak, golgan ishni Photoshop
dasturining o‘zi bajaradi.

1. Help > Resize Image (ITomouis > M3mMeHUTH pazmepbl
u3o0paxeHusi) menyusidan buyruglarni tanlang.

2. O‘tkazgichni Print (ITeuats) yoki Online (Ounaitn)ni
qo‘ying, 3.94-rasmda ko‘rsatilganday qilib, Next ([anbuie)
tugmasini bosing.

3. Kerakli bo‘lgan bosmaga chiquvchi tasvir o‘lchamini bering
(3.95-rasm), keyin Next (lasbiue) tugmasini bosing. Agarda oldingi
gadamda Online rejimi tanlangan bo‘lsa, Finish (I'otoBo) tugmasiga
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sichqoncha bilan cherting. Tasvirni bosmaga chiqarish uchun
golgan amallarni bajaring.

Resize Image Wizard

3.94-rasm. Bosmaga chiqarishni tanlash (ekranga
yoki printerga).

Resize Image Wizard

3.95-rasm. Bosmaga chiqgarishda o‘zimiz xohlagan tasvir
o‘lchamlarini Kkiritish.
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4. Ko‘rsatilgan giymatlarni belgilang yoki bosmaxona ko‘rsat-
masi bo‘yicha boshga lianitura rastrini kiriting (3.96-rasm), keyin
Next ([anbiie) tugmasini cherting.

5. Tasvir sifatini tanlash Quality (KauecTBo)da bajariladi, 3.97-
rasmda berilgan va tasvirning natijaviy o‘lchamlariga e’tibor bering,
bu esa Results (Pe3ynsrar) maydonidan beriladi. Agarda keyinchalik
gandaydir bir ma’lumot berilgan bo‘lsa, uni o‘qish lozim. Agarda
davom ettirmoqchi bo‘lsangiz Next ([lanbiue) tugmasini cherting.

6. Oxirida Finish (T'otoBo) tugmasini cherting (3.98-rasm) va
tasvirni xotirada saglab, tasvirning o‘lchamlarini o‘zgartiring. Agarda
bekor gilmoqchi bo‘lsangiz Cancel (Ormena) tugmasini bosing.

Resize Image Wizard

| Which halftone screen (LPI) will be used 1o print your image?

Description

Cancel |  Back |

3.96-rasm. Rastr lianiturasini tanlash.

Resize Image Wizard

‘what level of image quality would you like?

Lower Quality 1x 1.5x 2x  Higher Quality
Smaller File pay Larger File
- Results ——
Original Image Size: 1055k
New Image Size: 813%

. Pixels Per Inch: 200

y, The new file is larger than the original which will
] L] result in & lower quality image. For best results,
- rescan at a higher resolution.

Cancel | Back |

3.97-rasm. Kerakli bo‘lgan sifatni tanlash.
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Resize Image Wizard

You have now completed the Resize Image Wizard.
Your image has been resized and the file has been duplicated.

If you would like to sharpen the focus of your image, go to the
Filter menu and choose Unsharp Mask from the Sharpen section.

Cancel Back

3.99-rasm. Tasvir aniq ko‘rinishda berilgan.

Unsharp Mask filtridan foydalanish

Agarda tasvir o‘lchamlarini yoki ajrataolishni o‘zgartirgan
bo‘lsangiz, Resample Image (OrcnexuBath uameHeHusi)da bayroqcha
mavjud bo‘lgan bo‘lsa va keyin tasvirni CMYK rejimiga o‘tkazsangiz
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yoki tasvirdagi o‘zgartirishlarni (transformatsiya) amalga oshirsangiz,
u holda interpolyatsiya natijasida tasvir aniqligi yo‘qoladi. Berilgan
Unsharp Mask (Macka Hepe3koctu) filtri yordamida fokusirovka
effekti gilinadi. Bu filtr ikkita qo‘shni nuqtalar orasidagi kontrast-
likni orttiradi (ko‘paytiradi), agarda ular bir-biri bilan kontrastlikda
bo‘lsa. Filtrning keyingi parametrlarini ham ko‘rsatsa bo‘ladi:
ravshanlik parametrini oshirish Amount (KoanyectBo) yordamida;
kontrastni oshirish uchun har bir nuqgta atrofidagi nuqgtalar sonini
oshirish (parametr Radius (Paauyc)); filtrning gaysi nuqtalarga
ta’sir gilishini va qaysilariga ta’sir gilmasligini aniglash uchun joriy
kontrastlikning minimal ko‘rsatkichini ko‘rsatish kerak (parametr
Threshold (ITopor)).

Filtrni Unsharp Mask qo‘llash effekti ekranda bilinishi mumkin,
yugqori ajrataolishli printerlarda esa u sezilmaydi.

1. Filter > Sharpen > Unsharp Mask (®unstp > Peskoctb >
Hepe3koe MackupoBaHue) menyusining buyruqlarini tanlang
3.99-rasm.

2. Amount (KoauuectBo)
filtri, piksellar orasidagi
i kontrastlik qanchaga kattala-
= | shishini ko*rsatadi (3.100-rasm).
oy Crevew Figuralar yoki obyektlar

- uchun kichkina son tanlang
(50 dan kichik bo‘lsin); agarda
tasvirda chegaralari aniq bo‘lgan
obyektlar bor bo‘lsa, kattaroq
sonni ko‘rsating. Son kattalashib
ketsa, u holda yuqori kontrastli

pe.e

=
[
|

oox |

dinauntic0 % sohalarda oreol paydo bo‘ladi

<

r— (3.101-rasm). Tasvir o‘lchami
— katta bo‘lgani sari aniglikni
Teshold: [Tl levels kamroq o‘zgartirish kerak.
& Yugqori ajrataolishli tasvirlar
uchun Amount (KosunuecTBo)
parametr giymatini 150 dan
200 % oraligda oling.

3. Radius (Panuyc)ning giymatlarini tanlash birmuncha qiyin
bo‘ladi: tasvirning natijaviy o‘lchamini, ajrataolishini va tasvirda
nima berilganini aniq berish lozim. Radius parametrining qiymatini 0, 1

3.100-rasm. Unsharp Mask
filtrining parametrlari.
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3.101-rasm. Har xil oreollarning chegaraga yaqin joylarda paydo bo‘lishi
va ranglar markazining Unsharp Mask filtrida Amount—160%,

Radius—1,5, Threshold — O qgiymatlari berilganda o‘zgarishi.
dan 250 gacha diapazonda berish
kerak va shu bilan birga chegaraga
yaqin joylardagi yuqgori kontrastli
joylarning qiymatlarini to‘g‘ri
bering. 1 va 2 giymatlaridan
boshlab ko‘ring. Katta sonlar
kontrastligi yuqori joylarning
kontrastligini yanada oshiradi
(3.102-rasm).

Tasvirni ajrataolish gancha
yugori, nugtalar soni esa gancha
ko‘p bo‘lsa, yuqori kontrastli
sohalarga o‘tish chegarasi
shunga mos holda radiusning
katta giymatini talab qiladi.
Kontrastligi past bo‘lgan tas-
virlar uchun katta giymatli ra-
dius bering va kichik giymatni murakkab bo‘lgan yuqori kontrast-
dagi tasvirlarga berib ko‘ring.

Radius giymati gancha katta bo‘lgani sari Amount parametr
giymati shuncha kichik va teskari bo‘ladi.
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3.102-rasm. Unsharp Mask filtrini Amount — 130%, Radius — 6,0,
Threshold — O qiymatlarini o‘zgartirish natijasida kontrastligi

va ravshanligi.

4. Threshold (ITopor) parametrining giymatlarini B auamna-
3oHe 0 dan 255gacha diapazondan tanlansa minimal kontrastli tasvir
uchun soha o‘zgartirilmasdan oldingisi olinadi. Agarda 0 ko‘rsa-

Unsharp Mask

Amount: [160 %

Radius: II S pixels

i
Threshold: |15] levels

—
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tilsa, filtrni hamma tasvirlarga
ishlatsa bo‘ladi. Agarda giymati
0 dan katta bo‘lsa, yuqori
kontrastli joylarning chegaraga
yaqin joylarida ravshanlik
yuqorilashadi va past kont-
rastlilarda ravshanlik kam
miqdorda o‘zgaradi. Agarda
Threshold (ITopor) parametr
giymatini o‘zgartirsak, Amount
(KonnyectBo) va Radius (Pa-
auyc) parametrlar giymat-
larining kasrida bo‘ladi, bunda
chegaraga yaqin joylardagi
kontrastlikni orttiradi. Qan-
qaydir nosozliklarni (SHUM)



3.103-rasm. Unsharp Mask filtrini Amount — 160%, Radius — 1,5,
Threshold — 15 giymatlari bilan o‘zgarganda ranglarning yumshoq
shaklga (msarkuit) o‘tishi.

yo‘qotish uchun Threshold (ITopor) parametr giymatlarini 8 va
20 orasida berish kerak (3.103-rasm).

5. OK tugmasiga sichqoncha yordamida cherting.

Skanerlangan tasvirdagi don shaklidagi nosozliklarni yo‘qotish
uchun Filter > Blur > Gaussian Blur (®wistp > PazmbiTne >
Paszmbitie no layccy) filtrini kichkina giymati bilan o‘ting (1 dan
kichik) va keyin bir yoki ikki marta Filter > Sharpen > Sharpen
Edges (®wibtp > Peskocth > Pe3koctb KOHTYpoB)ni ishlating,
bu tasvirning yanada aniq chiqgishini ta’minlaydi.

Unsharp Mask filtrini ishlatgandan keyin katta tasvirlardagi
filtrni ishlatib, ekranda ko‘rish uchun kutishga majbur bo‘lamiz,
shunday bo‘lmasligi uchun oldin tasvir chigadi va oyna o‘lchami
beriladi, keyin Preview ([IpeaBapureibHblii MpOCMOTP) ga
bayrogcha qo‘ysangiz, katta ekranda chiqgarib berib, kerakli bo‘lgan
giymatlarni muharrirlasa bo‘ladi.

Unsharp Mask filtrini bir yoki bir necha rangli kanallarda qo‘llab
ko‘ring (masalan, RGB—tasvirida qizil, yashilga). Ikkita kanalda
ravshanlikni oshirib, bir xil radiusli gqiymatni bering. Tasvirni Lab
rejimiga ham olib o‘tsa bo‘ladi va L kanaliga filtr qo‘ysa bo‘ladi, u
yorug‘likni oshiradi, bunda rang piksellari o‘zgarmaydi.

190



MUNDARIJA

L Grafik dizayn ..............ccooooiiiiii e 3
| T O N (03 1 F: 1 1 + U U OSSPSR 4
1.2, RANE oot 9
1.3, Shakl covveiiiiieie et e tr e e e aearaas 15
1.4. Qisqacha kompozitsiya to‘g risida .........ccoovvviiiiiiiiiiiiiiiieeee e, 24
II. CorelDrawda ishlash ..., 28
2.1. Hujjatni yaratish va ochish ...........cccooviiee, 28
2.2. Vektor va rastr grafika ............ccooooeiiiiiiiiii e, 41
2.3. Obyektlar bilan ishlash ............ccocoiiiiiiiiiii e, 42
2.4. Matnlar bilan ishlash ... 61
2.5. To‘ldirish va chegaralash parametrlari ...............ccoceeiiiiiiin, 74
2.6. Qatlamlar bilan iShlash ........ococovvviiiiiiiiii e 83
2.7. Rangli va vektorli effeKtlar ..........ccocoeviiviiiiiiiiiiieee e, 86
2.8. Tasvirlarni import va eksportlash ............coccceviiiiiiiiiiiiiiiineee. 109
2.9. Rastrli tasvirlar bilan ishlash va o‘zgartirish ................cocooeel. 115
2.10. Ko‘p sahifali hujjatlar bilan ishlash ......................cc.cccoeen. 120
II1. Photoshopda ishlashning asoslari .................................... 123
3.1. Asosiy tushunchalar ... 123
3.2. Photoshop dasturidagi ranglar ...................cccoieiiiiiiiiiinn, 143
3.3. Ishning boshlanishi ..........c.c.cccooiiiiiiiiiii e 149
3.4, Rastrli tasvirlar hagida tushunchalar .............ccocovvvvvviiiiiiiiiiine 178

191



O‘gquv qo ‘llanma

Sh.A.Nazirov, F.M.Nuraliyev, B.Sh.Aytmuratov

RASTR VA VEKTOR GRAFIKA

Kasb-hunar kollejlari uchun o‘quv qo‘llanma

Mubharrir Mavjuda Nasriddinova
Musavvir Eldor Zokirov
Badiiy muharrir Anatoliy Bobrov
Texnik muharrir Tatyana Smirnova
Musahhih Fotima Ortigova
Kompyuterda sahifalovchi Zilola Mannopova

IB Ne 4498

Bosishga 06.07.07 y. da ruxsat etildi. Bichimi 60x90 !/, Tayms garniturasi.
Ofset bosma. 12,0 shartli bosma toboq. 13,5 nashr tobogi.
Jami 5772 nusxa. ...ragamli buyurtma. 32—2007 ragamli shartnoma.
Bahosi shartnoma asosida.

O‘zbekiston Matbuot va axborot agentligining G‘afur Gulom nomidagi
nashriyot-matbaa ijodiy uyi. 100129. Toshkent, Navoiy ko‘chasi, 30.
100128. Toshkent, Usmon Yusupov ko‘chasi, 86.

Bizning internet manzilimiz: www.iptdgulom.uz


http://www.iptdgulom.uz

